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Safety information

Connect the power cord to a properly grounded electrical outlet that is near the product and easily accessible.
Do not place or use this product near water or wet locations.

A CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or performance of
procedures other than those specified herein may result in hazardous radiation exposure.

CAUTION—POTENTIAL INJURY: The lithium battery in this product is not intended to be replaced. There is a
danger of explosion if a lithium battery is incorrectly replaced. Do not recharge, disassemble, or incinerate a
lithium battery. Discard used lithium batteries according to the manufacturer's instructions and local
regulations.

This product uses a printing process that heats the print media, and the heat may cause the media to release emissions.
You must understand the section in your operating instructions that discusses the guidelines for selecting print media
to avoid the possibility of harmful emissions.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

A CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 Ib) and requires two or more
trained personnel to lift it safely.

CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.

CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using multiple input options. If you purchased a printer with
a similar configuration, then you may need additional furniture. For more information, see
www.lexmark.com/multifunctionprinters.

CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

® Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet.
® Disconnect all cords and cables from the printer before moving it.
® Lift the printer off the optional tray, and then set it aside instead of trying to lift the tray and printer at the same
time.
Note: Use the handholds located on both sides of the printer to lift it.

Use only the power cord provided with this product or the manufacturer's authorized replacement.

A CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

A CAUTION—SHOCK HAZARD: Make sure that all external connections (such as Ethernet and telephone system
connections) are properly installed in their marked plug-in ports.

This product is designed, tested, and approved to meet strict global safety standards with the use of specific
manufacturer's components. The safety features of some parts may not always be obvious. The manufacturer is not
responsible for the use of other replacement parts.
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CAUTION—POTENTIAL INJURY: Do not cut, twist, bind, crush, or place heavy objects on the power cord. Do not
subject the power cord to abrasion or stress. Do not pinch the power cord between objects such as furniture
and walls. If any of these things happen, a risk of fire or electrical shock results. Inspect the power cord regularly
for signs of such problems. Remove the power cord from the electrical outlet before inspecting it.

Refer service or repairs, other than those described in the user documentation, to a service representative.

A CAUTION—SHOCK HAZARD: Do not set up this product or make any electrical or cabling connections, such as
the fax feature, power cord, or telephone, during a lightning storm.

A CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the printer,
unplug the power cord from the electrical outlet and disconnect all cables from the printer before proceeding.

SAVE THESE INSTRUCTIONS.
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Learning about the printer

Finding information about the printer

What are you looking for? Find it here

Initial setup instructions:
® Connecting the printer

® Installing the printer software

Setup documentation—The setup documentation came
with the printer and is also available at
http://support.lexmark.com.

Additional setup and instructions for using the printer:
® Selecting and storing paper and specialty media
® |loading paper
® Configuring printer settings
® Viewing and printing documents and photos
® Setting up and using the printer software
® Configuring the printer on a network
® Caring for and maintaining the printer

® Troubleshooting and solving problems

User's Guide and Quick Reference Guide—The guides may
be available on the Software and Documentation CD.
For more information, visit
http://support.lexmark.com.

Instructions for:
® Connecting the printer to an Ethernet network

® Troubleshooting printer connection problems

Networking Guide—QOpen the Software and
Documentation CD, and then look for Printer and
Software Documentation under the Pubs folder. From
the list of publications, click the Networking Guide link.

Help using the printer software

Windows or Mac Help—Open a printer software program
or application, and then click Help.

Click @ to view context-sensitive information.

Notes:

® Help is automatically installed with the printer
software.

® The printer software is located in the printer
program folder or on the desktop, depending on
your operating system.
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What are you looking for? Find it here

The latest supplemental information, updates, and customer Lexmark Support Web site—
support: http://support.lexmark.com
® Documentation Note: Select your country or region, and then select
e Driver downloads your product to view the appropriate support site.
e Live chat support Support telephone numbers and hours of operation for

your country or region can be found on the Support Web

site or on the printed warranty that came with your
® Voice support printer.

® E-mail support

Record the following information (located on the store
receipt and at the back of the printer), and have it ready
when you contact customer support so that they may
serve you faster:

® Machine Type number
® Serial number
® Date purchased

® Store where purchased

Warranty information Warranty information varies by country or region:

® In the U.S.—See the Statement of Limited Warranty
included with this printer, or at
http://support.lexmark.com.

® In other countries and regions—See the printed
warranty that came with your printer.

Selecting a location for the printer

A CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 Ib) and requires two or more
trained personnel to lift it safely.

When selecting a location for the printer, leave enough room to open trays, covers, and doors. If you plan to install any
options, then leave enough room for them also. It is important to:

® Set up the printer near a properly grounded and easily accessible electrical outlet.

® Make sure airflow in the room meets the latest revision of the ASHRAE 62 standard or the CEN Technical Committee
156 standard.

® Provide a flat, sturdy, and stable surface.
® Keep the printer:
— Clean, dry, and free of dust.
— Away from stray staples and paper clips.
— Away from the direct airflow of air conditioners, heaters, or ventilators.

— Free from direct sunlight and humidity extremes.

Observe the recommended temperatures and avoid fluctuations:

| Ambient temperature | 15.6 to 32.2°C (60 to 90°F) |

l Storage temperature |-40 to 43°C (-40 to 110°F) I

® Allow the following recommended amount of space around the printer for proper ventilation:
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1 Right side | 102 mm (4 in.)
2 | Front 508 mm (20in.)
3 | Leftside |152 mm (6in.)
4 |Rear 102 mm (4 in.)
5 |[Top 254 mm (10 in.)}

Printer configurations

A%

I=

\

| -
N\~ 2

A CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using multiple input options. If you purchased a printer with

a similar configuration, then you may need additional furniture. For more information, see
www.lexmark.com/multifunctionprinters.
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Printer control panel

Standard bin

250-sheet tray (Tray 1)

Manual feeder

v (W N |-

Optional 650-sheet duo tray with integrated multipurpose feeder (Tray 2)
Note: This tray is standard on the CS410dtn and CS510dte models.

6 | Optional 550-sheet tray (Tray 3)

Using the printer control panel
1 23 4 5

1 | Display ® View the printer status.

Set up and operate the printer.

2 Select button

Select menu options.

® Save settings.




Learning about the printer 16

Use the

3 Arrow buttons

To

Scroll through menus, or settings on the display.

4 Keypad

Enter numbers, letters, or symbols.

5 | Sleep button

Enable Sleep mode or Hibernate mode.

Notes:

® Pressing any hard button, attaching a device to a USB port, sending a print job, or performing
a power-on reset with the main power switch wakes the printer from Sleep mode.

® Pressing the Sleep button or the power switch will cause the printer to wake from Hibernate

mode.
6 | Stop button Stop all printer activity.
7 | Back button Return to the previous screen.
8 |Home button |Go to the home screen.
9 |Indicator light | Check the status of the printer.
10 | USB port Connect a camera or flash drive to the printer.

Understanding the colors of the indicator and Sleep button

lights

The colors of the indicator and Sleep button lights on the printer control panel signify a certain printer status or condition.

Indicator light color and its corresponding printer status

Indicator light

Printer status

off

The printer is off or in Hibernate mode.

Blinking green

The printer is warming up, processing data, or printing.

Solid green

The printer is on, but idle.

Blinking red

The printer requires user intervention.

N

Sleep button light color and its corresponding printer status

Sleep button light Printer status

Off

The printer is off, idle or in Ready state.

Solid amber

The printer is in Sleep mode.

Blinking amber

The printer is entering or waking from Hibernate mode.

pulsing pattern

Blinking amber for 0.1 second, then goes The printer is in Hibernate mode.
completely off for 1.9 seconds in a slow,
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Using the Embedded Web Server

Note: This feature is available only in network printers or printers connected to print servers.
If the printer is installed on a network, then you can use the Embedded Web Server to do the following:

® View the virtual display of the printer control panel.

® Check the status of the printer supplies.

® Configure supply notifications.

® Configure printer settings.

® Configure network settings.

® View reports.
To access the Embedded Web Server for your printer:

1 Obtain the printer IP address:

® From the TCP/IP section in the Network/Ports menu

® By printing a network setup page or menu settings page, and then finding the TCP/IP section

Notes:

— An IP address appears as four sets of numbers separated by periods, such as 123.123.123.123.
— If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Open a Web browser, and then type the printer IP address in the address field.

3 Press Enter.

The Embedded Web Server page appears.
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Additional printer setup

Installing internal options

A CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

You can customize your printer connectivity and memory capacity by adding optional cards.

Available internal options

Memory cards
®* DDR3 DIMM
® Flash memory
— Fonts
— Firmware
® Forms Barcode
® Prescribe
® |PDS
® Hard disk”

* This internal option is available only in CS510 printer model.
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Accessing the controller board

A CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

1 Access the controller board at the back of the printer.
Note: This task requires a flat-head screwdriver.

2 Turn the screws counterclockwise to remove them.

3 Slightly open the controller board access cover, and then shift to the right to remove it.

4 Locate the appropriate connector on the controller board.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch something metal on the printer before touching any controller board electronic components or
connectors.
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5 Reattach the cover.

2 1
1 | Memory card connector |
2 | Option card connector J
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6 Turn the screws clockwise to lock the cover.

Installing a memory card

A CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

1 Access the controller board.

For more information, see “Accessing the controller board” on page 19.
2 Unpack the memory card.

Warning—Potential Damage: Do not touch the connection points along the edge of the card. Doing so may
cause damage.
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3 Align the notch (1) on the memory card with the ridge (2) on the connector.

4 Push the memory card straight into the connector, and then push the card toward the controller board wall until
it clicks into place.

5 Close the controller board access cover.
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Installing an optional card

A CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have other devices attached to the printer, then turn them
off as well, and unplug any cables going into the printer.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch a metal surface on the printer before touching any controller board electronic components or connectors.

1 Access the controller board.

For more information, see “Accessing the controller board” on page 19.
2 Unpack the optional card.
Warning—Potential Damage: Avoid touching the connection points along the edge of the card.
3 Holding the card by its sides, align the plastic pins (1) on the card with the holes (2) on the controller board.

2

Y
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4 Push the card firmly into place as shown in the illustration.

Warning—Potential Damage: Improper installation of the card may cause damage to the card and the
controller board.

Note: The entire length of the connector on the card must touch and be flushed against the controller board.
5 Close the controller board access door.

Note: When the printer software and any hardware options are installed, it may be necessary to manually add
the options in the printer driver to make them available for print jobs. For more information, see “Updating
available options in the printer driver” on page 28.
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Installing hardware options

Order of installation

A CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 Ib), and requires two or more
trained personnel to lift it safely.

CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

Install the printer and any optional tray in the following order:
® QOptional 550-sheet tray (Tray 3)
® 650-sheet duo tray (Tray 2)

® Printer

Installing an optional tray

The printer supports two optional input sources: a 550-sheet tray and a 650-sheet duo tray (Tray 2) with an integrated
multipurpose feeder.

A CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 Ib) and requires two or more
trained personnel to lift it safely.

A CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

1 Unpack the optional tray, and then remove all packing material and the dust cover.
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2 Label the trays with the supplied tray number labels from the top down.
Note: The standard 250-sheet tray must be labeled as Tray 1.

3 Place the tray near the printer.

Note: If you are installing both the optional trays, then the optional 550-sheet tray must always be installed as
the first tray when configuring from the bottom to the top.

4 Align the 650-sheet duo tray with the optional 550-sheet tray, and then lower it into place.

—

-«
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-

5 Align the printer with the 650-sheet duo tray, and then lower the printer into place.
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6 Install the dust covers.

Note: When the printer software and any options are installed, you may need to manually add the options in the

printer driver to make them available for print jobs. For more information, see “Updating available options in the
printer driver” on page 28.

Setting up the printer software

Installing the printer software

Note: If you installed the printer software on the computer before but need to reinstall the software, then uninstall
the current software first.

For Windows users
1 Close all open software programs.
2 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then launch the CD manually:

a Click @, or click Start and then click Run.

b Inthe Start Search or Run dialog, type D: \setup . exe, where D is the letter of your CD or DVD drive.
C Press Enter, or click OK.

3 Click Install, and then follow the instructions on the computer screen.

For Macintosh users
1 Close all open applications.

2 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then click the CD icon on the desktop.
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3 Double-click the software installer package, and then follow the instructions on the computer screen.

Note: To take advantage of the full features of your printer, select the custom install option, and then select all
packages listed.

Using the Internet

1 Go to the Lexmark Web site at http://support.lexmark.com.

2 Navigate to:
SUPPORT & DOWNLOADS > select your printer > select your operating system

3 Download the printer driver, and then install the printer software.

Updating available options in the printer driver
When any hardware options are installed, you may need to manually add the options in the printer driver to make
them available for use.
For Windows users
1 Open the printers folder.
a Click @, or click Start and then click Run.

b Inthe Start Search or Run dialog, type control printers.

C Press Enter, or click OK.
2 Select the printer.
3 Right-click the printer, and then select Printer properties (Windows 7) or Properties (earlier versions).
4 Click the Configuration tab.

5 Do either of the following:
® (Click Update Now - Ask Printer.

® Under Configuration Options, manually add any installed hardware options.

6 Click Apply.

For Macintosh users

1 From the Apple menu, navigate to either of the following:
® System Preferences > Print & Scan > select your printer > Options & Supplies > Driver

® System Preferences > Print & Fax > select your printer > Options & Supplies > Driver

2 Add any installed hardware options, and then click OK.

Attaching cables

Connect the printer to the computer using a USB cable or to the network using an Ethernet cable.
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Make sure to match the following:
® The USB symbol on the cable with the USB symbol on the printer
® The appropriate Ethernet cable to the Ethernet port

Warning—Potential Damage: Do not touch the USB cable, any wireless network adapter, or the printer in the area
shown while actively printing. A loss of data or a malfunction can occur.

Use the To
1 USB printer port Connect the printer to a computer.
2 Ethernet port Connect the printer to a network.
3 USB port Attach an optional wireless network adapter.
4 | Printer power cord socket | Connect the printer to a properly grounded electrical outlet.
Networking
Notes:

® Purchase a MarkNet™ N8352 wireless network adapter first before setting up the printer on a wireless network.
For information on installing the wireless network adapter, see the instruction sheet that came with the
adapter.

® A Service Set Identifier (SSID) is a name assigned to a wireless network. Wired Equivalent Privacy (WEP), Wi-Fi
Protected Access (WPA), WPA2, and 802.1X - RADIUS are types of security used on a network.

Preparing to set up the printer on an Ethernet network
To configure your printer to connect to an Ethernet network, organize the following information before you begin:

Note: If your network automatically assigns IP addresses to computers and printers, continue on to installing the
printer.
® Avalid, unique IP address for the printer to use on the network

® The network gateway
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® The network mask

® A nickname for the printer (optional)

Note: A printer nickname can make it easier for you to identify your printer on the network. You can choose to
use the default printer nickname, or assign a name that is easier for you to remember.

You will need an Ethernet cable to connect the printer to the network and an available port where the printer can

physically connect to the network. Use a new network cable when possible to avoid potential problems caused by a
damaged cable.

Installing the printer on an Ethernet network

For Windows users

1 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then launch the CD manually:

a Click @, or click Start and then click Run.

b Inthe Start Search or Run dialog, type D: \setup . exe, where D is the letter of the CD or DVD drive.
C Press Enter, or click OK.

2 Click Install, and then follow the instructions on the computer screen.
3 Select Ethernet connection, and then click Continue.
4 Attach the Ethernet cable when instructed to do so.
5 Select the printer from the list, and then click Continue.
Note: If the configured printer does not appear in the list, then click Modify Search.

6 Follow the instructions on the computer screen.

For Macintosh users
1 Allow the network DHCP server to assign an IP address to the printer.
2 Obtain the printer IP address either:
® From the printer control panel
® From the TCP/IP section in the Network/Ports menu
® By printing a network setup page or menu settings page, and then finding the TCP/IP section
Note: You will need the IP address if you are configuring access for computers on a different subnet than the printer.
3 Install the printer driver on the computer.
a Insert the Software and Documentation CD, and then double-click the installer package for the printer.
b Follow the instructions on the computer screen.
C Select a destination, and then click Continue.
d From the Easy Install screen, click Install.
e

Type the user password, and then click OK.
All the necessary applications are installed on the computer.

f Click Close when installation is complete.
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4 Add the printer.
® For IP printing:
a From the Apple menu, navigate to either of the following:
— System Preferences > Print & Scan

— System Preferences > Print & Fax
b Click +.
¢ Click the IP tab.
d Type the printer IP address in the address field, and then click Add.

® For AppleTalk printing:

Notes:

— Make sure AppleTalk is activated on your printer.
— This feature is supported only in Mac OS X version 10.5.
a From the Apple menu, navigate to:
System Preferences > Print & Fax
b Click +, and then navigate to:
AppleTalk > select your printer > Add

Preparing to set up the printer on a wireless network

Notes:

® Make sure your wireless network adapter is installed in your printer and working properly.

® Make sure your access point (wireless router) is turned on and is working properly.

Make sure you have the following information before setting up the printer on a wireless network:
® SSID—The SSID is also referred to as the network name.
® Wireless Mode (or Network Mode)—The mode is either infrastructure or ad hoc.
® Channel (for ad hoc networks)—The channel defaults to automatic for infrastructure networks.

Some ad hoc networks will also require the automatic setting. Check with your system support person if you are
not sure which channel to select.

® Security Method—There are three basic options for Security Method:
— WEP key

If your network uses more than one WEP key, then enter up to four in the provided spaces. Select the key
currently in use on the network by selecting the default WEP transmit key.

or

— WPA or WPA2 preshared key or passphrase

WPA includes encryption as an additional layer of security. The choices are AES or TKIP. Encryption must be set
for the same type on the router and on the printer, or the printer will not be able to communicate on the
network.

— 802.1X-RADIUS

If you are installing the printer on an 802.1X network, then you may need the following:
® Authentication type

® Inner authentication type
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® 802.1X user name and password
® Certificates

— No security
If your wireless network does not use any type of security, then you will not have any security information.

Note: Using an unsecured wireless network is not recommended.

Notes:

— If you do not know the SSID of the network that your computer is connected to, then launch the wireless utility
of the computer network adapter, and then look for the network name. If you cannot find the SSID or the
security information for your network, then see the documentation that came with the access point, or contact
your system support person.

— To find the WPA/WPA?2 preshared key/passphrase for the wireless network, see the documentation that came
with the access point, see the Web page associated with the access point, or consult your system support
person.

Connecting the printer to a wireless network using Wi-Fi Protected Setup (WPS)

Before you begin, make sure that:
® The access point (wireless router) is WPS certified.

® A wireless network adapter is installed in the printer and is working properly. For more information, see the
instruction sheet that came with the wireless network adapter.

Using the Push Button Configuration (PBC) method

1 From the printer control panel, navigate to:

> Settings > m >Network/Ports > m > Network [x] > m > Network [x] Setup > m > Wireless > m >
Wi-Fi Protected Setup > n > Start Push Button Method > n

2 Follow the instructions on the printer display.

Using the Personal Identification Number (PIN) method

1 From the printer control panel, navigate to:

> Settings > n >Network/Ports > n > Network [x] > Wireless > n > Wi-Fi Protected Setup > n > Start
PIN Method > n

2 Copy the eight-digit WPS PIN.

3 Open a Web browser, and then type the IP address of your access point in the address bar.
Notes:

® The IP address appears as four sets of numbers separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.
4 Access the WPS settings.

5 Enter the eight-digit PIN, and then save the setting.
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Connecting the printer to a wireless network using the Embedded Web Server

Before you begin, make sure that:
® Your printer is connected temporarily to an Ethernet network.

® A wireless network adapter is installed in your printer and working properly. For more information, see the
instruction sheet that came with your wireless network adapter.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Network/Ports > Wireless.
3 Modify the settings to match the settings of your access point (wireless router).
Note: Make sure to enter the correct SSID.
4 Click Submit.

5 Turn off the printer, and then disconnect the Ethernet cable. Then wait for at least five seconds, and then turn the
printer back on.

6 To verify if your printer is connected to the network, print a network setup page. Then in the Network Card [x]
section, see if the status is “Connected”.

For more information, see the “Verifying printer setup” section of the User’s Guide.

Verifying printer setup

Printing a menu settings page
Print a menu settings page to review the current menu settings and to verify if the printer options are installed correctly.

Note: If you have not changed any menu settings, then the menu settings page lists all the factory default settings.
When you select and save other settings from the menus, they replace the factory default settings as user default
settings. A user default setting remains in effect until you access the menu again, choose another value, and save it.

From the printer control panel, navigate to:

> Settings > n >Reports > n > Menu Settings Page > n
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Printing a network setup page

If the printer is attached to a network, then print a network setup page to verify the network connection. This page
also provides important information that aids network printing configuration.

1 From the printer control panel, navigate to:

> Settings > m > Reports > m > Network Setup Page > n

2 Check the first section of the network setup page, and then confirm that the status is Connected.

If the status is Not Connected, then the LAN drop may not be active, or the network cable may be malfunctioning.
Consult your system support person for a solution, and then print another network setup page.
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Loading paper and specialty media

This chapter covers the selection and handling of paper and specialty media. Proper selection and loading of media can
improve how reliably documents print. For more information, see “Avoiding jams” on page 142 and “Storing paper”
on page 53.

Setting the paper size and type

1 From the printer control panel, navigate to:

> Settings > m > Paper Menu > n > Paper Size/Type > m

2 Press the up or down arrow button to select the tray or feeder size, and then press n
3 Press the up or down arrow button to select the paper size, and then press n
4 Press the up or down arrow button to select the tray or feeder type, and then press m

5 Press the up or down arrow button to select the paper type, and then press n

Configuring Universal paper settings

The Universal paper size is a user-defined setting that lets you print on paper sizes that are not preset in the printer
menus.

Notes:

® The smallest supported Universal size is 76 x 127 mm (3 x 5 inches) and is loaded only in the multipurpose
feeder and manual feeder.

® The largest supported Universal size is 215.9 x 359.9 mm (8.5 x 14.17 inches) and is loaded only in the
multipurpose feeder and manual feeder.

1 From the printer control panel, navigate to:

> Settings > n > Paper Menu > n > Units of Measure > n > select a unit of measure > n

2 Pressthe arrow buttons untilUnits of Measure, Portrait Height,or Portrait Width appears, and
then press n

3 Enter the preferred settings using the keypad, and then press n
4 Press .
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Loading the 250- and 550-sheet tray

The printer has one 250-sheet tray (Tray 1) with an integrated manual feeder. The 250-sheet tray, the 650-sheet duo
tray, and the 550-sheet tray support the same paper sizes and types and are loaded in the same way.

CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.

1 Pull out the tray completely.

Note: Do not remove trays while a job is printing or while Busy appears on the display. Doing so may cause a
jam.

2 If the paper is longer than letter-size paper, then squeeze and then slide the length guide at the back of the tray to
extend it.
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3 Squeeze, and then slide the length guide tab to the correct position for the size of the paper being loaded.

Note: Use the paper size indicators on the bottom of the tray to help position the guide.

4 Squeeze, and then slide the width guide tab to the correct position for the size of the paper being loaded.

Note: Use the paper size indicators on the bottom of the tray to help position the guides.

5 Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten the
edges on a level surface.
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6 Load the paper stack with the recommended printable side faceup.

7 Place the paper guides securely against the edges of the paper.

8 Insert the tray.

9 From the printer control panel, set the paper size and paper type in the Paper menu to match the paper loaded in
the tray.

Note: Mixing paper sizes or paper types in a tray may cause jams.

Loading the 650-sheet duo tray

The 650-sheet duo tray (Tray 2) consists of a 550-sheet tray and an integrated 100-sheet multipurpose feeder. The tray
is loaded in the same way as the 250-sheet tray and the optional 550-sheet tray, and supports the same paper types
and sizes. The only differences are the look of the guide tabs and the location of the paper size indicators.

CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.
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1 Length guide tab

2 | Paper size indicator

3 | Width guide tab

Loading the multipurpose feeder

1 Push the multipurpose feeder latch to the left.
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2 Open the multipurpose feeder.

3 Pull the multipurpose feeder extender.

Note: Guide the extender gently so that the multipurpose feeder is fully extended and open.

4 Prepare the paper for loading.

® Flex the sheets of paper back and forth to loosen them, and then fan them. Do not fold or crease the paper.
Straighten the edges on a level surface.

® Hold transparencies by the edges, and then fan them. Straighten the edges on a level surface.

Note: Avoid touching the printable side of transparencies. Be careful not to scratch them.
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® Flex a stack of envelopes back and forth to loosen them, and then fan them. Straighten the edges on a level
surface.

Warning—Potential Damage: Never use envelopes with stamps, clasps, snaps, windows, coated linings, or
self-stick adhesives. These envelopes may severely damage the printer.

5 Locate the maximum paper fill indicator and tab.

Note: Make sure the paper or specialty media is below the maximum paper fill indicator located on the paper
guides.

Width guide tab

Maximum paper fill indicator

Width guide

Feeder extender

i (B (W (N |-

Paper size indicator
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6 Load the paper, and then adjust the width guide to lightly touch the edge of the paper stack.

® |oad paper, card stock, and transparencies with the recommended printable side facedown and the top edge
entering the printer first.

® |oad envelopes with the flap side up and against the right side of the paper guide.

-

Notes:

® Do not load or close the multipurpose feeder while a job is printing.
® Load only one size and type of paper at a time.

® Paper should lie flat in the multipurpose feeder. Make sure the paper fits loosely in the multipurpose feeder
and is not bent or wrinkled.

7 From the printer control panel, set the paper size and type in the Paper menu to match the paper loaded in the
tray.

Loading the manual feeder

The standard 250-sheet tray has an integrated manual feeder that can be used to print on different types of paper one
sheet at a time.

1 Load a sheet of paper into the manual feeder:
® Printable side facedown for one-sided printing

® Printable side faceup for two-sided (duplex) printing

Note: There are different ways for loading letterhead depending on the mode of printing.
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One-sided printing using a letterhead Two-sided printing using a letterhead

® Load envelope with the flap side up and against the right side of the paper guide.

P

2 Feed paper into the manual feeder only to the point where its leading edge can contact the paper guides.
Note: To achieve the best possible print quality, use only high-quality media designed for laser printers.
3 Adjust the paper guides to the width of the paper loaded.

Warning—Potential Damage: Do not force the paper into the feeder. Forcing the paper may cause jams.
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Linking and unlinking trays

When the paper size and paper type for any trays are the same, the printer links those trays. When one linked tray
becomes empty, paper will feed from the next linked tray. We recommend giving all unique paper, such as letterhead
and different colored plain papers, a different custom type name so that the trays they are in will not automatically
link.

Linking and unlinking trays
Note: This feature applies only in network printers.
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Paper Menu.

3 Change the tray settings to specify the paper size and type for the tray.
® To link trays, make sure the paper size and type for the tray match with that of the other tray.

® To unlink trays, make sure the paper size or type for the tray does not match with that of the other tray.
4 Click Submit.

Warning—Potential Damage: Paper loaded in the tray should match the paper type name assigned in the printer.
The temperature of the fuser varies according to the specified paper type. Printing issues may occur if settings are
not properly configured.

Creating a custom name for a paper type

Using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Paper Menu > Custom Names.
3 Select a custom name, and then type a new custom paper type name.
4 Click Submit.

5 Click Custom Types, and then verify if the new custom paper type name has replaced the custom name.
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Using the printer control panel

1 From the printer control panel, navigate to:

> Settings > n > Paper Menu > n > Custom Names

2 Select a custom name, and then type a new custom paper type name.

3 Press m

4 Press Custom Types, and then verify if the new custom paper type name has replaced the custom name.

Assigning a custom paper type name

Using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Paper Menu > Custom Names.
3 Type a name for the paper type, and then click Submit.
4 Select a custom type, and then verify that the correct paper type is associated with the custom name.

Note: Plain Paper is the factory default paper type for all user-defined custom names.

Using the printer control panel

1 From the printer control panel, navigate to:
-
w1l > Settings > > Paper Menu > > Custom Names

2 Type a name for the paper type, and then press n

Assigning a custom paper type

Using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu > Custom Types.



Loading paper and specialty media

46

3 Select a custom paper type name, and then select a paper type.

Note: Paper is the factory default paper type for all user-defined custom names.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

> Settings > m > Paper Menu > m > Custom Types

2 Select a custom paper type name, and then select a paper type.

Note: Paper is the factory default paper type for all user-defined custom names.

3 Press m
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Paper and specialty media guide

Using specialty media

Tips on using letterhead

® Use letterhead designed specifically for laser printers.
® Print a test page on the letterhead being considered for use before buying large quantities.
® Before loading letterhead, flex, fan, and straighten the stacks to prevent sheets from sticking together.

® Page orientation is important when printing on letterhead.

Printing Printable side Paper orientation

Source
Trays One-sided Faceup Load the sheet
with the top edge
entering the
printer first.

Two-sided Facedown Load the sheet
with the bottom
edge entering the
printer first.

Trays

Note: Check with the manufacturer or vendor to determine whether or not the preprinted letterhead is acceptable
for laser printers.
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Source Printing Printable side Paper orientation

Manual feeder One-sided Facedown Load the sheet
with the top edge
entering the
printer first.

Manual feeder Two-sided Faceup Load the sheet
with the bottom
edge entering the
printer first.

Multipurpose feeder One-sided Facedown Load the sheet
with the top edge
entering the
printer first.

Note: Check with the manufacturer or vendor to determine whether or not the preprinted letterhead is acceptable
for laser printers.
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Source Printing Printable side Paper orientation

Multipurpose feeder Two-sided Faceup Load the sheet
with the bottom
edge entering the
printer first.

Note: Check with the manufacturer or vendor to determine whether or not the preprinted letterhead is acceptable

for laser printers.

Tips on using transparencies

Print a test page on the transparencies being considered for use before buying large quantities.

From the printer control panel, set the paper size, type, texture, and weight in the Paper menu to match the
transparencies loaded in the tray.

Print a test page on the transparencies being considered for use before buying large quantities.
Feed transparencies from the 250-sheet tray, manual feeder, or multipurpose feeder.

Use transparencies designed specifically for laser printers.

Avoid getting fingerprints on the transparencies to prevent print quality problems.

Before loading transparencies, flex, fan, and straighten the stacks to prevent sheets from sticking together.

Tips on using envelopes

From the printer control panel, set the paper size, type, texture, and weight in the Paper menu to match the
envelopes loaded in the tray.

Print samples on the envelopes being considered for use before buying large quantities.
Use envelopes designed specifically for laser printers.

For best performance, use envelopes made from 90-g/m? (24-Ib) paper or 25% cotton.
Use only new envelopes from undamaged packages.

To optimize performance and minimize jams, do not use envelopes that:

— Have excessive curl or twist.

— Are stuck together or damaged in any way.

— Have windows, holes, perforations, cutouts, or embossing.

— Have metal clasps, string ties, or folding bars.

— Have an interlocking design.

— Have postage stamps attached.

— Have any exposed adhesive when the flap is in the sealed or closed position.
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— Have bent corners.
— Have rough, cockle, or laid finishes.
Adjust the width guides to fit the width of the envelopes.

Before loading the envelopes on the tray, flex and fan the envelopes to loosen them. Straighten the edges on a
level surface.

Note: A combination of high humidity (over 60%) and high printing temperature may wrinkle or seal envelopes.

Tips on using labels

From the printer control panel, set the paper size, type, texture, and weight in the Paper menu to match the labels
loaded in the tray.

Print samples on labels being considered for use before buying large quantities.

For more information on label printing, characteristics, and design, see the Card Stock & Label Guide at
http://support.lexmark.com.

Use labels designed specifically for laser printers.
Do not use labels with slick backing material.

Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets
also contaminate the printer and the cartridge with adhesive, and could void the printer and toner cartridge
warranties.

Do not use labels with exposed adhesive.

Before loading labels on the tray, flex and fan labels to loosen them. Straighten the edges on a level surface.

Tips on using card stock

Card stock is heavy, single-ply specialty media. Many of its variable characteristics, such as moisture content, thickness,
and texture, can significantly affect print quality.

From the printer control panel, set the paper size, type, texture, and weight in the Paper menu to match the card
stock loaded in the tray.

Print samples on the card stock being considered for use before buying large quantities.
Specify the paper texture and weight from the tray settings to match the paper loaded in the tray.

Preprinting, perforation, and creasing may significantly affect the print quality and cause jams or other paper feed
problems.

Before loading the card stock on the tray, flex and fan the card stock to loosen them. Straighten the edges on a
level surface.

Paper guidelines

Select the correct paper or specialty media to reduce printing problems. For the best print quality, try a sample of the
paper or specialty media before buying large quantities.

Paper characteristics

The following paper characteristics affect print quality and reliability. Consider these characteristics when evaluating
new paper stock.
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Weight

The printer trays can automatically feed paper weights up to 176-g/m? (47-Ib) bond grain long paper. The multipurpose
feeder can automatically feed paper weights up to 176-g/m? (47-1b) bond grain long paper. Paper lighter than
60 g/m? (16 Ib) might not be stiff enough to feed properly, causing jams. For best performance, use 75-g/m? (20-Ib)

bond grain long paper. For paper smaller than 182 x 257 mm (7.2 x 10.1 inches), we recommend 90 g/m? (24 |b) or
heavier paper.

Note: Duplex printing is supported from 60-105-g/m? (16-28-Ib) bond grain long paper.

Curl

Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl can occur after
the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped in hot, humid,
cold, or dry conditions, even in the trays, can contribute to paper curling prior to printing and can cause feeding
problems.

Smoothness

Paper smoothness directly affects print quality. If paper is too rough, then toner cannot fuse to it properly. If paper is
too smooth, then it can cause paper feeding or print quality issues. Always use paper between 100 and 300 Sheffield
points; smoothness between 150 and 250 Sheffield points produces the best print quality.

Moisture content

The amount of moisture in paper affects both print quality and the ability of the printer to feed the paper correctly.
Leave paper in its original wrapper until it is time to use it. This limits the exposure of paper to moisture changes that
can degrade its performance.

Store paper in its original wrapper in the same environment as the printer for 24 to 48 hours before printing. Extend
the time to several days if the storage or transportation environment is very different from the printer environment.
Thick paper may also require a longer conditioning period.

Grain direction

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of
the paper, or grain short, running the width of the paper.

For 60-90-g/m? (16—24-Ib) bond paper, grain long paper is recommended.

Fiber content

Most high-quality xerographic paper is made from 100% chemically treated pulped wood. This content provides the
paper with a high degree of stability resulting in fewer paper feeding problems and better print quality. Paper containing
fibers such as cotton can negatively affect paper handling.

Unacceptable paper

The following paper types are not recommended for use with the printer:

® Chemically treated papers used to make copies without carbon paper, also known as carbonless papers, carbonless
copy paper (CCP), or no carbon required (NCR) paper

® Preprinted papers with chemicals that may contaminate the printer

® Preprinted papers that can be affected by the temperature in the printer fuser
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® Preprinted papers that require a registration (the precise print location on the page) greater than £2.3 mm (£0.9in.),
such as optical character recognition (OCR) forms

In some cases, registration can be adjusted with a software application to successfully print on these forms.
® Coated papers (erasable bond), synthetic papers, thermal papers
® Rough-edged, rough or heavily textured surface papers, or curled papers
® Recycled papers that fail EN12281:2002 (European)
® Paper weighing less than 60 g/m? (16 Ib)

® Multiple-part forms or documents

Selecting paper

Using the appropriate paper prevents jams and helps ensure trouble-free printing.
To help avoid paper jams and poor print quality:
® Always use new, undamaged paper.

® Before loading paper, know the recommended printable side of the paper. This information is usually indicated on
the paper package.

® Do not use paper that has been cut or trimmed by hand.
® Do not mix paper sizes, types, or weights in the same tray; mixing results in jams.

® Do not use coated papers unless they are specifically designed for electrophotographic printing.

Selecting preprinted forms and letterhead

Use these guidelines when selecting preprinted forms and letterhead:
® Use grain long for 60-90 g/m? (16—24 Ib) paper.
® Use only forms and letterhead printed using an offset lithographic or engraved printing process.

® Avoid papers with rough or heavily textured surfaces.

Use papers printed with heat-resistant inks designed for use in xerographic copiers. The ink must be able to withstand
temperatures up to 230°C (446°F) without melting or releasing hazardous emissions. Use inks that are not affected by
the resin in toner. Inks that are oxidation-set or oil-based generally meet these requirements; latex inks might not.
When in doubt, contact the paper supplier.

Preprinted papers such as letterhead must be able to withstand temperatures up to 230°C (446°F) without melting or
releasing hazardous emissions.

Using recycled paper and other office papers

As an environmentally conscious company, Lexmark supports the use of recycled office paper produced specifically for
use in laser (electrophotographic) printers. In 1998, Lexmark presented to the US government a study demonstrating
thatrecycled paper produced by major mills in the US fed as well as non-recycled paper. However, no blanket statement
can be made that all recycled paper will feed well.

Lexmark consistently tests its printers with recycled paper (20-100% post-consumer waste) and a variety of test paper
from around the world, using chamber tests for different temperature and humidity conditions. Lexmark has found no
reason to discourage the use of today's recycled office papers, but generally the following property guidelines apply
to recycled paper.

® Low moisture content (4-5%)
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® Suitable smoothness (100—200 Sheffield units, or 140—350 Bendtsen units, European)

Note: Some much smoother papers (such as premium 24 Ib laser papers, 50-90 Sheffield units) and much
rougher papers (such as premium cotton papers, 200—300 Sheffield units) have been engineered to work very
well in laser printers, despite surface texture. Before using these types of paper, consult your paper supplier.

® Suitable sheet-to-sheet coefficient of friction (0.4—0.6)

® Sufficient bending resistance in the direction of feed
Recycled paper, paper of lower weight (<60 g/m? [16 |b bond]) and/or lower caliper (<3.8 mils [0.1 mm]), and paper
that is cut grain-short for portrait (or short-edge) fed printers may have lower bending resistance than is required for
reliable paper feeding. Before using these types of paper for laser (electrophotographic) printing, consult your paper
supplier. Remember that these are general guidelines only and that paper meeting these guidelines may still cause

paper feeding problems in any laser printer (for example, if the paper curls excessively under normal printing
conditions).

Storing paper

Use these paper storage guidelines to help avoid jams and uneven print quality:

® For best results, store paper where the temperature is 21°C (70°F) and the relative humidity is 40 percent. Most
label manufacturers recommend printing in a temperature range of 18-24°C (65—75°F) with relative humidity
between 40 and 60 percent.

® Store paper in cartons, on a pallet or shelf, rather than on the floor.
® Store individual packages on a flat surface.
® Do not store anything on top of individual paper packages.

® Take paper out of the carton or wrapper only when you are ready to load it in the printer. The carton and wrapper
help keep the paper clean, dry, and flat.

Supported paper sizes, types, and weights

This chapter provides information on standard and optional paper sources and the types of paper they support.

Note: For an unlisted paper size, select the closest larger listed size.

Supported paper sizes

Note: Your printer model may have a 650-sheet duo tray, which consists of a 550-sheet tray and an integrated
100-sheet multipurpose feeder. The 550-sheet tray of the 650-sheet duo tray supports the same paper sizes as the
optional 550-sheet tray. The integrated multipurpose feeder supports different paper sizes, types, and weights.
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Paper size and Standard \ELTIE]] 650-sheet duo tray 550-sheet Duplex
dimension 250-sheet tray feeder tray mode

550-sheet tray Multipurpose
feeder

A4 V! v e E V! v
210 x 297 mm
(8.3x11.7in.)

A5 \/1 \/ \/2 \/1 \/2 X
148 x 210 mm
(5.83x8.3in.)

A6 X \/ X \/1 X X

105 x 148 mm
(4.1x5.8in.)

JISBS \/1 \/ \/1 ‘/1 \/1 X
182 x 257 mm
(7.2x10.1in.)

Letter \/1 \/ \/1 ‘/1 \/1 \/
216 x 279 mm
(8.5x11in.)

Legal \/1 \/ \/1 \/1 \/1 \/
216 x 356 mm
(8.5x14in.)

Executive \/ 1 \/ \/ 1 \/ 1 \/ 1 X
184 x 267 mm
(7.3x10.5in.)

Oficio (Mexico) \/ 1 \/ \/ 1 ‘/ 1 \/ 1 \/
216 x 340 mm
(8.5 x 13.4in.)

Folio \/1 \/ \/1 ‘/1 \/1 \/
216 x 330 mm
(8.5x13in.)

Statement X \/ X \/ 1 X X

140 x 216 mm
(5.5x8.5in.)

1 The paper source supports paper size without size sensing.

2 Universal is only supported in the standard 250and optional 550sheet tray if the paper size is from 148 x 215.9 mm (5.83
x 8.5 inches) to 215.9 x 355.6 mm (8.5 x 14 inches).

3Universal is only supported in the multipurpose feeder and manual feeder if the paper size is from 76.2 x 127 mm (3 x 5
inches) to 215.9 x 359.9 mm (8.5 x 14.17 inches).

4Universal is only supported in duplex mode if the width is between 210 mm (8.27 inches) and 215.9 mm (8.5 inches) and
length is between 279.4 mm (11 inches) and 355.6 mm (14 inches).
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Paper size and Standard \ELTIE] 650-sheet duo tray 550-sheet Duplex
dimension 250-sheet tray feeder tray mode

550-sheet tray Multipurpose
feeder

Universal X \/ 1,3 X \/ 1,3 X X

76x127 mm (3x5in.)to
216 x 356 mm
(8.5x14in.)

Universal \/1,2 \/ \/1,2 \/ \/1,2 \/4
148 x 210 mm (5.8 x 8.3
in) to 216 x 356 mm
(8.5x 14 in).

7 3/4 Envelope X \/ X \/1 X X
(Monarch)

98 x 191 mm
(3.9x7.5in.)

9 Envelope X \/ X \/ 1 X X

98 x 225 mm
(3.9x8.9in.)

10 Envelope X \/ X \/1 X X
105 x 241 mm
(4.1x9.5in.)

DL Envelope X \/ X ‘/1 X X
110 x 220 mm
(4.3x8.7in.)

C5 Envelope X \/ X \/1 X X
162x229 mm (6.4x9in.)

B5 Envelope X \/ X ‘/1 X X

176 x 250 mm
(6.9x9.8in.)

Other Envelope X \/ X ‘/1 X X

98 x 162 mm
(3.9x6.3in.)up to
176 x 250 mm
(6.9x9.8in.)

1 The paper source supports paper size without size sensing.

2 Universal is only supported in the standard 250and optional 550sheet tray if the paper size is from 148 x 215.9 mm (5.83
x 8.5 inches) to 215.9 x 355.6 mm (8.5 x 14 inches).

3Universal is only supported in the multipurpose feeder and manual feeder if the paper size is from 76.2 x 127 mm (3 x 5
inches) to 215.9 x 359.9 mm (8.5 x 14.17 inches).

4Universal is only supported in duplex mode if the width is between 210 mm (8.27 inches) and 215.9 mm (8.5 inches) and
length is between 279.4 mm (11 inches) and 355.6 mm (14 inches).
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Supported paper types and weights

Notes:

® Your printer model may have a 650-sheet duo tray, which consists of a 550-sheet tray and an integrated
100-sheet multipurpose feeder. The 550-sheet tray of the 650-sheet duo tray supports the same paper as the
550-sheet tray. The integrated multipurpose feeder supports different paper sizes, types, and weights.

® labels, transparencies, envelopes, and card stock always print at reduced speed.

Paper type 250-sheet tray Manual feeder 650-sheet duo tray 550-sheet tray Duplex mode
550-sheet tray Multipurpose
feeder
Paper v v v v v v
® Plain
® Recycled
® Glossy
* Bond

® Letterhead

® Preprinted

® Colored

® Light

® Heavy

® Rough/Cotton
® Custom Type [x]

Card stock \/ \/ \/ \/ X

Transparencies \/ \/ X \/ X X

Labels \/ \/ \/ \/ \/ X
® Paper

Envelope X \/ X \/ X X
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Printing

Printing a document

Printing a document

1 From the Paper menu on the printer control panel, set the paper type and size to match the paper loaded.

2 Send the print job:

For Windows users

a With a document open, click File > Print.

b Click Properties, Preferences, Options, or Setup.
€ Adjust the settings, if necessary.

d Click OK > Print.

For Macintosh users

a Customize the settings in the Page Setup dialog:
1 With a document open, choose File > Page Setup.

2 Choose a paper size or create a custom size to match the paper loaded.
3 Click OK.

b Customize the settings in the Print dialog:
1 With a document open, choose File > Print.
If necessary, click the disclosure triangle to see more options.
2 From the Print dialog and pop-up menus, adjust the settings if necessary.

Note: To print on a specific paper type, adjust the paper type setting to match the paper loaded, or
select the appropriate tray or feeder.

3 Click Print.

Printing in black and white

From the printer control panel, navigate to:

> Settings > m > Print Settings > n > Quality Menu > n > Print Mode > m > Black Only > m

Adjusting toner darkness

Using the Embedded Web Server

1 Open a Web browser, and then type the IP address of the printer in the address field.
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Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Print Settings > Quality Menu > Toner Darkness.

3 Adjust the toner darkness, and then click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

> Settings > m > Print Settings > m > Quality Menu > m > Toner Darkness

2 Adjust the toner darkness, and then press m

Using Max Speed and Max Yield

Max Speed and Max Yield let you choose between a faster print speed or a higher toner yield. Max Yield is the factory
default setting.

® Max Speed—This lets you print in either black or color depending on what is set in the printer driver. The printer
prints in color unless Black Only is selected in the printer driver.

® Max Yield—This lets you switch from black to color based on the color content found on each page. Frequent color
mode switching can result to slower printing if the content of pages is mixed.

Using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

® View the printer IP address on the printer home screen. The IP address appears as four sets of numbers
separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Print Settings > Setup Menu.
3 From the Printer Usage list, select Max Speed or Max Yield.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

> Settings > m > Settings > n > Print Settings > n > Setup Menu > n > Printer Usage > m

2 Select Max Speed or Max Yield, and then press n
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Printing from a flash drive

Printing from a flash drive

Notes:

® Before printing an encrypted PDF file, you will be prompted to enter the file password from the printer control
panel.

® You cannot print files for which you do not have printing permissions.

1 Insert a flash drive into the USB port.

Notes:

® Aflash drive icon appears on the printer control panel and in the held jobs icon when a flash drive is
installed.

® |f you insert the flash drive when the printer requires attention, such as when a jam has occurred, then the
printer ignores the flash drive.

® |f you insert the flash drive while the printer is processing other print jobs, then Busy appears. After these
print jobs are processed, you may need to view the held jobs list to print documents from the flash drive.

Warning—Potential Damage: Do not touch the printer or the flash drive in the area shown while actively
printing, reading, or writing from the memory device. Loss of data can occur.

2 From the printer control panel, select the document you want to print.
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3 Press the left or right arrow button to specify the number of copies for printing, and then press n

Notes:

® Do not remove the flash drive from the USB port until the document has finished printing.

® |f you leave the flash drive in the printer after leaving the initial USB menu screen, then access held jobs
from the printer control panel to print files from the flash drive.

Supported flash drives and file types

Flash drive File type

® Lexar JumpDrive 2.0 Pro (256MB, 512MB, or 1GB sizes) Documents:
® SanDisk Cruzer Mini (256MB, 512MB, or 1GB sizes) * .pdf
Notes: ® Xps
Images:
® High-speed USB flash drives must support the fullspeed standard. Low-speed USB devices . 4
are not supported. -acx
® USB flash drives must support the File Allocation Table (FAT) system. Devices formatted * gif
with New Technology File System (NTFS) or any other file system are not supported. ® .jpegor .jpg
®* bmp
® .pcx
® tiff or .tif
¢ .png
* fls

Printing confidential and other held jobs

Storing print jobs in the printer

1 From the printer control panel, navigate to:

> Settings > > Security > > Confidential Print > select the print job type
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2

Print job type Description

Max Invalid PIN Limits the number of times an invalid PIN can be entered.

Note: When the limit is reached, the print jobs for that user name and PIN are
deleted.

Confidential Job Expiration Lets you hold print jobs in the computer until you enter the PIN from the printer
control panel.

Note: The PIN is set from the computer. It must be four digits, using the
numbers 0-9.

Repeat Job Expiration Lets you print and store print jobs in the printer memory for reprinting.

Verify Job Expiration Lets you print one copy of a print job while the printer holds the remaining
copies. It allows you to examine if the first copy is satisfactory. The print job is
automatically deleted from the printer memory once all copies are printed.

Reserve Job Expiration Lets you store print jobs for printing at a later time. The print jobs are held until
deleted from the Held Jobs menu.

Notes:
® Confidential, Verify, Reserve, and Repeat print jobs may be deleted if the printer requires extra memory to
process additional held jobs.

® You can set the printer to store print jobs in the printer memory until you start the print job from the printer
control panel.

® All print jobs that can be initiated by the user at the printer are called held jobs.

Press .

Printing confidential and other held jobs

Note: Confidential and Verify print jobs are automatically deleted from memory after printing. Repeat and Reserve
jobs are held in the printer until you delete them.

For Windows users

1

2
3
4

(6, ]

With a document open, click File > Print.
Click Properties, Preferences, Options, or Setup.
Click Print and Hold.

Select the print job type (Confidential, Repeat, Reserve, or Verify), and then assign a user name. For a confidential
print job, also enter a four-digit PIN.

Click OK or Print.

6 From the printer home screen, release the print job.

® For confidential print jobs, navigate to:
Held jobs > select your user name > Confidential Jobs > enter the PIN > Print
® For other print jobs, navigate to:
Held jobs > select your user name > select the print job > specify the number of copies > Print
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For Macintosh users

1 With a document open, choose File > Print.

If necessary, click the disclosure triangle to see more options.
2 From the print options or Copies & Pages pop-up menu, choose Job Routing.

3 Select the print job type (Confidential, Repeat, Reserve, or Verify), and then assign a user name. For a confidential
print job, also enter a four-digit PIN.

4 Click OK or Print.

5 From the printer home screen, release the print job.

® For confidential print jobs, navigate to:
Held jobs > select your user name > Confidential Jobs > enter the PIN > Print

® For other print jobs, navigate to:
Held jobs > select your user name > select the print job > specify the number of copies > Print

Printing information pages

Printing a font sample list

1 From the printer control panel, navigate to:

> Settings > n > Reports > n > Print Fonts

2 Press the up or down arrow button to select the font setting.

3 Press m

Note: The PPDS fonts appear only when the PPDS data stream is activated.

Printing a directory list

From the printer control panel, navigate to:

> Settings > m > Reports > m > Print Directory > n

Note: The Print Directory menu item appears only when an optional flash memory or printer hard disk is installed.
Canceling a print job

Canceling a print job from the printer control panel

From the printer control panel, press . > m
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Canceling a print job from the computer

For Windows users
1 Open the printers folder.

a Click @, or click Start and then click Run.

b In the Start Search or Run dialog, type control printers.
C Press Enter, or click OK.
2 Double-click the printer icon.

3 Select the print job you want to cancel.

4 Click Delete.

For Macintosh users
1 From the Apple Menu, navigate to either of the following:
® System Preferences > Print & Scan > select a printer > Open Print Queue

® System Preferences > Print & Fax > select a printer > Open Print Queue

2 From the printer window, select the print job you want to cancel, and then click Delete.
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Understanding the printer menus

Menus list

Note: Some menus are available only in select printer models.

Supplies Paper Menu Reports
Cyan Cartridge Default Source Menu Settings Page
Magenta Cartridge Paper Size/Type Device Statistics
Yellow Cartridge Configure MP?! Network Setup Page
Black Cartridge Substitute Size  Network [x] Setup Page
Waste Toner Bottle Paper Texture Profiles List
Black or Color Imaging Kit Paper Weight Print Fonts
Maintenance Kit Paper Loading Print Directory

Custom Types Print Demo

Custom Names  Asset Report

Universal Setup

Security Settings Help
Miscellaneous Security Settings General Settings  Print All Guides
Confidential Print Flash Drive Menu Color Quality

Disk Wiping Print Settings Print Quality
Security Audit Log Printing Guide

Set Date and Time Print Defects Guide

Information Guide

Supplies Guide

1 This menu item appears only when a 650-sheet duo tray is attached.

Network/Ports
Active NIC

Standard Network or Network [x]
Standard USB
SMTP Setup

Option Card Menu

Note: A list of installed DLEs (Download
Emulators) appears.



Understanding the printer menus

65

Supplies menu

Use

Cyan, Magenta, Yellow, or Black Toner Cartridge

Nearly Low

Low

Very Low

Replace

Missing

Defective

Missing or Unresponsive
Unsupported

Invalid Region

OK

Non-genuine Lexmark Cartridge

To

Show the status of the cyan, magenta, yellow, or black toner
cartridge.

Black or Color Imaging Kit
Nearly Low
Low
Very Low
Replace
Missing
Defective
Missing or Unresponsive
Unsupported
OK

Non-genuine Lexmark Imaging Kit

Show the status of the black or color imaging kit.

Waste Toner Bottle
Near Full
Replace
Missing
OK

Show the status of the waste toner bottle.

Maintenance Kit
Nearly Low
Low
Very Low
Replace
OK

Show the status of the maintenance kit.
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Paper menu

Default Source menu

(VY] To

Default Source Set a default paper source for all print jobs.
Tray [x] Notes:
MP Feeder ' )
Manual Paper ® Tray 1 (standard tray) is the factory default setting.

Manual Envelope ® From the Paper menu, set Configure MP to “Cassette” for MP Feeder to
appear as a menu setting.

® |f the same size and type of paper are in two trays and the paper size and
paper type settings match, then the trays are automatically linked. When
one tray is empty, the print job continues using the linked tray.

Paper Size/Type menu

Use To

Tray [x] Size Specify the size of the paper loaded in each tray.
A4 Note: Letter is the US factory default setting. A4 is the international factory
A5 default setting.
JIS-B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Universal

Tray [x] Type Specify the type of the paper loaded in each tray.
Plain Paper
Card Stock
Transparency ® Plain Paper is the factory default setting for Tray 1. Custom Type [x] is

the factory default setting for all other trays.

Notes:

Recycled
® |f available, a user-defined name will appear instead of Custom Type [x].

Glossy
Labels ® Use this menu to configure automatic tray linking.
Bond ® Only the 250-sheet tray supports Transparency.
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Note: Only installed trays and feeders are listed in this menu.
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Use

MP Feeder Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
C5 Envelope
B5 Envelope
Other Envelope

To
Specify the size of the paper loaded in the multipurpose feeder.
Notes:
® Letteris the U.S. factory default setting. A4 is the international factory
default setting.

® From the Paper menu, set Configure MP to Cassette in order for MP
Feeder Size to appear as a menu.

® The multipurpose feeder does not automatically detect the paper size.
Make sure the paper size is set.

MP Feeder Type
Plain Paper
Card Stock
Transparency
Recycled
Glossy
Labels
Bond
Envelope
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the type of the paper loaded in the multipurpose feeder.
Notes:

® Custom [x] is the factory default setting.

® From the Paper menu, set Configure MP to Cassette in order for MP
Feeder Type to appear as a menu.

Note: Only installed trays and feeders are listed in this menu.
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Use

Manual Paper Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal

To

Specify the size of the paper being manually loaded.

Note: Letter is the US factory default setting. A4 is the international factory
default setting.

Manual Paper Type
Plain Paper
Card Stock
Transparency
Recycled
Glossy
Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the type of the paper being manually loaded.

Notes:

® Plain Paper is the factory default setting.

® From the Paper menu, set Configure MP to Manual in order for Manual
Paper Type to appear as a menu.

Manual Envelope Size

7 3/4 Envelope

9 Envelope

10 Envelope

DL Envelope

C5 Envelope

B5 Envelope
Other Envelope

Specify the size of the envelope being manually loaded.

Note: 10 Envelope is the US factory default setting. DL Envelope is the
international factory default setting.

Manual Envelope Type
Envelope
Custom Type [x]

Specify the type of the envelope being manually loaded.

Note: Envelope is the factory default setting.

Note: Only installed trays and feeders are listed in this menu.
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Configure MP menu

Use To

Configure MP Determine when the printer selects paper from the multipurpose feeder.
Cassette Notes:
Manual
First ® Cassette is the factory default setting. Cassette configures the

multipurpose feeder as the automatic paper source.

® Manual sets the multipurpose feeder only for manual-feed print jobs.

® First configures the multipurpose feeder as the primary paper source.

Substitute Size menu

Use To
Substitute Size Substitute a specified paper size if the requested paper size is not available.
Off Notes:
Statement/A5
Letter/Ad ® All Listed is the factory default setting. All available substitutions are
. allowed.
All Listed

® Off indicates that no size substitutions are allowed.

® Setting a size substitution lets the print job continue without Change
Paper appearing.

Paper Texture menu

Use To
Plain Texture Specify the relative texture of the plain paper loaded.
Smooth Note: Normal is the factory default setting.
Normal
Rough
Card Stock Texture Specify the relative texture of the card stock loaded.
Smooth Notes:
Normal ) _
Rough ® Normal is the factory default setting.
® The options appear only if card stock is supported.
Transparency Texture Specify the relative texture of the transparencies loaded.
Smooth Note: Normal is the factory default setting.
Normal
Rough
Recycled Texture Specify the relative texture of the recycled paper loaded.
Smooth Note: Normal is the factory default setting.
Normal

Rough
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Use

Glossy Texture

To

Specify the relative texture of the glossy paper loaded.

Smooth Note: Normal is the factory default setting.
Normal
Rough
Heavy Glossy Texture Specify the relative texture of the heavy glossy paper loaded.
Smooth Note: Normal is the factory default setting.
Normal
Rough
Labels Texture Specify the relative texture of the labels loaded.
Smooth Note: Normal is the factory default setting.
Normal
Rough
Bond Texture Specify the relative texture of the bond paper loaded.
Smooth Note: Rough is the factory default setting.
Normal
Rough
Envelope Texture Specify the relative texture of the envelopes loaded.
Smooth Note: Normal is the factory default setting.
Normal
Rough
Letterhead Texture Specify the relative texture of the letterhead loaded.
Smooth Note: Normal is the factory default setting.
Normal
Rough
Preprinted Texture Specify the relative texture of the preprinted paper loaded.
Smooth Note: Normal is the factory default setting.
Normal
Rough
Colored Texture Specify the relative texture of the colored paper loaded.
Smooth Note: Normal is the factory default setting.
Normal
Rough
Light Texture Specify the relative texture of the light paper loaded.
Smooth Note: Normal is the factory default setting.
Normal
Rough
Heavy Texture Specify the relative texture of the heavy paper loaded.
Smooth Note: Normal is the factory default setting.
Normal
Rough
Rough/Cotton Texture Specify the relative texture of the cotton paper loaded.

Rough
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Custom [x] Texture

Smooth
Normal
Rough

Specify the relative texture of the custom paper loaded.

Notes:

® Normal is the factory default setting.

® The options appear only if custom type is supported.

Paper Weight menu

Use To

Plain Weight Specify the relative weight of the plain paper loaded.
Light Note: Normal is the factory default setting.
Normal
Heavy

Card Stock Weight Specify the relative weight of the card stock loaded.
Light Note: Normal is the factory default setting.
Normal
Heavy

Transparency Weight Specify the relative weight of the transparencies loaded.
Light Note: Normal is the factory default setting.
Normal
Heavy

Recycled Weight Specify the relative weight of the recycled paper loaded.
Light Note: Normal is the factory default setting.
Normal
Heavy

Glossy Weight
Light
Normal
Heavy

Specify the relative weight of the glossy paper loaded.

Note: Normal is the factory default setting.

Heavy Glossy Weight

Specify the relative weight of the heavy glossy paper loaded.

Heavy

Light Note: Normal is the factory default setting.
Normal
Heavy
Labels Weight Specify the relative weight of the labels loaded.
Light Note: Normal is the factory default setting.
Normal
Heavy
Bond Weight Specify the relative weight of the bond paper loaded.
Light Note: Normal is the factory default setting.
Normal
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Envelope Weight
Light
Normal
Heavy

To

Specify the relative weight of the envelope loaded.

Note: Normal is the factory default setting.

Rough Envelope Weight

Specify the relative weight of the rough envelope loaded.

Light Note: Heavy is the factory default setting.
Normal
Heavy
Letterhead Weight Specify the relative weight of the letterhead loaded.
Light Note: Normal is the factory default setting.
Normal
Heavy
Preprinted Weight Specify the relative weight of the preprinted paper loaded.
Light Note: Normal is the factory default setting.
Normal
Heavy
Colored Weight Specify the relative weight of the colored paper loaded.
Light Note: Normal is the factory default setting.
Normal
Heavy
Light Weight Specify that the relative weight of the paper loaded is light.
Light
Heavy Weight Specify that the relative weight of the paper loaded is heavy.
Heavy
Rough/Cotton Weight Specify the relative weight of the rough or cotton paper loaded.
Light Note: Normal is the factory default setting.
Normal
Heavy

Custom [x] Weight
Light
Normal
Heavy

Specify the relative weight of the custom paper loaded.

Notes:

® Normal is the factory default setting.

® The options appear only when the custom type is supported.
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Paper Loading menu

Use

Cardstock Loading
Off

To

Determine and set two-sided printing for all print jobs that specify
Cardstock as the paper type.

Recycled Loading
Duplex
Off

Determine and set two-sided printing for all print jobs that specify
Recycled as the paper type.

Glossy Loading
Duplex
Off

Determine and set two-sided printing for all print jobs that specify
Glossy as the paper type.

Heavy Glossy Loading
Off

Determine and set two-sided printing for all print jobs that specify
Heavy Glossy as the paper type.

Labels Loading
Off

Determine and set two-sided printing for all print jobs that specify
Labels as the paper type.

Bond Loading
Duplex
Off

Determine and set two-sided printing for all print jobs that specify
Bond as the paper type.

Letterhead Loading
Duplex
Off

Determine and set two-sided printing for all print jobs that specify
Letterhead as the paper type.

Preprinted Loading
Duplex
Off

Determine and set two-sided printing for all print jobs that specify
Preprinted as the paper type.

Colored Loading
Duplex
Off

Determine and set two-sided printing for all print jobs that specify
Colored as the paper type.

Light Loading
Duplex
Off

Determine and set two-sided printing for all print jobs that specify
Light as the paper type.

Heavy Loading
Duplex
Off

Determine and set two-sided printing for all print jobs that specify
Heavy as the paper type.

Rough/Cotton Loading
Off

Determine and set two-sided printing for all print jobs that specify
Rough/Cotton as the paper type.

Notes:

® Duplex sets the printer default to two-sided printing for every print job unless one-sided printing is selected from

Printing Preferences or the Print dialog.

® Off is the factory default setting for all the menus.
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Custom [x] Loading

Determine and set two-sided printing for all print jobs that specify

Duplex Custom [x] as the paper type.
Off Note: Custom [x] Loading is available only when the custom type is
supported.
Notes:

® Duplex sets the printer default to two-sided printing for every print job unless one-sided printing is selected from
Printing Preferences or the Print dialog.

® Off is the factory default setting for all the menus.

Custom Types menu

Use To
Custom Type [x] Associate a paper or specialty media type with a factory default Custom Type [x]
Paper name or a user-defined custom name created in the Embedded Web Server or
Card Stock MarkVision™ Professional.
Transparency Notes:
Gloss
y ® Paper is the factory default setting for Custom Type [x].
Rough/Cotton
Labels ® The custom media type must be supported in the selected tray or feeder
in order to print from that source.
Envelope
Recycled Specify a paper type when Recycled is selected.
Paper Notes:
Card Stock _ )
Transparency ® Paper is the factory default setting.
Glossy ® The Recycled paper type must be supported in the selected tray or
Rough/Cotton feeder in order to print from that source.
Labels
Envelope

Universal Setup menu

Units of Measure

Inches
Millimeters

Identify the units of measure.

Notes:

® Inches is the US factory default setting.

® Millimeters is the international factory default setting.
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Use

Portrait Width
3-8.5 inches
76-216 mm

To
Set the width for portrait orientation.
Notes:
® |f the width exceeds the maximum, then the printer uses the
maximum width allowed.

® 8.5inches is the US factory default setting. You can increase the
width in 0.01-inch increments.

® 216 mm is the international factory default setting. You can increase
the width in 1-mm increments.

Portrait Height
3-14.17 inches
76—-360 mm

Set the width for portrait orientation.

Notes:
® |f the height exceeds the maximum, then the printer uses the
maximum height allowed.

® 14 inches is the US factory default setting. You can increase the
height in 0.01-inch increments.

® 356 mm is the international factory default setting. You can increase
the height in 1-mm increments.

Reports menu

Reports menu

Use

Menu Settings Page

To

Print a report containing information about paper loaded in trays, installed
memory, the total page count, alarms, timeouts, the printer control panel
language, the TCP/IP address, the status of supplies, the status of the network
connection, and other information.

Device Statistics

Print a report containing printer statistics such as supply information and details
about printed pages.

Network Setup Page

Print a report containing information about the network printer settings, such as
the TCP/IP address.

Note: This menu appears only in network printers or printers connected to
print servers.

Network [x] Setup Page

Print a report containing information on network printer settings, such as the
TCP/IP address information.

Notes:
® This menu item is available only when more than one network option is
installed.

® This menu item appears only in network printers or in printers connected
to print servers.

Profiles List

Print a list of profiles stored in the printer.
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Use To

Print Fonts Printareport in English of all the fonts available for the printer language currently
PCL Fonts set in the printer.
PostScript Fonts Note: A separate list is available for PCL and PostScript emulations. Each

emulation report contains print samples and information about the available
fonts for each language.

Print Demo Print demo files that are available in the RIP code, the flash option, and the disk

Demo Page option.
[list of available demo pages]

Asset Report Print a report containing asset information including the printer serial number
and model name. The report contains text and UPC bar codes that can be scanned
into an asset database.

Network/Ports menu

Active NIC menu

Menu item Description
Active NIC Notes:
Auto

® Auto is the factory default setting.

[list of available network cards] . . . . o
® This menu item appears only if an optional network card is installed.

Standard Network or Network [x] menu

Note: Only active ports appear in this menu.

Use To

PCL SmartSwitch Set the printer to automatically switch to PCL emulation when a print job requires
On it, regardless of the default printer language.
off Notes:

® Onis the factory default setting.
® |f PCL SmartSwitch is enabled, then the printer uses PostScript emulation.

® |f PCL SmartSwitch is disabled, then the printer does not examine incoming
data and it uses the default printer language specified in the Setup menu.

PS SmartSwitch Set the printer to automatically switch to PS emulation when a print job requires it,
On regardless of the default printer language.
off Notes:

® Onis the factory default setting.
® |f PS SmartSwitch is enabled, then the printer uses PostScript emulation.

® |f PS SmartSwitch is disabled, then the printer does not examine incoming
data and it uses the default printer language specified in the Setup menu.
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Use

NPA Mode
Off
Auto

To

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.

Notes:

Auto is the factory default setting.

Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Network Buffer
Disabled
Auto
3KB to [maximum size allowed]

Set the size of the network input buffer.

Notes:

Auto is the factory default setting.
The value can be changed in 1-KB increments.

The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

To increase the maximum size range for the Network Buffer, disable or
reduce the size of the parallel, serial, and USB buffers.

Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Mac Binary PS
On
Off
Auto

Set the printer to process Macintosh binary PostScript print jobs.

Notes:

Auto is the factory default setting.
Off filters print jobs using the standard protocol.

On processes raw binary PostScript print jobs.

Standard Network Setup OR
Network [x] Setup

Reports
Network Card
TCP/IP

IPv6

Wireless
AppleTalk

Display and set the printer network settings.

Note: The Wireless menu appears only when the printer is connected to a wireless
network.

Reports menu

To access the menu, navigate to either of the following:

® Network/Ports > Standard Network > Standard Network Setup > Reports

® Network/Ports > Network [x] > Network [x] Setup > Reports

Print Setup Page | Print a report containing information about the network printer settings, such as the TCP/IP address.
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Network Card menu

To access the menu, navigate to either of the following:
® Network/Ports > Standard Network > Standard Network Setup > Network Card
® Network/Ports > Network [x] > Network [x] Setup > Network Card

Use To

View Card Status View the connection status of the network card.
Connected
Disconnected

View Card Speed View the speed of an active network card.
Network Address View the network addresses.
UAA
LAA
Job Timeout Set the amount of time it takes for a network print job to be canceled.
0, 10-225 seconds Notes:

® 90 seconds is the factory default setting.
® A setting value of 0 disables the timeout.

® |favalue between 1 and 9 is selected, then Invalid appears on the
display, and the value is not saved.

TCP/IP menu

To access the menu, navigate to either of the following:
® Network/Ports > Standard Network > Standard Network Setup > TCP/IP
* Network/Ports > Network [x] > Network [x] Setup > TCP/IP

Note: This menu is available only in network printers or printers that are attached to print servers.

Use To
Set Hosthame Set the current TCP/IP hostname.
IP Address View or change the current TCP/IP address.

Note: Manually setting the IP address sets the Enable DHCP and Enable Auto IP
settings to Off. It also sets Enable BOOTP and Enable RARP to Off on systems that
support BOOTP and RARP.

Netmask View or change the current TCP/IP netmask.
Gateway View or change the current TCP/IP gateway.
Enable DHCP Specify the DHCP address and parameter assignment.
On Note: On is the factory default setting.
Off
Enable RARP Specify the RARP address assignment setting.
On Note: Off is the factory default setting.

Off
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Use To
Enable BOOTP Specify the BOOTP address assignment setting.
On Note: On is the factory default setting.
Off
Enable AutolP Specify the Zero Configuration Networking setting.
Yes Note: Yes is the factory default setting.
No
Enable FTP/TFTP Send files to the printer using the built-in FTP server.
Yes Note: Yes is the factory default setting.
No
Enable HTTP Server Enable the built-in Web server (Embedded Web Server) which lets you monitor and
Yes manage the printer remotely using a Web browser.
No Note: Yes is the factory default setting.
WINS Server Address View or change the current WINS server address.
Enable DDNS View or change the current DDNS setting.
Yes Note: Yes is the factory default setting.
No
Enable mDNS View or change the current mDNS setting.
Yes Note: Yes is the factory default setting.
No
DNS Server Address View or change the current DNS server address.
Backup DNS Server Address [x] View or change the current DNS server address.
Enable HTTPS View or change the current HTTPS setting.
Yes Note: Yes is the factory default setting.
No
IPvé menu

To access the menu, navigate to any of the following:
® Network/Ports menu > Standard Network > Standard Network Setup >IPv6

® Network/Ports menu > Network [x] > Network [x] Setup > IPv6
Note: This menu is available only in network printers or printers that are attached to print servers.

| Use To

Enable IPv6 Enable IPv6 in the printer.
On Note: On is the factory default setting.
Off
Auto Configuration Specify whether or not the network adapter accepts the automatic IPv6
On address configuration entries provided by a router.
Off Note: On is the factory default setting.
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Use

Set Hosthame

View Address

View Router Address

To

Set the host name.

Note: These settings can be changed only from the Embedded Web
Server.

Enable DHCPv6
On
Off

Enable DHCPv6 in the printer.
Note: On is the factory default setting.

Wireless menu

Note: This menu is available only in printers connected to a wireless network or printer models that have a wireless

network adapter.

To access the menu, navigate to:

® Network/Ports > Network [x] > Network [x] Setup > Wireless

Use

Wi-Fi Protected Setup (WPS)
Start Push Button Method
Start PIN Method

To
Establish a wireless network and enable network security.

Notes:

® Start Push Button Method connects the printer to a wireless
network when buttons on both the printer and the access point
(wireless router) are pressed within a given period of time.

® Start PIN Method connects the printer to a wireless network when
a PIN on the printer is entered into the wireless settings of the
access point.

Enable/Disable WPS Auto-detection
Enable
Disable

Automatically detect the connection method that an access point with
WPS uses—Start Push Button Method or Start PIN Method.

Note: Disable is the factory default setting.

Network Mode

Specify the network mode.

802.11b/g/n

BSS Type Notes:
Infrastructure
Ad hoc ® Infrastructure is the factory default setting. This lets the printer
access a network using an access point.
® Ad hoc configures wireless connection directly between the printer
and a computer.
Compatibility Specify the wireless standard for the wireless network.
802.11b/g Note: The 802.11b/g/n is the factory default setting.

Choose Network

Select an available network for the printer to use.

View Signal Quality

View the quality of the wireless connection.

View Security Mode

View the encryption method for the wireless network.
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AppleTalk menu

Note: This menu is available only in printer models connected to a wired network or when an optional network card
is installed.

To access the menu, navigate to any of the following:
® Network/Ports > Standard Network > Standard Network Setup > AppleTalk
® Network/Ports > Network Setup [x] > AppleTalk

Use To

Activate Enable or disable AppleTalk support.
Yes Note: Yes is the factory default setting.
No

View Name Show the assigned AppleTalk name.

Note: The name can be changed only from the Embedded Web Server.

View Address Show the assigned AppleTalk address.
Note: The address can be changed only from the Embedded Web Server.

Set Zone Provide a list of AppleTalk zones available on the network.

[list of zones available on the network] | Note: The factory default setting is the default zone for the network. If no
default zone exists, then the zone marked with an asterisk (*) is the default

setting.
Standard USB menu
Use To
PCL SmartSwitch Set the printer to automatically switch to PCL emulation when a print job received
On through a USB port requires it, regardless of the default printer language.
Off Notes:

® Onis the factory default setting.
® |f PCL SmartSwitch is enabled, then the printer uses PostScript emulation.

® |f PCL SmartSwitch is disabled, then the printer does not examine incoming
data and it uses the default printer language specified in the Setup menu.

PS SmartSwitch Set the printer to automatically switch to PS emulation when a print job received
On through a USB port requires it, regardless of the default printer language.
off Notes:

® Onis the factory default setting.
® |f PS SmartSwitch is enabled, then the printer uses PostScript emulation.

® |f PS SmartSwitch is disabled, then the printer does not examine incoming data
and it uses the default printer language specified in the Setup menu.
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Use To
NPA Mode Set the printer to perform the special processing required for bidirectional
On communication following the conventions defined by the NPA protocol.
Off Notes:
Auto . . . .
® Auto is the factory default setting. Auto sets the printer to examine data,
determine the format, and then process it appropriately.
® The printer automatically restarts when changing the setting from the printer
control panel. The menu selection is then updated.
USB Buffer Set the size of the USB input buffer.
Disabled Notes:
Auto

3K to [maximum size allowed]

® Auto is the factory default setting.

® Disabled turns off job buffering. Any jobs already buffered in the printer hard
disk are printed before normal processing resumes.

® The USB buffer size value can be changed in 1KB increments.

® The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is enabled or
disabled.

® To increase the maximum size range for the USB Buffer, disable or reduce the
size of the parallel, serial, and network buffers.

® The printer automatically restarts when the setting is changed from the printer
control panel. The menu selection is then updated.

Mac Binary PS

Set the printer to process Macintosh binary PostScript print jobs.

On Notes:
Off
Auto ® Auto is the factory default setting.
® On processes raw binary PostScript print jobs.
® Off filters print jobs using the standard protocol.
ENA Address Set the network address, netmask, and gateway information for an external print
YYY-YYY-YYY.yYYy server.
ENA Netmask Note: This menu is available only when the printer is attached to an external print
server through the USB port.
YYY-YYY-YYY.YYY
ENA Gateway
YYY-YYY-YYY.YYY

SMTP Setup menu

Use

Primary SMTP Gateway

To

Specify SMTP server gateway and port information.

Primary SMTP Gateway Port

Note: 25 is the default SMTP gateway port.

Secondary SMTP Gateway

Secondary SMTP Gateway Port
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Use To
SMTP Timeout Specify the amount of time in seconds before the server stops trying to
5-30 send an e-mail.
Note: 30 seconds is the factory default setting.
Reply Address Specify a reply address of up to 128 characters in the e-mail sent by the
printer.
Use SSL Set the printer to use SSL for increased security when connecting to the
Disabled SMTP server.
Negotiate Notes:
Required

® Disabled is the factory default setting.

® When the Negotiate setting is used, the SMTP server determines if
SSL will be used.

SMTP Server Authentication
No authentication required
Login/Plain
CRAM-MD5
Digest-MD5
NTLM
Kerberos 5

Specify the type of user authentication required for printing privileges.

Note: “No authentication required” is the factory default setting.

Device-Initiated E-mail
None
Use Device SMTP Credentials

Device Userid

Device Password

Specify what credentials will be used when communicating to the SMTP
server. Some SMTP servers require credentials to send an e-mail.

Notes:

® None is the factory default setting for Device-Initiated E-mail.

® Device Userid and Device Password are used to log in to the SMTP
server when Use Device SMTP Credentials is selected.

Security menu

Confidential Print menu

| Use To

Max Invalid PIN Limit the number of times an invalid PIN can be entered.
Off Notes:
2-10

® This menu appears only when a formatted, non-defective printer hard disk is installed.
® Once the limit is reached, the print jobs for that user name and PIN are deleted.

Note: Off is the factory default setting.
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Use

Confidential Job Expiration
Off
1 hour
4 hours
24 hours
1 week

To
Limit the amount of time a confidential print job stays in the printer before it is deleted.
Notes:

* |f the “Confidential Job Expiration” setting is changed while confidential print jobs

reside in the printer RAM or printer hard disk, then the expiration time for those print
jobs does not change to the new default value.

® |f the printer is turned off, then all confidential jobs held in the printer RAM are
deleted.

Repeat Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a time limit on how long the printer stores print jobs.

Verify Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a time limit on how long the printer stores print jobs needing verification.

Reserve Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a time limit on how long the printer stores print jobs for printing at a later time.

Note: Off is the factory default setting.

Disk Wiping menu

Disk Wiping erases only print job data on the printer hard disk that are not currently in use by the file system. All
permanent data on the printer hard disk are preserved, such as downloaded fonts, macros, and held jobs.

Note: This menu appears only when a formatted, non-defective printer hard disk is installed.

Wiping Mode
Auto

Specify the mode for disk wiping.
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(VY]

Automatic Method
Single pass
Multiple pass

To

Mark all disk space used by a previous print job. This method does not permit the file
system to reuse this space until it has been cleared.

Notes:

® “Single pass” is the factory default setting.

® Only automatic wiping enables users to activate disk wiping without having to
turn the printer off for an extended amount of time.

® Highly confidential information should be wiped using only the Multiple pass
method.

Security Audit Log menu

Use To
Export Log Let an authorized user export the audit log.
Notes:
® To export the audit log from the printer control panel, attach a flash drive to
the printer.
® The audit log can be downloaded from the Embedded Web Server and saved
on a computer.
Delete Log Specify whether or not audit logs are deleted.
Yes Note: Yes is the factory default setting.
No
Configure Log Specify how and whether or not audit logs are created.
Enable Audit Notes:
Yes
No ® Enable Audit determines if events are recorded in the secure audit log and
remote syslog. No is the factory default setting.
Enable Remote Syslog yslog ¥ &
No ® Enable Remote Syslog determines if logs are sent to a remote server. No is the
Yes factory default setting.

Remote Syslog Facility
0-23

Severity of Events to Log
0-7

® Remote Syslog Facility determines the value used to send logs to the remote
syslog server. 4 is the factory default setting.

® |f the security audit log is activated, then the severity value of each event is
recorded. 4 is the factory default setting.

Set Date and Time menu

Use

Current Date and Time

To

View the current date and time settings for the printer.
Note: The date and time are set in YYYY-MM-DD HH:MM format.

Manually Set Date and Time
[input date/time]

Enter the date and time.

Note: Setting the date and time using this menu automatically sets Enable NTP to
Off.
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Use To
Time Zone Select the time zone.
[list of time zones] Note: GMT is the factory default setting.
Automatically observe DST Set the printer to use the applicable daylight saving time (DST) start and end times
On associated with the printer Time Zone setting.
Off Note: On is the factory default setting.
Enable NTP Enable Network Time Protocol, which synchronizes the clocks of devices on a
On network.
Off Notes:
® Onis the factory default setting.
\ ® Enable NTP is automatically set to Off if you manually set the date and time. )

Settings menu

General Settings menu

Use To

Display Language Set the language of the text that appears on the display.
English Note: Not all languages are available for all printers, and you may
Francais need to install special hardware for those languages to appear.
Deutsch
Italiano
Espanol
Dansk
Norsk
Nederlands
Svenska
Portuguese
Suomi
Russian
Polski
Greek
Magyar
Turkce
Cesky
Simplified Chinese
Traditional Chinese
Korean
Japanese

Show Supply Estimates Display the estimates of the supplies on the printer control panel,
Show estimates Embedded Web Server, menu settings, and the device statistics

Do not show estimates reports.

Note: “Show estimates” is the factory default setting.
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Use To
Eco-Mode Minimize the use of energy, paper, or specialty media.
off Notes:
Energy
Energy/Paper ® Off is the factory de-fault setting. Off resets the printer to its
factory default settings.
Paper

® Energy minimizes the power used by the printer.

® Energy/Paper minimizes the use of power, paper, and
specialty media.

® Paper minimizes the amount of paper and specialty media
needed for a print job by duplexing each page.

Quiet Mode Reduce the amount of noise produced by the printer.
off Notes:
On

® Off is the factory default setting. This setting supports the
performance specifications of your printer.

® On configures the printer to produce as little noise as
possible.

® Setting Quiet mode to Off allows for optimal printing of color-
rich documents.

Run Initial Setup Run the setup wizard.
Yes Notes:
No

® Yesis the factory default setting.

® When the setup wizard is complete, the default setting

becomes No.
Paper Sizes Specify the default paper measurement.
us Notes:
Metric
® USis the factory default setting.
® The initial setting is determined by your country or region
selection in the initial setup wizard.
Home screen customization Add or remove icons and buttons that appear on the home screen.
Change language Available options for each home screen option are:
Search Held Jobs Display
Held jobs Do not display
USB Drive Notes:
Bookmarks
Jobs by user ® ”"Display” is the factory default setting for “Search Held Jobs,”

“Held jobs,” and “USB Drive.”

® ”Do not display” is the factory default setting for “Change
language,” “Bookmarks,” and “Jobs by user.”
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Use

Alarms
Alarm Control
Cartridge Alarm

To

Set an alarm to sound when the printer requires user intervention.
Available options for each alarm type are:

off

Single

Continuous

Notes:
® Single is the factory default setting. This sets the alarm as
three quick beeps.
® Off means no alarm will sound.
® Single sounds three quick beeps.

® Continuous repeats three beeps every 10 seconds.

Timeouts Specify the number of minutes of inactivity before the printer enters
Sleep Mode a reduced power state.
Disabled Notes:
1-120 . .
® 30 is the factory default setting.
® Disabled appears only when Energy Conserve is set to Off.
Timeouts Set the amount of time the printer waits before it goes into

Hibernate Timeout

Hibernate mode.

Disabled Notes:
1-3 hours . . .
6 hours ® Disabled is the factory default setting for Class A and Class B
printers in all countries except for European Union countries,
1-3 days Switzerland, and Canada.
1-2 weeks ® 3 days is the factory default setting for Class B printers in all
1 month European Union countries, Switzerland, and Canada.
® When the Hibernate Timer expires, the printer uses Ethernet
connection to check the value of “Hibernate Timeout on
Connection.”
® When “Hibernate Timeout on Connection” is set to Do Not
Hibernate, the device never automatically hibernates.
® When “Hibernate Timeout on Connection” is set to Hibernate,
the device follows the value of Hibernate Timeout, except
when it is set to Disabled.
Timeouts Set the amount of time (in seconds) the printer waits before

Screen Timeout
15-300

returning the display to the Ready state.

Note: 30 is the factory default setting.
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Use To
Timeouts Set the amount of time (in seconds) the printer waits to receive an
Print Timeout end-of-job message before canceling the remainder of the print job.
Disabled Notes:
1-255 ) )
® 90 is the factory default setting.
® When the timer expires, any partially printed page still in the
printer is printed, and then the printer checks to see if any
new print jobs are waiting.
® Print Timeout is available only when using PCL. This setting
has no effect on PostScript emulation print jobs.
Timeouts Set the amount of time (in seconds) the printer waits for additional
Wait Timeout data before canceling a print job.
Disabled Notes:
15-65535 ) )
® 40 is the factory default setting.
® Wait Timeout is available only when the printer is using
PostScript emulation. This setting has no effect on PCL
emulation print jobs.
Timeouts Set the amount of time (in seconds) the printer waits for user
Job Hold Timeout intervention before it holds jobs that require unavailable resources
5-255 and continues to process print jobs in the print queue.

Notes:

® 30 is the factory default setting.

® This menu appears only when a printer hard disk is installed.

Error Recovery
Auto Reboot
Reboot when idle
Reboot always
Reboot never

Set the printer to restart when an error is encountered.

Note: “Reboot always” is the factory default setting.

Error Recovery
Max Auto Reboots
1-20

Set the number of automatic restarts the printer can perform.

Notes:

® 5is the factory default setting.

® When the number of automatic restarts equivalent to the
values of this setting has been reached, the printer displays
the applicable error instead of restarting.

Print Recovery
Auto Continue
Disabled
5-255 sec

Let the printer automatically continue printing from certain offline
situations when not resolved within the specified period.

Note: Disabled is the factory default setting.
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Use

Print Recovery
Jam Recovery
On
Off
Auto

To
Specify whether the printer reprints jammed pages.

Notes:

® Auto is the factory default setting. The printer reprints
jammed pages unless the memory required to hold the pages
is needed for other printer tasks.

® On sets the printer to always reprint jammed pages.

® Off sets the printer to never reprint jammed pages.

Print Recovery
Page Protect
Off
On

Let the printer successfully print a page that may not have printed
otherwise.

Notes:
® Off is the factory default setting. Off prints a partial page
when there is not enough memory to print the whole page.

® On sets the printer to process the whole page so the entire
page prints.

Hibernate Timeout on Connection
Hibernate
Do Not Hibernate

Set the printer to recognize the Hibernate Timeout setting even
when an active Ethernet connection exists.

Note: Do Not Hibernate is the factory default setting.

Press Sleep Button
Do Nothing
Sleep
Hibernate

Determine how the printer, while inidle state, reacts to a short press
of the Sleep button.

Notes:

® Sleep is the factory default setting.

® Do Nothing ignores any Sleep button presses regardless of
duration.

Press and Hold Sleep Button
Do Nothing
Sleep
Hibernate

Determine how the printer, while in idle state, reacts to a long press
of the Sleep button.

Note: Do Nothing is the factory default setting. Do Nothing
ignores any Sleep button presses regardless of duration.

Factory Defaults
Do Not Restore
Restore Now

Return the printer settings to the factory default settings.

Notes:

® Do Not Restore is the factory default setting. Do Not Restore
keeps the user-defined settings.

® Restore Now returns all printer settings to the factory default
settings except those in the Network/Ports menu. All
downloads stored in the RAM are deleted. Downloads stored
in flash memory are not affected.

Export Configuration Package
Export

Export the printer configuration package to a flash drive.

Note: Make sure a flash drive is attached to the printer.
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Setup menu

Use To

Printer Language Set the default printer language.

PCL Emulation Notes:

PS Emulation

® PS Emulation is the factory default setting. PS Emulation uses
a PS interpreter for processing print jobs.

® PCL Emulation uses a PCL interpreter for processing print
jobs.

® Setting a printer language as the default does not prevent a
software program from sending print jobs that use another
printer language.

Print Area Set the logical and physical printable area.

Normal Notes:

Fit To Page ) ' _

Whole Page o Ngrmal is t.he factory default setting. W.hen attempting to
print data in the non-printable area defined by the Normal
setting, the printer clips the image.

® Fit to Page fits the page content into the selected paper size.

® Whole Page allows the image to be moved into the
non-printable area defined by the Normal setting, but the
printer clips the image at the Normal setting boundary. This
setting affects only pages printed using a PCL 5e interpreter
and has no effect on pages printed using the PCL XL or
PostScript interpreter.

Printer Usage Set color toner use in printing.

Max Yield Note: Max Yield is the factory default setting.

Max Speed

Black Only Mode Set the printer to print text and graphics using only the black toner
On cartridge.
off Notes:

® Off is the factory default setting.
® The setting value does not affect the ability of the printer to
generate color output from flash drive print jobs.

Resource Save Specify how the printer handles temporary downloads, such as
On fonts and macros stored in the RAM, when the printer receives a
Off job that requires more than the available memory.

Notes:

® Off is the factory default setting. Off sets the printer to retain
the downloads only until memory is needed. Downloads are
deleted in order to process print jobs.

® On sets the printer to retain downloads during language
changes and printer resets. If the printer runs out of
memory, then Memory full [38] appears, but
downloads are not deleted.
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Flash Drive menu

Use

Copies
1-999

To

Specify a default number of copies for each print job.

Note: 1 is the factory default setting.

Paper Source
Tray [x]
MP Feeder
Manual Paper
Manual Envelope

Set a default paper source for all print jobs.

Note: Tray 1 is the factory default setting.

Color Generate color or black-and-white outputs.
Color Notes:
Black Only
® Color is the factory default setting.
® This setting can generate color output only from a flash drive print job.
Collate Stack the pages of a print job in sequence when printing multiple copies.
1,1,1-2,2,2 Note: 1,2,3-1,2,3 is the factory default setting.
1,2,3-1,2,3
Sides (Duplex) Specify whether prints are on one side or on both sides of the paper.
1sided Note: “1 sided” is the factory default setting.
2 sided
Duplex Binding Define binding for duplexed pages in relation to paper orientation.
Long Edge Notes:
Short Edge

® long Edge is the factory default setting. Long Edge assumes binding along the
long edge of the page (left edge for portrait and top edge for landscape).

® Short Edge assumes binding along the short edge of the page (top edge for
portrait and left edge for landscape).

Paper Saver Orientation
Auto
Landscape
Portrait

Specify the orientation of a multiple-page document.

Notes:
® Auto is the factory default setting. The printer chooses between portrait and
landscape.

® This setting affects jobs only when Paper Saver is set to any value other than
Off.

Paper Saver
Off
2-Up
3-Up
4-Up
6-Up
9-Up
12-Up
16-Up

Print multiple-page images on one side of the paper.

Notes:

® Off is the factory default setting.

® The number selected is the number of page images that will print per side.
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Use

Paper Saver Border
None
Solid

To
Print a border on each page image when using Paper Saver Border.
Notes:

® None is the factory default setting.

® This setting affects jobs only when Paper Saver is set to any value other than
Off.

Paper Saver Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specify the positioning of multiple-page images when using Paper Saver Ordering.
Notes:

® Horizontal is the factory default setting.

® Positioning depends on the number of page images and whether they are in
portrait or landscape orientation.

® This setting affects jobs only when Paper Saver is set to any value other than
Off.

Separator Sheets
Off
Between Copies
Between Jobs
Between Pages

Specify whether blank separator sheets are inserted.

Notes:

® Off is the factory default setting.

® Between Copies inserts a blank sheet between each copy of a print job when
Collate is set to On. When Collate is set to Off, then a blank page is inserted
between each set of printed pages, such as after all page 1's and after all page
2's.

® Between Jobs inserts a blank sheet between print jobs.

® Between Pages inserts a blank sheet between each page of the print job. This
setting is useful when printing transparencies or inserting blank pages in a
document for notes.

Separator Sheet Source
Tray [x]
Manual Feeder

Specify the paper source for separator sheets.

Note: Tray 1 is the factory default setting.

Blank Pages
Do Not Print
Print

Specify whether blank pages are inserted in a print job.

Note: Do Not Print is the factory default setting.
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Finishing menu

Use

Sides (Duplex)
1 sided
2 sided

To

Specify whether two-sided (duplex) printing is set as the default setting for all print
jobs.

Notes:

® “1sided” is the factory default setting.
® You can set two-sided printing from the software program.
For Windows users:

Click File > Print, and then click Properties, Preferences, Options, or Setup.
For Macintosh users:

Choose File > Print, and then adjust the settings from the Print dialog and pop-up
menus.

Duplex Binding
Long Edge

Define binding for duplexed pages in relation to paper orientation.

Notes:
Short Edge
® Long Edge is the factory default setting. This assumes binding along the long
edge of the page (left edge for portrait and top edge for landscape).
® Short Edge assumes binding along the short edge of the page (top edge for
portrait and left edge for landscape).
Copies Specify the default number of copies for each print job.
1-999 Note: 1 is the factory default setting.
Blank Pages Specify whether blank pages are inserted in a print job.
Do Not Print Note: Do Not Print is the factory default setting.
Print
Collate Stack the pages of a print job in sequence when printing multiple copies.

(1,1,1) (2,2,2)
(1,2,3)(1,2,3)

Note: “(1,1,1) (2,2,2)" is the factory default setting.

Separator Sheets
Off
Between Copies
Between Jobs
Between Pages

Specify whether blank separator sheets are inserted.

Notes:

® Off is the factory default setting.

® Between Copies inserts a blank sheet between each copy of a print job when
Collate is set to On. When Collate is set to Off, then a blank page is inserted
between each set of printed pages, such as after all page 1's and after all page
2's.

® Between Jobs inserts a blank sheet between print jobs.

® Between Pages inserts a blank sheet between each page of the print job. This
setting is useful when printing transparencies or when inserting blank pages in
a document.

Separator Source
Tray [x]
Manual Feeder

Specify the paper source for separator sheets.

Note: Tray 1 (standard tray) is the factory default setting.
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Use To
Paper Saver Specify that multiple-page images be printed on one side of a paper.
Off Notes:
2-Up
3-Up ® Off is the factory default setting.
4-Up ® The number selected is the number of page images that will print per side.
6-Up
9-Up
12-Up
16-Up
Paper Saver Ordering Specify the positioning of multiple-page images.
Horizontal Notes:

Reverse Horizontal

Reverse Vertical ® Horizontal is the factory default setting.

Vertical ® Positioning depends on the number of images and whether they are in portrait
or in landscape orientation.

® This setting affects jobs only when Paper Saver is set to any value other than

Off.
Paper Saver Orientation Specify the orientation of a multiple-page document.
Auto Notes:
Landscape
Portrait ® Auto is the factory default setting.
® This setting affects jobs only when Paper Saver is set to any value other than
Off.
Paper Saver Border Print a border around each page.
None Notes:
Solid

® None is the factory default setting.

® This setting affects jobs only when Paper Saver is set to any value other than
Off.

Quality menu

Print Mode Specify whether images are printed in black and white or in color.
Color Notes:
Black Only

® Color is the factory default setting.

® The printer driver is capable of overriding this setting.
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Use

Color Correction
Auto
Off
Manual

To
Adjust the color output on the printed page.
Notes:
® Auto is the factory default setting. This applies different color conversion tables
to each object on the printed page.
® Off turns off color correction.

® Manual allows customization of the color tables using the settings available from
the Manual Color menu.

® Due to the differences in additive and subtractive colors, certain colors that
appear on computer monitors are impossible to duplicate on the printed page.

Print Resolution
1200 dpi
4800 CQ

Specify the printed output resolution in dots per inch or in color quality (CQ).
Note: 4800 CQ is the factory default setting.

Toner Darkness
1-5

Lighten or darken the printed output.

Notes:

® 4isthe factory default setting.

® Selecting a smaller number can help conserve toner.

Enhance Fine Lines

Enable a print mode preferable for files such as architectural drawings, maps, electrical

On circuit diagrams, and flow charts.
Off Notes:
® Off is the factory default setting.
® To set this option using the Embedded Web Server, type the network printer IP
address in the Web browser address field.
® You can set this option from the software program.
For Windows users:
Click File > Print, and then click Properties, Preferences, Options, or Setup.
For Macintosh users:
Choose File > Print, and then adjust the settings from the Print dialog and pop-up
menus.
Color Saver Reduce the amount of toner used for graphics and images. The amount of toner used
On for text is not reduced.
off Notes:

® Off is the factory default setting.
® On overrides Toner Darkness settings.

RGB Brightness

Adjust the printed output either by lightening or darkening it. You can conserve toner

6t06 by lightening the output.
Note: O is the factory default setting.
RGB Contrast Adjust the contrast of printed objects.
0-5 Note: O is the factory default setting.
RGB Saturation Adjust saturation in color outputs.
0-5

Note: 0 is the factory default setting.
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Color Balance

Cyan

-5to5
Magenta

-5to5
Yellow

-5to5
Black

-5to5
Reset Defaults

To

Adjust color in printed output by increasing or decreasing the amount of toner being
used for each color.

Note: 0 is the factory default setting.

Color Samples
sRGB Display
sRGB Vivid
Display—True Black
Vivid
Off —RGB
US CMYK
Euro CMYK
Vivid CMYK
Off —CMYK

Print sample pages for each of the RGB and CMYK color conversion tables used in the
printer.

Notes:

® Selecting any setting prints the sample.

® Color samples consist of a series of colored boxes along with the RGB or CMYK
combination that creates the color observed. These pages can be used to help
decide which combinations to use to get the printed output you want.

® To access a complete list of color sample pages using the Embedded Web Server,
type the network printer IP address in the Web browser address field.

Manual Color
RGB Image
RGB Text
RGB Graphics

Customize the RGB color conversions.
Select from the following options:
Vivid
sRGB Display
Display—True Black
sRGB Vivid
Off

Notes:

® sRGB Display is the factory default setting for RGB Image. This applies a color
conversion table to an output that matches the colors displayed on a computer
monitor.

® sRGB Vivid is the factory default setting for RGB Text and RGB Graphics. This
applies a color table that increases saturation. This is preferred for business
graphics and text.

® Vivid applies a color conversion table that produces brighter, more saturated
colors.

® “Display—True Black” applies a color conversion table that uses only black toner
for neutral gray colors.

® Off turns off color conversion.
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Manual Color (continued)
CMYK Image
CMYK Text
CMYK Graphics

To

Customize the CMYK color conversions.
Select from the following options:

US CMYK

Euro CMYK

Vivid CMYK

Off

Notes:
® US CMYK is the factory default setting. This applies a color conversion table that
tries to produce output that matches SWOP color output.

® Euro CMYK is the international factory default setting. This applies a color
conversion table that tries to produce output that matches Euroscale color
output.

® Vivid CMYK increases color saturation for the US conversion table.
® Off turns off color conversion.

Spot Color Replacement

Assign specific CMYK values to named spot colors.

Note: This menu is available only in the Embedded Web Server.

Color Adjust

Initiate a recalibration of color conversion tables and allow the printer to make
adjustments for color variations in output.

Notes:
® Adjusting color starts when the menu is selected. Adjusting color appears
on the display until the process is finished.

® Color variations in output sometimes result from changeable conditions such as
room temperature and humidity. Color adjustments are made on printer

algorithms. Color alignment is also recalibrated in this process.

Utilities menu

Use

Remove Held Jobs
Confidential
Held
Not Restored
All

To

Delete confidential and held jobs from the printer hard disk.
Notes:
® Selecting a setting affects only print jobs that are resident in the printer.

Bookmarks, print jobs on flash drives, and other types of held jobs are not
affected.

® Not Restored removes all Print and Hold jobs that are not restored from the
printer hard disk or memory.
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Use To
Format Flash Format the flash memory.
Yes Warning—Potential Damage: Do not turn off the printer while the flash memory is
No being formatted.
Notes:

® Yes deletes all data stored in flash memory.
® No cancels the format request.

® Flash memory refers to the memory added by installing a flash memory card in
the printer.

® The flash memory option card must not be read/write- or write-protected.

® This menu item appears only when a non-defective flash memory card is

installed.
Delete Downloads on Disk Delete downloads from the printer hard disk, including all held jobs, buffered jobs,
Delete Now and parked jobs.
Do Not Delete Notes:

® Delete Now sets the printer to delete the downloads and allows the display to
return to the originating screen after the deletion.

® Do Not Delete sets the printer display to return to the main Utilities menu for
touch-screen printer models. When selected in non-touch-screen printer
models, Do Not Delete sets the printer to return to the originating screen after
the deletion.

Activate Hex Trace Assist in isolating the source of a print job problem.

Notes:

® When activated, all data sent to the printer is printed in hexadecimal and
character representation, and control codes are not executed.

® To exit or deactivate Hex Trace, turn off or reset the printer.

Coverage Estimator Provide an estimate of the percentage coverage of toner on a page. The estimate is
Off printed on a separate page at the end of each print job.
On Note: Off is the factory default setting.
XPS menu

Print Error Pages Print a page containing information on errors, including XML markup errors.

Off Note: Off is the factory default setting.
On
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PDF menu

Use To

Scale to Fit Scale page content to fit the selected paper size.
Yes Note: No is the factory default setting.
No

Annotations Print annotations in a PDF.
Do Not Print Note: Do Not Print is the factory default setting.
Print

PostScript menu

Use To
Print PS Error Print a page containing the PostScript error.
On Note: Off is the factory default setting.
Off
Lock PS Startup Mode Enable users to disable the SysStart file.
On Note: Off is the factory default setting.
Off
Font Priority Establish the font search order.
Resident Notes:
Flash/Disk

® Resident is the factory default setting.

® This menu item appears only when a formatted, non-defective flash
memory option card or printer hard disk is installed.

® Make sure the flash memory option or printer hard disk is not
read/write-, write-, or password-protected.

® Job Buffer Size must not be set to 100%.

Image Smoothing Enhance the contrast and sharpness of low-resolution images and smoothen
On their color transitions.
Off Notes:

® Off is the factory default setting.

® Image Smoothing has no effect on images that are 300 dpi or higher in
resolution.

,
N
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PCL Emul menu

Use

Font Source
Resident

To

Specify the set of fonts used in the Font Name menu.

Notes:
Download
All ® “Resident” is the factory default setting. It shows the factory default set
of fonts downloaded in the RAM.
® “Download” shows all the fonts downloaded in the RAM.
® “All” shows all fonts available to any option.
Font Name Identify a specific font and where it is stored.
Courier 10 Note: Courier 10 is the factory default setting.
Symbol Set Specify the symbol set for each font name.
10U PC-8 Notes:
12U PC-850

® 10U PC-8 s the US factory default setting. 12U PC-850 is the international
factory default setting.

® Asymbol set is a set of alphabetical and numeric characters, punctuation,
and special symbols. Symbol sets support the different languages or
specific programs, such as math symbols for scientific text. Only the
supported symbol sets are shown.

PCL Emulation Settings
Point Size
1.00-1008.00

Change the point size for scalable typographic fonts.
Notes:

® 12 isthe factory default setting.

® Point size refers to the height of the characters in the font. One point
equals approximately 0.014 of an inch. This can be increased or decreased
in 0.25-point increments.

PCL Emulation Settings
Pitch
0.08-100.00

Specify the font pitch for scalable monospaced fonts.
Notes:

® 10 is the factory default setting.

® Pitch refers to the number of fixed-space characters per inch (cpi). This
can be increased or decreased in 0.01-cpi increments.

® For non-scalable monospaced fonts, the pitch appears on the display but
cannot be changed.

PCL Emulation Settings
Orientation
Portrait
Landscape

Specify the orientation of text and graphics on a page.
Notes:

® Portrait is the factory default setting. It prints text and graphics parallel to
the short edge of the page.

® Landscape prints text and graphics parallel to the long edge of the page.
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Use

PCL Emulation Settings
Lines per Page
1-255

To
Specify the number of lines that print on each page.
Notes:

® 60 is the US factory default setting. 64 is the international default setting.

® The printer sets the amount of space between each line based on the
Lines per Page, Paper Size, and Orientation settings. Select the paper size
and orientation before setting Lines per Page.

PCL Emulation Settings
A4 Width
198 mm
203 mm

Set the printer to print on A4-size paper.
Notes:

® 198 mm is the factory default setting.

® The 203-mm setting sets the width of the page to allow the printing of
eighty 10-pitch characters.

PCL Emulation Settings
Auto CR after LF
On
Off

Specify whether the printer automatically performs a carriage return (CR) after
a line feed (LF) control command.

Note: Off is the factory default setting.

PCL Emulation Settings
Auto LF after CR
On
Off

Specify whether the printer automatically performs a line feed (LF) after a
carriage return (CR) control command.

Note: Off is the factory default setting.

Tray Renumber

Assign MP Feeder
Off
None
0-199

Assign Tray [x]
Off
None
0-199

Assign Manual Paper
Off
None
0-199

Assign Manual Envelope
Off
None
0-199

Configure the printer to work with printer software or programs that use
different source assignments for trays and feeders.

Notes:

® “Off” is the factory default setting.

® “None” ignores the Select Paper Feed command. This option appears only
when it is selected by the PCL 5e interpreter.

® “0-199” allows a custom setting to be assigned.
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Use To

Tray Renumber Show the factory default setting assigned to each tray or feeder.
View Factory Defaults
MPF Default = 8
T1 Default =1
T2 Default =4
T3 Default =5
T4 Default = 20
T5 Default =21
Env Default =6
MPaper Default = 2
MEnv Default = 3

Tray Renumber Restore all tray and feeder assignments to the factory default settings.

Restore Defaults

Yes
No
HTML menu
Use To
Font Name Joanna MT Set the default font for HTML documents.
Albertus MT Letter Gothic Note: The Times font is used in HTML documents that do not
Antique Olive Lubalin Graph specify a font.
Apple Chancery Marigold
Arial MT Monalisa Recut
Avant Garde Monaco
Bodoni New CenturySbk
Bookman New York
Chicago Optima
Clarendon Oxford
Cooper Black Palatino
Copperplate StempelGaramond
Coronet Taffy
Courier Times
Eurostile TimesNewRoman
Garamond Univers
Geneva Zapf Chancery
Gill Sans NewSansMTCS
Goudy NewSansMTCT
Helvetica New SansMTJA
Hoefler Text NewSansMTKO
Intl CG Times
Intl Courier
Intl Univers )
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Use To
Font Size Set the default font size for HTML documents.
1-255 pt Notes:
® 12 ptis the factory default setting.
® Font size can be increased in 1-point increments.
Scale Scale the default font for HTML documents.
1-400% Notes:
® 100% is the factory default setting.
® Scaling can be increased in 1% increments.
Orientation Set the page orientation for HTML documents.
Portrait Note: Portrait is the factory default setting.
Landscape
Margin Size Set the page margin for HTML documents.
8-255 mm Notes:
® 19 mmi is the factory default setting.
® Margin size can be increased in 1-mm increments.
Backgrounds Specify whether to print backgrounds on HTML documents.
Do Not Print Note: Print is the factory default setting.
Print

Image menu

Use To
Auto Fit Select the optimal paper size, scaling, and orientation.
On Note: On is the factory default setting. It overrides scaling and orientation settings
Off for some images.
Invert Invert bitonal monochrome images.
On Notes:
Off
® Off is the factory default setting.
® This setting does not apply to GIF or JPEG images.
Scaling Scale the image to fit the selected paper size.
Anchor Top Left Notes:
Best Fit

Anchor Center
Fit Height/Width
Fit Height

Fit Width

® Best Fit is the factory default setting.
® When Auto Fit is set to On, Scaling is automatically set to Best Fit.
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Use To

Orientation Set the image orientation.
Portrait Note: Portrait is the factory default setting.
Landscape

Reverse Portrait
Reverse Landscape
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Saving money and the environment

Lexmark is committed to environmental sustainability and is continually improving its printers to reduce their impact
onthe environment. We design with the environment in mind, engineer our packaging to reduce materials, and provide
collection and recycling programs. For more information, see:

® The Notices chapter

® The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment

® The Lexmark recycling program at www.lexmark.com/recycle

By selecting certain printer settings or tasks, you may be able to reduce your printer's impact even further. This chapter
outlines the settings and tasks that may yield a greater environmental benefit.

Saving paper and toner

Studies show that as much as 80% of the carbon footprint of a printer is related to paper usage. You can significantly
reduce your carbon footprint by using recycled paper and the following printing suggestions, such as printing on both
sides of the paper and printing multiple pages on one side of a single sheet of paper.

To quickly save paper and energy, select a setting for the Eco-Mode in the General Settings menu.

Using recycled paper

As an environmentally conscious company, Lexmark supports the use of recycled office paper produced specifically for
use in laser printers. For more information on recycled papers that work well with your printer, see “Using recycled
paper and other office papers” on page 52.

Conserving supplies

Use both sides of the paper

If your printer model supports duplex printing, then you can control whether print appears on one or two sides of the
paper by selecting 2-sided printing from the Print dialog or from the Lexmark Toolbar.

Place multiple pages on one sheet of paper

You can print up to 16 consecutive pages of a multiple-page document onto one side of a single sheet of paper by
selecting a setting from the Multipage printing (N-Up) section of the Print dialog screen.

Check your first draft for accuracy

Before printing or making multiple copies of a document:

® Use the preview feature, which you can select from the Print dialog or from the Lexmark Toolbar to see how the
document will look like before you print it.

® Print one copy of the document to check its content and format for accuracy.

Avoid paper jams

Correctly set the paper type and size to avoid paper jams. For more information, see “Avoiding jams” on page 142.


http://www.lexmark.com/environment
http://www.lexmark.com/recycle
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Saving energy

Using Eco-Mode

Use Eco-Mode to quickly select one or more ways to reduce your printer's environmental impact.

1 From the printer control panel, navigate to:

> Settings > > Settings > > General Settings > > Eco-Mode > n > select the setting you want

Use To

Off Use the factory default settings for all settings associated with Eco-Mode. This setting supports the
performance specifications for your printer.

Energy Reduce energy use, especially when the printer is idle.
Notes:

® Printer engine motors do not start until a job is ready to print. You may notice a short delay
before the first page is printed.

® The printer enters Sleep mode after one minute of inactivity.

Energy/Paper | Use all the settings associated with Energy and Paper modes.

Plain Paper ® Enable automatic two-sided (duplex) printing.

2 Press .

Reducing printer noise

® Turn off print log features.

Use Quiet mode to reduce the printer noise.

1 From the printer control panel, navigate to:

> Settings > > Settings > General Settings > > Quiet Mode > > select a setting you want

| Use To

On Reduce printer noise.
Notes:

® Print jobs process at a reduced speed.

® Printer engine motors do not start until a document
is ready to print. There is a short delay before the
first page is printed.

® The alarm control and cartridge alarm sounds are
turned off.

® The printer will ignore the Advance Start command.

Off Use factory default settings.

Note: This setting supports the performance
specifications of the printer.




Saving money and the environment 108

2 Press n

Adjusting Sleep mode

To save energy, decrease the number of minutes before the printer enters Sleep mode. Select from 1to 120. The factory
default setting is 30 minutes.

Note: The printer still accepts print jobs when in Sleep mode.

Using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Navigate to:

Settings > General Settings > Timeouts
3 In the Sleep Mode field, enter the number of minutes you want the printer to wait before it enters Sleep mode.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

> Settings > n > Settings > n > General Settings > n > Timeouts > n > Sleep Mode > n

2 In the Sleep Mode field, select the number of minutes you want the printer to wait before it enters Sleep mode.

3 Press m

Using Schedule Power Modes
Schedule Power Modes lets you schedule when the printer goes into a reduced power state or into the Ready state.

Note: This feature is available only in network printers or printers connected to print servers.

Using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > General Settings > Schedule Power Modes.

3 From the Action menu, select the power mode.
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4 From the Time menu, select the time.
5 From the Day(s) menu, select the day or days.

6 Click Add.

Using Hibernate mode

Hibernate is an ultra-low-power operating mode. When operating in Hibernate mode, all other systems and devices
are powered down safely.

Notes:

® Make sure to wake the printer from Hibernate mode before sending a print job. A hard reset or a long press of
the Sleep button wakes the printer from Hibernate mode.

® The Hibernate mode can be scheduled. For more information, see “Using Schedule Power Modes” on page 108.

® |f the printer is in Hibernate mode, the Embedded Web Server is disabled.

Using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

® |f your are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > General Settings > Sleep Button Settings.
3 From the “Press Sleep Button” or “Press and Hold Sleep Button” drop-down menu, select Hibernate.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

> Settings > m > Settings > m > General Settings > m

2 Press the arrow buttons until Press Sleep Buttonor Press and Hold Sleep Button appears, and
then press n

3 Press the arrow buttons until Hibernate appears, and then press n

Notes:

® When Press Sleep Button is set to Hibernate, a short press of the Sleep button sets the printer to Hibernate
mode.

® When Press and Hold Sleep Button is set to Hibernate, a long press of the Sleep button sets the printer to
Hibernate mode.
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Setting Hibernate Timeout

Hibernate Timeout lets you set the amount of time the printer waits after a print job is processed before it goes into a
reduced power state.

Using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > General Settings > Timeouts.

3 From the Hibernate Timeout menu, select the number of hours, days, weeks, or months you want for the printer
to wait before it goes into a reduced power state.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

> Settings > m > Settings > m > General Settings > m > Timeouts > n > Hibernate Timeout > n

2 Select the amount of time the printer waits after a print job is processed before it enters Hibernate mode.

3 Press n

Adjusting the brightness of the printer display

To save energy, or to make the display easier to read, adjust its brightness settings.

Using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > General Settings.
3 In the Screen Brightness field, enter the percentage of the brightness you want for the display.
4 Click Submit.

Using the printer control panel
From the printer control panel, navigate to:

> Settings > m > General Settings > n > Screen Brightness > m
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Recycling

Lexmark provides collection programs and environmentally progressive approaches to recycling. For more information,
see:

® The Notices chapter

® The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment

® The Lexmark recycling program at www.lexmark.com/recycle

Recycling Lexmark products
To return Lexmark products for recycling:

1 Go to www.lexmark.com/recycle.

2 Find the product type you want to recycle, and then select your country or region from the list.
3 Follow the instructions on the computer screen.

Note: Printer supplies and hardware not listed in the Lexmark collection program may be recycled through your local
recycling center. Contact your local recycling center to determine the items they accept.

Recycling Lexmark packaging

Lexmark continually strives to minimize packaging. Less packaging helps to ensure that Lexmark printers are transported
in the most efficient and environmentally sensitive manner and that there is less packaging to dispose of. These
efficiencies result in fewer greenhouse emissions, energy savings, and natural resource savings.

Lexmark cartons are 100% recyclable where corrugated recycling facilities exist. Facilities may not exist in your area.

The foam used in Lexmark packaging is recyclable where foam recycling facilities exist. Facilities may not exist in your
area.

When you return a cartridge to Lexmark, you can reuse the box that the cartridge came in. Lexmark will recycle the
box.

Returning Lexmark cartridges for reuse or recycling

Lexmark Cartridge Collection Program diverts millions of Lexmark cartridges from landfills annually by making it both
easy and free for Lexmark customers to return used cartridges to Lexmark for reuse or recycling. One hundred percent
of the empty cartridges returned to Lexmark are either reused or demanufactured for recycling. Boxes used to return
the cartridges are also recycled.

To return Lexmark cartridges for reuse or recycling, follow the instructions that came with your printer or cartridge and
use the prepaid shipping label. You can also do the following:

1 Go to www.lexmark.com/recycle.

2 From the Toner Cartridges section, select your country or region.

3 Follow the instructions on the computer screen.
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Securing the printer

Using the security lock feature

The printer is equipped with a security lock feature. Attach a security lock compatible with most laptop computers in
the location shown to secure the printer in place.

Statement of Volatility

Your printer contains various types of memory that can store device and network settings, and user data.

| Type of memory Description

Volatile memory Your printer uses standard random access memory (RAM) to
temporarily buffer user data during simple print jobs.

Non-volatile memory Your printer may use two forms of non-volatile memory:
EEPROM and NAND (flash memory). Both types are used to
store operating system, device settings, and network
information.

Erase the content of any installed printer memory in the following circumstances:
® The printer is being decommissioned.
® The printer is being moved to a different department or location.
® The printer is being serviced by someone from outside your organization.
® The printer is being removed from your premises for service.

® The printer is being sold to another organization.
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Erasing volatile memory

The volatile memory (RAM) installed in your printer requires a power source to retain information. To erase the buffered
data, turn off the printer.

Erasing non-volatile memory

Erase individual settings, device and network settings, security settings, and embedded solutions by following these
steps:

1 Turn off the printer.

2 Hold down 2 and 6 on the keypad while turning the printer on. Release the buttons only when the screen with the
progress bar appears.

The printer performs a power-on sequence, and then the Configuration menu appears. When the printer is fully
turned on, a list of functions appears on the printer display.

3 Press the up or down arrow button until Wipe All Settings appears.

The printer will restart several times during this process.

Note: Wipe All Settings securely removes device settings, solutions, jobs, and passwords from the printer
memory.

4 Navigate to:
Back > Exit Config Menu

The printer will perform a power-on reset, and then return to normal operating mode.

Finding printer security information

In high-security environments, it may be necessary to take additional steps to make sure that confidential data stored
in the printer cannot be accessed by unauthorized persons. For more information, visit the
Lexmark security Web page.

You can also see the Embedded Web Server Administrator’s Guide for additional information:

1 Go to http://support.lexmark.com.

2 In the Search field, type the model name of your printer, and then click Go.

3 Click the Manuals tab, and then select the Embedded Web Server Administrator’s Guide.
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Maintaining the printer

Warning—Potential Damage: Failure to maintain optimum printer performance periodically, or to replace parts and
supplies, may cause damage to your printer.

Cleaning the printer parts

Cleaning the printer
Note: You may need to perform this task after every few months.

Warning—Potential Damage: Damage to the printer caused by improper handling is not covered by the printer
warranty.

1 Make sure that the printer is turned off and unplugged from the electrical outlet.

A CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the printer,
unplug the power cord from the electrical outlet and disconnect all cables from the printer before
proceeding.

2 Remove paper from the standard bin, multipurpose feeder, and manual feeder.
3 Remove any dust, lint, and pieces of paper around the printer using a soft brush or vacuum.
4 Dampen a clean, lint-free cloth with water, and use it to wipe the outside of the printer.

Warning—Potential Damage: Do not use household cleaners or detergents, as they may damage the finish of
the printer.

5 Make sure all areas of the printer are dry before sending a new print job.

Checking the status of parts and supplies

A message appears on the display when a replacement supply item is needed or when maintenance is required. For
more information, see “Supplies menu” on page 65.

Checking the status of parts and supplies on the printer control panel

From the printer control panel, navigate to:

> Status/Supplies > n View Supplies > n

Checking the status of parts and supplies from the Embedded Web Server

Note: Make sure the computer and the printer are connected to the same network.

1 Open a Web browser, and then type the printer IP address in the address field.
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Notes:

® View the printer IP address on the home screen. The IP address appears as four sets of numbers separated
by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Device Status > More Details.

Estimated number of remaining pages

The estimated number of remaining pages is based on the recent printing history of the printer. Its accuracy may
vary significantly and is dependent on many factors, such as actual document content, print quality settings, and
other printer settings.

The accuracy of the estimated number of remaining pages may decrease when the actual printing consumption is
different from the historical printing consumption. Consider the variable level of accuracy before purchasing or replacing
supplies based on the estimate. Until an adequate print history is obtained on the printer, initial estimates assume
future supplies consumption based on the International Organization for Standardization* test methods and page
content.

* Average continuous black or composite CMY declared cartridge yield in accordance with ISO/IEC 19798.

Ordering supplies

To order supplies in the U.S., contact Lexmark at 1-800-539-6275 for information about Lexmark authorized supplies
dealers in your area. In other countries or regions, visit the Lexmark Web site at www.lexmark.com or contact the
place where you purchased the printer.

Note: All life estimates for printer supplies assume printing on letter- or A4-size plain paper.

Using genuine Lexmark parts and supplies

Your Lexmark printer is designed to function best with genuine Lexmark supplies and parts. Use of third-party supplies
or parts may affect the performance, reliability, or life of the printer and its imaging components. Use of third-party
supplies or parts can affect warranty coverage. Damage caused by the use of third-party supplies or parts is not covered
by the warranty. All life indicators are designed to function with Lexmark supplies and parts, and may deliver
unpredictable results if third-party supplies or parts are used. Imaging component usage beyond the intended life may
damage your Lexmark printer or its associated components.

Ordering toner cartridges

Notes:

® Estimated cartridge yield is based on the ISO/IEC 19798 standard.

® Extremely low print coverage for extended periods of time may negatively affect actual yield.
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Return program cartridges

United States and Canada

Return program toner cartridges

European Union (EU),
European Economic Area
(EEA), and Switzerland

Africa, Middle East, Central
Eastern Europe (Non-EU),
Commonwealth of
Independent States (CIS),
Asia Pacific, and Latin
America

Black 701K 702K 708K
Cyan 701C 702C 708C
Magenta 701M 702M 708M
Yellow 701Y 702Y 708Y
High yield return program toner cartridges

Black 701HK 702HK 708HK
Cyan 701HC 702HC 708HC
Magenta 701HM 702HM 708HM
Yellow 701HY 702HY 708HY

For more information on countries located in each region, visit www.lexmark.com/regions.

Regular cartridges

Item Worldwide

High yield regular toner cartridges

Black 700H1
Cyan 700H2
Magenta 700H3
Yellow 700H4

For more information on countries located in each region, visit www.lexmark.com/regions.

Ordering imaging kits

All countries and regions

Black imaging kit 70071

l Color imaging kit 70025

Ordering a waste toner bottle

Item All countries and regions

C540X75G

Waste toner bottle
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Storing supplies

Choose a cool, clean storage area for the printer supplies. Store supplies right side up in their original packing until you
are ready to use them.

Do not expose supplies to:
® Direct sunlight
® Temperatures above 35°C (95°F)
® High humidity above 80%
® Salty air
® Corrosive gases

® Heavy dust
Replacing supplies

Replacing the waste toner bottle

Top door

Waste toner bottle

Right side cover

AW IN =

Front door
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1 Unpack the replacement waste toner bottle.

2 Open the front door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

4 Remove the right side cover.
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5 Press the green levers on each side of the waste toner bottle, and then remove the waste toner bottle.

6 Seal the used waste toner bottle in the enclosed packaging.

For more information, see “Recycling Lexmark products” on page 111.

7 Insert the replacement waste toner bottle.
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8 Insert the right side cover.

9 Close the top door.

10 Close the front door.
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Replacing a black and color imaging kit

1 Open the front door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
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3 Remove the toner cartridges by lifting the handles, and then gently pulling them away from the imaging kit.

4 Remove the right side cover.
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5 Press the green levers on each side of the waste toner bottle, and then remove the waste toner bottle.
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8 Unpack the replacement black and color imaging kit.

e

® Color imaging kit includes the imaging kit and the cyan, magenta, yellow, and black developer units.

Notes:

® Black imaging kit includes the imaging kit and the black developer unit.

9 Seal the used imaging kit in the bag that the replacement imaging kit came.

For more information, see “Recycling Lexmark products” on page 111.

Note: When replacing the black imaging kit, save the cyan, magenta, and yellow developer units . Dispose only
the black developer unit.

10 Gently shake the yellow, cyan, magenta, and black developer units side-to-side.

=\
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11 Remove the red packing strip and the attached fabric from the developer units.

7y

’

Note: Make sure each developer unit is inserted into a matching color slot.

13 Remove the red packing strip from the imaging kit.

s

{

Warning—Potential Damage: Do not touch the shiny photoconductor drum under the imaging kit. Doing so may
affect the quality of future print jobs.
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14 Align, and then insert the imaging kit.

Note: Make sure that the imaging kit is fully seated.
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16 Insert the waste toner bottle.

17 Insert the right side cover.
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18 Insert the toner cartridges.

19 Close the top door.

20 Close the front door.
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Replacing toner cartridges

Warning—Potential Damage: Damage caused by use of a non-Lexmark toner cartridge is not covered under
warranty.

Note: Reduced print quality may result from using non-Lexmark toner cartridges.

1 Slide the release latch on the right side of the printer, and then open the top door.
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3 Unpack the new toner cartridge, and then remove its packaging.

>4

4 Align the new toner cartridge, and then press the cartridge down until it fits into place.

5 Close the top door.

6 Seal the used toner cartridge in the bag that the replacement toner cartridge came in before disposing.

For more information, see “Recycling Lexmark products” on page 111.
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Replacing a developer unit
Replace the developer unit when a print quality defect occurs or when damage occurs to the printer.

1 Open the front door.

& CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
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3 Lift the toner cartridge handle, and then gently pull it from the imaging kit.

4 Remove the right side cover.
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5 Press the green levers on each side of the waste toner bottle, and then remove the waste toner bottle.

7 Press down the blue lever, and then grasp the green handles on the sides to pull out the imaging kit.

Warning—Potential Damage: Do not touch the underside of the imaging kit. This could damage the imaging kit.
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8 Remove the used developer unit.

9 Gently shake the replacement developer unit side-to-side before removing it from its packaging.

=\
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10 Remove the red shipping cover from the developer unit.

11 Insert the developer unit.
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12 Align, and then insert the imaging kit.

Note: Make sure that the imaging kit is fully seated.
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14 Replace the waste toner bottle.

15 Insert the right side cover.
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16 Insert the toner cartridges.

17 Close the top door.

18 Close the front door.

19 Seal the used developer unit in the bag that the replacement developer unit came in before disposing.

For more information, see “Recycling Lexmark products” on page 111.
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Moving the printer

Before moving the printer

A CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 Ib) and requires two or more
trained personnel to lift it safely.

CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:
® Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet.
® Disconnect all cords and cables from the printer before moving it.
® Lift the printer off the optional tray, and then set it aside instead of trying to lift the tray and printer at the same
time.

Note: Use the handholds located on both sides of the printer to lift it.

Warning—Potential Damage: Damage to the printer caused by improper moving is not covered by the printer
warranty.

Moving the printer to another location

The printer and its hardware options can be safely moved to another location by following these precautions:
® Any cart used to move the printer must have a surface able to support the full footprint of the printer.

® Any cart used to move the hardware options must have a surface able to support the dimensions of the hardware
options.

Keep the printer in an upright position.

® Avoid severe jarring movements.

Shipping the printer

When shipping the printer, use the original packaging.
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Managing the printer

Finding advanced networking and administrator information

This chapter covers basic administrative support tasks using the Embedded Web Server. For more advanced system
support tasks, see the Networking Guide on the Software and Documentation CD or the Embedded Web Server

Administrator's Guide on the Lexmark Web site at http://support.lexmark.com.

Checking the virtual display

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:
® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.
® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Check the virtual display that appears at the top left corner of the screen.

The virtual display works as an actual display would work on a printer control panel.

Checking the printer status

You can view paper tray settings, the level of toner in the toner cartridges, the percentage of life remaining in the
maintenance kit, and capacity measurements of certain printer parts from the Device Status page of the Embedded

Web Server.
1 Type the printer IP address in the address field of your Web browser.

Note: If you do not know the IP address of the printer, then you can:
® View the IP address on the printer control panel in the TCP/IP section under the Networks/Ports menu.

® Print a network setup page or the menu settings pages and locate the IP address in the TCP/IP section.

2 Click Device Status.

Viewing reports
You can view some reports from the Embedded Web Server. These reports are useful for assessing the status of the
printer, network, and supplies.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:
® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.
® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Reports, and then click the type of report you want to view.
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Configuring supply notifications from the Embedded Web
Server

You can determine how you would like to be notified when supplies run nearly low, low, very low, or reach their
end-of-life by setting the selectable alerts.

Notes:

® You can select alerts for toner cartridges, imaging kit, maintenance kit, and waste toner bottle.

® All alerts can be set for nearly low, low, and very low supply conditions. Not all alerts can be set for the
end-of-life supply condition. E-mail alert is available for all supply conditions.

® The percentage of estimated remaining supply that prompts the alert can be set on some supplies for some
supply conditions.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Print Settings > Supply Notifications.

3 From the drop-down menu for each supply, select one of the following notification options:

Notification Description
Off The normal printer behavior for all supplies occurs.
E-mail Only The printer generates an e-mail when the supply condition is reached. The status of the

supply appears on the menus page and status page.

Warning The printer shows the warning message and generates an email about the status of the
supply. The printer does not stop when the supply condition is reached.

Continuable Stop?! The printer stops processing jobs when the supply condition is reached. The user needs to
press a button to continue printing.

Non Continuable Stop’? | The printer stops when the supply condition is reached. The supply must be replaced to
continue printing.

1 The printer generates an e-mail about the status of the supply when supply notification is enabled.

2The printer stops when some supplies become empty to prevent damage.

4 Click Submit.

Modifying confidential print settings

Note: This feature is available only in network printers or printers connected to print servers.
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.
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® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Configuration > Other Settings tab > Security > Confidential Print Setup.

3 Modify the settings:
® Set a maximum number of PIN entry attempts. When a user exceeds a specific number of PIN entry attempts,
all of the jobs for that user are deleted.

® Setan expiration time for confidential print jobs. When a user has not printed the jobs within the specified time,
all of the jobs for that user are deleted.

4 Save the modified settings.

Copying printer settings to other printers

Note: This feature is available only in network printers.
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

® View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

® |f you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click the Copy Printer Settings.
3 Tochange the language, select alanguage from the drop-down menu, and then click Click here to submit language.
4 Click Printer Settings.
5 Type the IP addresses of the source and target printers in their appropriate fields.
Note: If you want to add or remove a target printer, then click Add Target IP or Remove Target IP.

6 Click Copy Printer Settings.

Restoring factory default settings

If you want to keep a list of the current menu settings for reference, then print a menu settings page before restoring
the factory default settings. For more information, see “Printing a menu settings page” on page 33.

If you want a more comprehensive method of restoring the printer factory default settings, then perform the Wipe All
Settings option. For more information, see “Erasing non-volatile memory” on page 113.

Warning—Potential Damage: Restoring factory defaults returns most printer settings to the original factory default
settings. Exceptions include the display language, custom sizes and messages, and network/port menu settings. All
downloads stored in the RAM are deleted. Downloads stored in the flash memory or in the printer hard disk are not

affected.

From the printer control panel, navigate to:

> Settings >m > Settings > n > General Settings > m > Factory Defaults > n > Restore Now > m
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Clearing jams

Avoiding jams

Load paper properly

® Make sure paper lies flat in the tray.

Correct loading of paper Incorrect loading of paper

® Do not remove a tray while the printer is printing.
® Do not load a tray while the printer is printing. Load it before printing, or wait for a prompt to load it.

® Do not load too much paper. Make sure the stack height is below the maximum paper fill indicator.
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® Do not slide the paper into the tray. Load paper as shown in the illustration.

® Make sure the guides in the tray or the multipurpose feeder are properly positioned and are not pressing tightly
against the paper or envelopes.

® Push the tray firmly into the printer after loading paper.

Use recommended paper
® Use only recommended paper or specialty media.
® Do not load wrinkled, creased, damp, bent, or curled paper.

® Flex, fan, and straighten paper before loading it.

® Do not use paper that has been cut or trimmed by hand.
® Do not mix paper sizes, weights, or types in the same tray.
® Make sure the paper size and type are set correctly on the computer or printer control panel.

® Store paper according to manufacturer recommendations.
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Understanding jam messages and locations

When a jam occurs, a message indicating the jam location and information to clear the jam appears on the printer
display. Open the doors, covers, and trays indicated on the display to remove the jam.

Note: When Jam Recovery is set to On or Auto, the printer reprints jammed pages. However, Auto does not
guarantee that the page will print.

Jam location

1 Standard bin

Message on the display

[x]-page jam, clear standard
bin. [203.xx]

What to do

Remove the jammed paper.

2 Fuser

[x]-page jam, open front door to clear
fuser. [202.xx]

Open the front door, pull the tab and hold the fuser
cover down, and then remove the jammed paper.

3 Front door

[x]-page jam, open front door. [20y.xx]

Open the front door, and then remove the jammed
paper.

4 | Duplex [x]-page jam, open front door to clear | Open the front door, and then remove the jammed
duplex. [23y.xx] paper.
5 Tray [X] [x]-page jam, open tray [x]. [24y.xx] Pull the indicated tray out, and then remove the

jammed paper.

6 Manual feeder

[x]-page jam, clear manual
feeder. [251.xx]

Remove the jammed paper.

7 | Multipurpose feeder

[x]-page jam, clear multipurpose
feeder. [250.xx]

Push the paper release lever to lift the paper rollers,
and then remove the jammed paper.

[x]-page jam, clear standard bin.

1 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.
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2 From the printer control panel, touch 4 to clear the message and continue printing. For non-touch-screen printer

models, select Next > Clear the jam, press OK, and then press n to confirm.

[x]-page jam, open front door to clear fuser.

1 Open the front door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching it.
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2 Pull the green lever to open the fuser cover.

3 Hold down the fuser cover, and then remove the jammed paper.

Note: Make sure all paper fragments are removed.
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4 Close the front door.

5 From the printer control panel, touch 4 to clear the message and continue printing. For non-touch-screen printer

models, select Next > Clear the jam, press OK, and then press n to confirm.

[x]-page jam, open front door.
1 Open the front door.

& CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching it.

2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.
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3 Close the front door.

4 From the printer control panel, touch 4 to clear the message and continue printing. For non-touch-screen printer

models, select Next > Clear the jam, press OK, and then press n to confirm.

[x]-page jam, open front door to clear duplex.

1 Open the front door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching it.
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2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

3 Close the front door.

4 From the printer control panel, touch 4 to clear the message and continue printing. For non-touch-screen printer

models, select Next > Clear the jam, press OK, and then press n to confirm.

[x]-page jam, open tray [x].
1 Pull the tray completely out of the printer.

Note: The message on the printer display determines in which tray the paper jam is located.
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2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.
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3 Insert the tray.

4 From the printer control panel, touch 4 to clear the message and continue printing. For non-touch-screen printer

models, select Next > Clear the jam, press OK, and then press n to confirm.
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[x]-page jam, clear manual feeder.

1 Pull out the standard 250-sheet tray (Tray 1) and manual feeder.

2 Grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

3 Insert the tray.

4 From the printer control panel, touch 4 to clear the message and continue printing. For non-touch-screen printer

models, select Next > Clear the jam, press OK, and then press Jk&¥l to confirm.

[x]-page jam, clear multipurpose feeder

1 Push the paper release lever in the multipurpose feeder to access the jammed paper, and then gently pull it out.

Note: Make sure all paper fragments are removed.
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2 Flexthe sheets of paper backandforthtoloosenthem, and then fanthem. Do not fold or crease the paper. Straighten
the edges on a level surface.

3 Reload paper into the multipurpose feeder.




Clearing jams 153

4 Slide the paper guide until it rests lightly against the edge of the paper stack.

5 From the printer control panel, touch 4 to clear the message and continue printing. For non-touch-screen printer

models, select Next > > Clear the jam, press OK >n.
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Troubleshooting

Understanding the printer messages

Adjusting color

Wait for the process to complete.

Change [paper source] to [custom type name]

Try one or more of the following:

® |oad the correct size and type of paper in the tray, and then select Finished changing paper on the printer control
panel to clear the message and continue printing. For non-touch-screen printer models, press n to confirm.

Note: Make sure the paper size and type are specified in the Paper menu on the printer control panel.

® Cancel the print job.

Change [paper source] to [custom string]

Try one or more of the following:

® |oad the correct size and type of paper in the tray, and then select Finished changing paper on the printer control
panel to clear the message and continue printing. For non-touch-screen printer models, press n to confirm.

Note: Make sure the paper size and type are specified in the Paper menu on the printer control panel.

® Cancel the print job.

Change [paper source] to [paper type] [paper size]

Try one or more of the following:

® Load the correct size and type of paper in the tray, and then select Finished changing paper on the printer control
panel to clear the message and continue printing. For non-touch-screen printer models, press n to confirm.

Note: Make sure the paper size and type are specified in the Paper menu on the printer control panel.

® Cancel the print job.

Close door

Make sure the right side cover is installed, and then close the front and top doors to clear the message.
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[Color] cartridge low [88.xy]
You may need to order a toner cartridge. If necessary, select Continue to clear the message and continue printing. For

non-touch-screen printer models, press n to confirm.

[Color] cartridge nearly low [88.xy]
If necessary, select Continue on the printer control panel to clear the message and continue printing. For

non-touch-screen printer models, press n to confirm.

[Color] cartridge very low, [x] estimated pages remain [88.xy]

You may need to replace the toner cartridge very soon. For more information, see the “Replacing supplies” section of
the User’s Guide.

If necessary, select Continue on the printer control panel to clear the message and continue printing. For

non-touch-screen printer models, press n to confirm.

[Type] imaging kit low [84.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.
You may need to order an imaging kit. If necessary, select Continue on the printer control panel to clear the message

and continue printing. For non-touch-screen printer models, press n to confirm.

[Type] imaging kit nearly low [84.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.
If necessary, select Continue on the printer control panel to clear the message and continue printing. For

non-touch-screen printer models, press n to confirm.

[Type] imaging kit very low, [x] estimated pages remain [84.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.

You may need to replace the imaging kit very soon. For more information, see the “Replacing supplies” section of the
User’s Guide.

If necessary, select Continue on the printer control panel to clear the message and continue printing. For

non-touch-screen printer models, press n to confirm.



Troubleshooting 156

Complex page, some data may not have printed [39]

Try one or more of the following:

® From the printer control panel, select Continue to ignore the message and continue printing. For non-touch-screen

printer models, press n to confirm.

® Cancel the current print job. For non-touch-screen printer models, press m to confirm.

® |nstall additional printer memory.

Configuration change, some held jobs were not restored [57]

Held jobs are invalidated because of any of the following possible changes in the printer:

® The printer firmware has been updated.

The tray for the print job is removed.

The print job is sent from a flash drive that is no longer attached to the USB port.

The printer hard disk contains print jobs that were stored when the hard disk was installed in a different printer
model.

From the printer control panel, select Continue to clear the message. For non-touch-screen printer models, press m
to confirm.

Defective flash detected [51]

Try one or more of the following:
® Replace the defective flash memory card.

® From the printer control panel, select Continue to ignore the message and continue printing. For non-touch-screen

printer models, press n to confirm.

® Cancel the current print job.

Error reading USB drive. Remove USB.

An unsupported USB device is inserted. Remove the USB device, and then insert a supported one.

Error reading USB hub. Remove hub.

An unsupported USB hub has been inserted. Remove the USB hub, and then install a supported one.

Incompatible tray [x] [59]

Remove, and then reinstall the indicated tray to clear the message.
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Incorrect paper size, open [paper source] [34]

Try one or more of the following:
® |oad the correct size of paper in the tray.

® From the printer control panel, select Continue to clear the message and print using a different tray. For

non-touch-screen printer models, press n to confirm.
® Check the tray length and width guides and make sure the paper is loaded properly in the tray.
® Make sure the correct paper size and type are specified in the Printing Preferences or in the Print dialog.
® Make sure the paper size and type are specified in the Paper menu on the printer control panel.

® Make sure that the paper size is correctly set. For example, if MP Feeder Size is set to Universal, then make sure
the paper is large enough for the data being printed.

® Cancel the print job.

Insert Tray [x]

Insert the indicated tray into the printer.

Insufficient memory for Flash Memory Defragment operation [37]

Try one or more of the following:

® From the printer control panel, select Continue to stop the defragmentation and continue printing. For

non-touch-screen printer models, press n to confirm.
® Delete fonts, macros, and other data from the printer memory.

® |nstall additional printer memory.

Insufficient memory, some Held Jobs were deleted [37]

The printer deleted some held jobs in order to process current jobs.

Select Continue to clear the message. For non-touch-screen printer models, press n to confirm.

Insufficient memory to collate job [37]

Try one or more of the following:

® From the printer control panel, select Continue to print the part of the job already stored and begin collating the

rest of the print job. For non-touch-screen printer models, press m to confirm.

® Cancel the current print job.

Insufficient memory to support Resource Save feature [35]
Install additional printer memory or select Continue on the printer control panel to disable Resource Save, clear the

message, and continue printing. For non-touch-screen printer models, press n to confirm.
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Insufficient memory, some held jobs will not be restored [37]

Try one or more of the following:
® From the printer control panel, select Continue to clear the message. For non-touch-screen printer models, press

n to confirm.

® Delete other held jobs to free up additional printer memory.

Load [paper source] with [custom type name]

Try one or more of the following:
® |Load the tray or feeder with the correct size and type of paper.

® To use the tray with the correct paper size or type, select Finished loading paper on the printer control panel. For
non-touch-screen printer models, press n to confirm.

Note: If the printer detects a tray that has the correct paper type and size, then it feeds from that tray. If the
printer cannot detect a tray that has the correct paper type and size, then it prints from the default paper
source.

® Cancel the current job.

Load [paper source] with [custom string]
Try one or more of the following:
® |Load the indicated tray or feeder with the correct size and type of paper.
® To use the tray with the correct paper size or type, select Finished loading paper on the printer control panel. For

non-touch-screen printer models, press n to confirm.

Note: If the printer finds a tray that has the correct paper type and size, then it feeds from that tray. If the
printer cannot find a tray with the correct paper type and size, then it prints from the default paper source.

® Cancel the current job.

Load [paper source] with [paper size]
Try one or more of the following:
® |oad the tray or feeder with the correct size of paper.

® To use the tray or feeder with the correct paper size, select Finished loading paper on the printer control panel.
For non-touch-screen printer models, press n to confirm.

Note: If the printer detects a tray that has the correct paper size, then it feeds from that tray. If the printer
cannot detect a tray that has the correct paper size, then it prints from the default paper source.

® Cancel the current job.
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Load [paper source] with [paper type] [paper size]

Try one or more of the following:
® |load the tray or feeder with the correct size and type of paper.

® To use the tray or feeder with the correct paper size and type, select Finished loading paper on the printer control

panel. For non-touch-screen printer models, press n to confirm.

Note: If the printer detects a tray that has the correct paper size and type, then it feeds from that tray. If the
printer cannot detect a tray that has the correct paper size and type, then it prints from the default paper
source.

® Cancel the current job.

Load Manual Feeder with [custom string]

Try one or more of the following:
® |oad the feeder with the correct size and type of paper.
® Depending on your printer model, touch Prompt each page, paper loaded or press m on the printer control panel
to clear the message and continue printing.

® Cancel the current job.

Load Manual Feeder with [custom type name]

Try one or more of the following:
® |oad the feeder with the correct size and type of paper.
® Depending on your printer model, touch Prompt each page, paper loaded or press n on the printer control panel
to clear the message and continue printing.

® Cancel the current job.

Load Manual Feeder with [paper size]

Try one or more of the following:
® |oad the feeder with the correct size of paper.
® Depending on your printer model, touch Prompt each page, paper loaded or press m on the printer control panel
to clear the message and continue printing.

® Cancel the current job.

Load Manual Feeder with [paper type] [paper size]

Try one or more of the following:
® |oad the feeder with the correct size and type of paper.
® Depending on your printer model, touch Prompt each page, paper loaded or press n on the printer control panel
to clear the message and continue printing.

® Cancel the current job.
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Maintenance kit low [80.xy]

You may need to order a maintenance kit. For more information, contact customer support at
http://support.lexmark.com or your service representative. If necessary, select Continue to clear the message and

continue printing. For non-touch-screen printer models, press m to confirm.

Maintenance kit nearly low [80.xy]

For more information, contact customer support at http://support.lexmark.com or your service representative. If
necessary, select Continue to clear the message and continue printing. For non-touch-screen printer models,

press m to confirm.

Maintenance kit very low, [x] estimated pages remain [80.xy]

You may need to replace the maintenance kit very soon. For more information, contact customer support at
http://support.lexmark.com or your service representative.

If necessary, select Continue on the printer control panel to clear the message and continue printing. For

non-touch-screen printer models, press n to confirm.

Memory full [38]

Try one or more of the following:

® From the printer control panel, select Cancel job to clear the message. For non-touch-screen printer models, press

n to confirm.

® |nstall additional printer memory.

Network [x] software error [54]

Try one or more of the following:

® From the printer control panel, select Continue to continue printing. For non-touch-screen printer models, press

n to confirm.

® Turn off the printer, wait for about 10 seconds, and then turn the printer back on.

® Update the network firmware in the printer or print server. For more information, contact customer support.

Not enough free space in flash memory for resources [52]

Try one or more of the following:

® From the printer control panel, select Continue to clear the message and continue printing. For non-touch-screen

printer models, press n to confirm.
® Delete fonts, macros, and other data stored in the flash memory.

® Upgrade to a larger capacity flash memory card.

Note: Downloaded fonts and macros that are not previously stored in the flash memory are deleted.
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Non-Lexmark [color] [supply type], see User's Guide [33.xy]

Note: The supply type can be a toner cartridge or the imaging kit.
The printer has detected a non-Lexmark supply or part installed in the printer.

Your Lexmark printer is designed to function best with genuine Lexmark supplies and parts. Use of third-party supplies
or parts may affect the performance, reliability, or life of the printer and its imaging components.

All life indicators are designed to function with Lexmark supplies and parts, and may deliver unpredictable results if
third-party supplies or parts are used. Imaging component usage beyond the intended life may damage your Lexmark
printer or its associated components.

Warning—Potential Damage: Use of third-party supplies or parts can affect warranty coverage. Damage caused by
the use of third-party supplies or parts may not be covered by the warranty.

To accept any and all of these risks, and to proceed with the use of non-genuine supplies or parts in your printer, press
and hold . and the # button on the printer control panel simultaneously for 15 seconds.

If you do not wish to accept these risks, then remove the third-party supply or part from your printer, and then install
a genuine Lexmark supply or part.

Note: For the list of supported supplies, see the “Ordering supplies” section of the User's Guide or visit
www.lexmark.com.

PPDS font error [50]

Try one or more of the following:

® From the printer control panel, select Continue to clear the message and continue printing. For non-touch-screen

printer models, press n to confirm.

® |f the printer cannot find the requested font, then from the printer control panel, navigate to:
PPDS menu > Best Fit > On
The printer will find a similar font and reformat the affected text.

® Cancel the current print job.

Reinstall missing or unresponsive [color] cartridge [31.xy]

Try one or more of the following:
® |nstall the missing toner cartridge. For more information, see the “Replacing supplies” section of the User’s Guide.

® Remove the unresponsive cartridge, and then reinstall it.

Note: If the message appears after reinstalling the supply, then the cartridge may be defective. Replace the
cartridge.

Reinstall missing or unresponsive [type] imaging kit [31.xy]

Note: The type can be a black imaging kit, or a black and color imaging kit.


http://www.lexmark.com

Troubleshooting 162

Try one or more of the following:
® |nstall the missing imaging kit. For more information, see the “Replacing supplies” section of the User’s Guide.

® Remove the unresponsive imaging kit, and then reinstall it.

Note: If the message appears after reinstalling the supply, then the imaging kit may be defective. Replace the
imaging kit.

Reload printed pages in Tray [x]

Try any of the following:

® From the printer control panel, select Continue to clear the message and continue printing the second side of the

sheet. For non-touch-screen printer models, press Ja® to confirm.

® Cancel the print job.

Remove packaging material, [area name]
1 Remove any remaining packing material from the indicated location.

2 From the printer control panel, touch Continue to clear the message. For non-touch-screen printer models, press

n to confirm.

Remove paper from standard output bin

Remove the paper stack from the standard bin.

Replace [color] cartridge, 0 estimated pages remain [88.xy]

Replace the indicated toner cartridge to clear the message and continue printing. For more information, see the
instruction sheet that came with the supply.

Note: If you do not have a replacement cartridge, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace [color] cartridge, printer region mismatch [42.xy]

Install a toner cartridge that matches the region number of the printer. x indicates the value of the printer region. y
indicates the value of the cartridge region. x and y can have the following values:

Region number Region

0 Global

United States, Canada

European Union (EU), European Economic Area (EEA), Switzerland

Rest of the world

O [0 | N |-

Invalid
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Notes:

® The x and y values represent .xy in the error code that appears on the printer control panel.

® The x and y values must match for printing to continue.

Replace [type] imaging kit, 0 estimated pages remain [84.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.

Replace the indicated imaging kit to clear the message and continue printing. For more information, see the instruction
sheet that came with the supply.

Note: If you do not have a replacement imaging kit, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace defective [color] cartridge [31.xy]

Replace the defective toner cartridge to clear the message. For more information, see the instruction sheet that came
with the supply.

Note: If you do not have a replacement toner cartridge, then see the “Ordering supplies” section of the User’s Guide
or visit www.lexmark.com.

Replace defective [type] imaging kit [31.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.

Replace the defective imaging kit to clear the message and continue printing. For more information, see the instruction
sheet that came with the supply.

Note: If you do not have a replacement imaging kit, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace maintenance kit, 0 estimated pages remain [80.xy]

Contact customer support at http://support.lexmark.com or your service representative, and then report the message.
The printer is scheduled for maintenance.

Replace missing [color] cartridge [31.xy]

Install the indicated toner cartridge to clear the message. For more information, see the “Replacing supplies” section
of the User’s Guide.

Replace missing [type] imaging kit [31.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.

Install the indicated imaging kit to clear the message. For more information, see the “Replacing supplies” section of
the User’s Guide.
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Replace missing waste toner bottle [82.xy]

Install the missing waste toner bottle to clear the message. For more information, see the instruction sheet that came
with the supply.

Replace unsupported [color] cartridge [32.xy]
Remove the toner cartridge, and then install a supported one to clear the message.

Note: If you do not have a replacement cartridge, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace unsupported [type] imaging kit [32.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.
Remove the indicated imaging kit, and then install a supported one to clear the message.

Note: If you do not have a replacement imaging kit, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace waste toner bottle [82.xy]

Replace the waste toner bottle to clear the message.

Restore held jobs?

Try one or more of the following:
® From the printer control panel, touch Restore to restore all held jobs stored in the printer hard disk.

® From the printer control panel, touch Do not restore if you do not want to restore any of the print jobs.

SMTP server not set up. Contact system administrator.
From the printer control panel, touch Continue to clear the message.

Note: If the message appears again, then contact your system support person.

Some held jobs were not restored

From the printer control panel, select Continue to clear the message. For non-touch-screen printer models, press m
to confirm.

Note: Held jobs that are not restored remain in the printer hard disk and are inaccessible.
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Standard network software error [54]

Try one or more of the following:

® From the printer control panel, select Continue to continue printing. For non-touch-screen printer models, press

n to confirm.

® Turn off the printer and then turn it back on.

® Update the network firmware in the printer or print server. For more information, contact customer support.

Standard USB port disabled [56]

From the printer control panel, select Continue to clear the message. For non-touch-screen printer models, press m
to confirm.

Notes:

® The printer discards any data received through the USB port.

® Make sure the USB Buffer menu is not set to Disabled.

Supply needed to complete job

Try one or more of the following:

® From the printer control panel, touch Prompt for supplies to view all error messages that indicate what supplies

are needed to continue processing the current job. For non-touch-screen printer models, press n to clear the
message and continue printing.

1 Order the missing supply immediately.
2 Install the supply. For more information, see the instruction sheet that came with the supply.

® Cancel the print job, then install the missing supply, and then resend the print job.

Too many flash options installed [58]
1 Turn off the printer.
2 Unplug the power cord from the electrical outlet.
3 Remove the extra flash memory.
4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.

Too many trays attached [58]
1 Turn off the printer.
2 Unplug the power cord from the electrical outlet.

3 Remove the extra trays.
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4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.

Unformatted flash detected [53]

Try one or more of the following:

® From the printer control, select Continue to stop the defragmentation and continue printing. For non-touch-screen

printer models, press n to confirm.
® Format the flash memory.

Note: If the error message remains, then the flash memory may be defective and need to be replaced.

Waste toner bottle nearly full [82.xy]
You may need to order a waste toner bottle. If necessary, select Continue on the printer control panel to clear the

message and continue printing. For non-touch-screen printer models, press [l to confirm.

Weblink server not set up. Contact system administrator.

From the printer control panel, press [l to clear the message.

Note: If the message appears again, then contact your system support person.

Solving printer problems

Basic printer problems

The printer is not responding

Action Yes No

Step 1 Go to step 2. Turn on the printer.
Make sure the printer is turned on.

Is the printer turned on?

Step 2 Press the Sleep button | Go to step 3.

Check if the printer is in Sleep mode or Hibernate mode. to wake the printer
from Sleep mode or

Hibernate mode.

Is the printer in Sleep mode or Hibernate mode?
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Action

Step 3

Check if one end of the power cord is plugged into the printer and the
other to a properly grounded electrical outlet.

Is the power cord plugged into the printer and a properly grounded
electrical outlet?

Yes

Go to step 4.

No

Plug one end of the
power cord into the
printer and the other to
a properly grounded
electrical outlet.

in the correct ports.

Are the cables inserted in the correct ports?

Step 4 Unplug the other Go to step 5.
Check other electrical equipment plugged into the electrical outlet. electrical equipment,
and then turn on the
Does other electrical equipment work? printer. If the printer
quip ’ does not work, then
reconnect the other
electrical equipment.
Step 5 Go to step 6. Make sure to matchthe
Check if the cables connecting the printer and the computer are inserted following:

® The USB symbol on
the cable with the
USB symbol on the
printer

® The appropriate
Ethernet cable with
the Ethernet port

Check if the printer is plugged into any surge protectors, uninterruptible
power supplies, or extension cords.

Is the printer plugged into any surge protectors, uninterruptible power
supplies, or extension cords?

Step 6 Turn on the switch or | Go to step 7.
Make sure the electrical outlet is not turned off by a switch or breaker. | reset the breaker.

Is the electrical outlet turned off by a switch or breaker?

Step 7 Connect the printer Go to step 8.

power cord directly to
a properly grounded
electrical outlet.

Step 8

Check if one end of the printer cable is plugged into a port on the printer
and the other to the computer, print server, option, or other network
device.

Is the printer cable securely attached to the printer and the computer,
print server, option, or other network device?

Go to step 9.

Connect the printer
cable securely to the
printer and the
computer, print server,
option, or other
network device.

Step 9

Make sure toinstall all hardware options properly and remove any packing
material.

Are all hardware options properly installed and all packing material
removed?

Go to step 10.

Turn off the printer,
remove all packing
materials, then
reinstall the hardware
options, and then turn
on the printer.
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Action

Step 10
Check if you have selected the correct port settings in the printer driver.

Are the port settings correct?

Yes

Go to step 11.

No

Use correct printer
driver settings.

Step 11
Check the installed printer driver.

Is the correct printer driver installed?

Go to step 12.

Install the correct
printer driver.

Step 12

Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

Is the printer working?

The problem is solved.

Contact customer
support.

Printer display is blank

Action

Step 1
Press the Sleep button on the printer control panel.

Does Ready appear on the printer display?

Yes

The problem is solved.

No

Go to step 2.

Step 2
Turn off the printer, then wait for about 10 seconds, and then turn the

\

The problem is solved.

Turn off the printer,
and then contact

N

printer back on. customer support.
Do Please wait and Ready appear on the printer display?

Hardware and internal option problems
Cannot detect memory card

Action Yes No

Make sure the memory card is installed.

a Install the memory card. For more information, see “Installing a
memory card” on page 21.

Note: Check if the memory card is securely connected to the printer
controller board.

b Print a menu settings page, and then check if the card is listed in the
Installed Options list.

Is the card listed in the Installed Options list?

The problem is solved.

Contact customer
support.
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Cannot detect internal option

Action

Step 1

Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

Does the internal option operate correctly?

Yes

The problem is solved.

No

Go to step 2.

Check if the option is available in the printer driver.

It may be necessary to manually add the internal option in the printer
driver to make it available for print jobs. For more information, see
“Updating available options in the printer driver” on page 28.

Is the internal option available in the printer driver?

Step 2 Go to step 3. Connect the internal
Check if the internal option is properly installed in the controller board. option to the controller
. board.

a Turn off the printer.

b Unplug the power cord from the electrical outlet.

¢ Make suretheinternal optionisinstalled in the appropriate connector

in the controller board.

d Turn the printer back on.
Is the internal option properly installed in the controller board?
Step 3 Go to step 4. Reinstall the internal
Print a menu settings page, and then check to see if the internal option is option.
listed in the Installed Options list.
Is the internal option listed in the menu settings page?
Step 4 Go to step 5. Manually add the

internal option in the
printer driver.

Step 5
a Check if the internal option is selected.

Note: From the application you are using, select the internal option.
For Mac OS X version 9 users, make sure the printer is set up in
Chooser.

b Resend the print job.

Does the internal option operate correctly?

The problem is solved.

Contact customer
support.
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Tray problems

Action Yes [\ [o)

Step 1 The problem is solved. | Go to step 2.
a Pull out the tray, and then do one or more of the following:
® Check for paper jams or misfeeds.

® Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.

® If you are printing on custom-size paper, then make sure that the
paper guides rest against the edges of the paper.

® Make sure the paper is below the maximum paper fill indicator.
® Make sure paper lies flat in the tray.
b Check if the tray closes properly.

Is the tray working?

Step 2 The problem is solved. | Go to step 3.

a Turn off the printer, then wait about 10 seconds, and then turn the
printer back on.

b Resend the print job.

Is the tray working?

Step 3 Go to step 4. Reinstall the tray. For
Check if the tray is installed and recognized by the printer. more information, see
the setup

Print a menu settings page, and then check if the tray is listed in the

Installed Features list. documentation that

came with the tray.

Is the tray listed in the menu settings page?

Step 4 The problem is solved. | Contact customer
Check if the tray is available in the printer driver. support.

Note: If necessary, manually add the tray in the printer driver to make it
available for print jobs. For more information, see “Updating available
options in the printer driver” on page 28.

Is the tray available in the printer driver?
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Paper feed problems

Jammed pages are not reprinted

Action

a Turn on jam recovery.
1 From the printer control panel, navigate to:
Settings > General Settings > Print Recovery > Jam Recovery
2 Select On or Auto.

3 Depending on your printer model, press n or touch Submit.
b Resend the pages that did not print.

Were the jammed pages reprinted?

Yes

The problem is solved.

\[o)

Contact customer
support.

N

Paper frequently jams
Action Yes No
Step 1 Go to step 2. The problem is solved.
a Pull out the tray, and then do one or more of the following:
® Make sure paper lies flat in the tray.
® Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.
® Check if the paper guides are aligned against the edges of the
paper.
® Make sure the paper is below the maximum paper fill indicator.
® Check if you are printing on a recommended paper size and type.
b Insert the tray properly.
If jam recovery is enabled, then the print jobs will reprint
automatically.
Do paper jams still occur frequently?
Step 2 Go to step 3. The problem is solved.

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do paper jams still occur frequently?

Step 3

a Review the tips on avoiding jams. For more information, see “Avoiding
jams” on page 142.

b Follow the recommendations, and then resend the print job.

Do paper jams still occur frequently?

Contact customer
support.

The problem is solved.
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Paper jam message remains after jam is cleared
Action
a Do either of the following:
® For touch-screen printer models, touch ¢ or Done.

® For non-touch-screen printer models, select Next > > Clear

the jam, press OK > .
b Follow the instructions on the printer display.

Does the paper jam message remain?

Yes

Contact customer
support.

No

The problem is solved.

Solving home screen applications problems

An application error has occurred

Action

Step 1
Check the system log for relevant details.

a Open a Web browser, and then type the printer IP address in the
address field.

If you do not know the IP address of the printer, then you can:
® View the IP address on the printer home screen.

® Print a network setup page or the menu settings pages, and then
locate the IP address in the TCP/IP section.

Note: An IP address appears as four sets of numbers separated by
periods, such as 123.123.123.123.

b Click Settings > Apps > Apps Management > System tab > Log.
¢ From the Filter menu, select an application status.

d From the Application menu, select an application, and then click
Submit.

Does an error message appear in the log?

Yes

Go to step 2.

\[o)

Contact customer
support.

Step 2
Resolve the error.

Is the application working now?

The problem is solved.

Contact customer
support.
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Solving print problems

Printing problems

Incorrect characters print

Action
Step 1
Make sure the printer is not in Hex Trace mode.

Note: If Ready Hex appears on the printer display, then turn off the
printer, and then turn it back on to deactivate Hex Trace mode.

Is the printer in Hex Trace mode?

Yes

Deactivate Hex Trace
mode.

No

Go to step 2.

Step 2

a From the printer control panel, select Standard Network or
Network [x], and then set SmartSwitch to On.

b Resend the print job.

Do incorrect characters print?

Contact customer
support.

The problem is solved.

\

Job prints from the wrong tray or on the wrong paper

Action Yes No
Step 1 The problem is solved. | Go to step 2.
a Check if you are printing on paper that is supported by the tray.
b Resend the print job.
Did the job print from the correct tray or on the correct paper?
Step 2 The problem is solved. | Go to step 3.
a From the Paper menu on the printer control panel, set the paper size
and type to match the paper loaded in the tray.
b Resend the print job.
Did the job print from the correct tray or on the correct paper?
Step 3 The problem is solved. | Go to step 4.

a Depending on your operating system, open Printing Preferences or
the Print dialog, and then specify the paper type.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?
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Action

Step 4
a Check if the trays are not linked.
b Resend the print job.

Did the job print from the correct tray or on the correct paper?

Yes

The problem is solved.

No

Contact customer
support.

Large jobs do not collate

Action Yes No
Step 1 The problem is solved. | Go to step 2.
a From the Finishing menu on the printer control panel, set Collate to
(1,2,3) (1,2,3).
b Resend the print job.
Did the job print and collate correctly?
Step 2 The problem is solved. | Go to step 3.

a From the printer software, set Collate to (1,2,3) (1,2,3).

Note: Setting Collate to (1,1,1) (2,2,2) in the software overrides the
setting in the Finishing menu.

b Resend the print job.

Did the job print and collate correctly?

Step 3

Reduce the complexity of the print job by eliminating the number and size
of fonts, the number and complexity of images, and the number of pages
in the job.

Did the job print and collate correctly?

The problem is solved.

Contact customer
support.

-

Printing slows down

Notes:

® When printing using narrow paper, the printer prints at a reduced speed to prevent damage to the fuser.

® The printer speed may be reduced if printing for long periods of time, or printing at elevated temperatures.

Does the print speed increase?
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Print jobs do not print

Action

Step 1

a From the document you are trying to print, open the Print dialog and
check if you have selected the correct printer.

Note: If the printer is not the default printer, then you must select
the printer for each document that you want to print.

b Resend the print job.

Do the jobs print?

Yes

The problem is solved.

No

Go to step 2.

Step 2

a Checkifthe printeris plugged in and turned on, and if Ready appears
on the printer display.

b Resend the print job.

Do the jobs print?

The problem is solved.

Go to step 3.

Step 3
Ifan error message appears on the printer display, then clear the message.

Note: The printer continues to print after clearing the message.

Do the jobs print?

The problem is solved.

Go to step 4.

Step 4

a Check if the ports (USB, serial, or Ethernet) are working and if the
cables are securely connected to the computer and the printer.

Note: For more information, see the setup documentation that
came with the printer.

b Resend the print job.

Do the jobs print?

The problem is solved.

Go to step 5.

Step 5

a Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

b Resend the print job.

Do the jobs print?

The problem is solved.

Go to step 6.

Step 6

a Remove, and then reinstall the printer software. For more
information, see “Installing the printer software” on page 27.

Note: The printer software is available at
http://support.lexmark.com.
b Resend the print job.

Do the jobs print?

The problem is solved.

Contact customer
support.
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Print job takes longer than expected

Action

Step 1
Change the environmental settings of the printer.
a From the printer control panel, navigate to:
Settings > General Settings
b Select Eco-Mode or Quiet Mode, and then select Off.

Note: Disabling Eco-Mode or Quiet Mode may increase the
consumption of energy or supplies, or both.

Did the job print?

Yes

The problem is solved.

No

Go to step 2.

Step 2

Reduce the number and size of fonts, the number and complexity of
images, and the number of pages in the print job, and then resend the job

Did the job print?

The problem is solved.

Go to step 3.

Step 3
a Remove held jobs stored in the printer memory.
b Resend the print job.

Did the job print?

The problem is solved.

Go to step 4.

Step 4
a Disable the Page Protect feature.
From the printer control panel, navigate to:
Settings > General Settings > Print Recovery > Page Protect > Off
b Resend the print job.

Did the job print?

The problem is solved.

Go to step 5.

Step 5

a Check if the cable connections to the printer and print server are
secure. For moreinformation, see the setup documentation that came
with the printer.

b Resend the print job.

Did the job print?

The problem is solved.

Go to step 6.

Step 6
Install additional printer memory, and then resend the print job.

Did the job print?

The problem is solved.

Contact customer
support.
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Repeating defects appear on prints

Action Yes No
Step 1 Go to step 2. 1 Check if the
Measure the distance between the defects. distance between

the defects is

Check for a distance between the defects that equals:
equal to one of the

® 25.1 mm (0.98in.)

following:
® 29.8 mm (1.17in.) e 37.7 mm
® 43.9mm (1.72in.) (1.48in.)
® 455 mm (1.79in.) ® 78.5mm
* 942 mm (3.70in.) (3.091n.)
® 95 mm
Is the distance between defects equal to one of the listed measurements? (3.74in.)

2 Take note of the
distance, and then
contact customer
support at
http://support.le
xmark.com or
your service
representative.

Step 2 Contact customer The problem is solved.
Replace the imaging kit, and then resend the print job. support.

Do the repeating defects still appear?

Tray linking does not work

Notes:

® The trays can detect paper length.

® The multipurpose feeder does not automatically detect the paper size. You must set the size from the Paper
Size/Type menu.
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Action Yes \[o)
Step 1 The problem is solved. | Go to step 2.
a Open the trays, and then check if they contain paper of the same size
and type.

® Check if the paper guides are in the correct positions for the size
of the paper loaded in each tray.

® Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.

b Resend the print job.

Do the trays link correctly?

The problem is solved. | Contact customer

Step 2
support.

a Fromthe printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the trays to be linked.

Note: The paper size and type must match for trays to be linked.
b Resend the print job.

Do the trays link correctly?

Unexpected page breaks occur

Action Yes No

Step 1 The problem is solved. | Go to step 2.

Adjust the print timeout settings.
a From the printer control panel, navigate to:
Settings > General Settings > Timeouts > Print Timeout
b Select a higher setting and then, depending on your printer model,

select il or Submit.
¢ Resend the print job.

Did the file print correctly?

The problem is solved. | Contact customer

Step 2
support.

a Check the original file for manual page breaks.
b Resend the print job.

Did the file print correctly?
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Print quality problems

Characters have jagged or uneven edges

ABC
DEF

Action

Step 1

a Printafontsamplelistto checkif the fonts you are using are supported
by the printer.

1 From the printer control panel, navigate to any of the following:

L > Reports > Print Fonts

® Settings > Reports > Print Fonts
2 Select PCL Fonts or PostScript Fonts.
b Resend the print job.

Are you using fonts that are supported by the printer?

Yes

Go to step 2.

No

Select a font that is
supported by the
printer.

Step 2
Check if the fonts installed on the computer are supported by the printer.

Are the fonts installed on the computer supported by the printer?

The problem is solved.

Contact customer
support.

Clipped pages or images

Leading edge

ABCLC
ABCLC
ABCLC

Trailing edge

Action

Step 1

a Move the width and length guides in the tray to the correct positions
for the paper loaded.

b Resend the print job.

Is the page or image clipped?

Yes

Go to step 2.

No

The problem is solved.
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Action

Step 2

From the printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the tray.

Does the paper size match the paper loaded in the tray?

Yes

Go to step 3.

No

Do one or more of the
following:

® From the printer
control panel,
change the paper
size to match the
paper loaded in the
tray.

® From the printer
control panel,
change the paper
type to match the
paper loaded in the
tray.

Step 3

a Depending on your operating system, specify the paper size from
Printing Preferences or from the Print dialog.

b Resend the print job.

Is the page or image clipped?

Go to step 4.

The problem is solved.

Step 4
a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Is the page or image clipped?

Contact customer
support.

The problem is solved.

Gray background on prints

Leading edge

ABCDE
ABCDE
ABCDE

Trailing edge
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Action
Step 1

Reduce the toner darkness.

a From the Quality menu on the printer control panel, reduce the toner
density.

Note: 4 is the factory default setting.
b Resend the print job.

Did the gray background disappear?

Yes

The problem is solved.

\[o)

Go to step 2.

Step 2
a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Did the gray background disappear?

The problem is solved.

Contact customer
support.

Horizontal voids appear on prints

Leading edge
OSSR

SRR 3

]

Trailing edge

Action

Step 1
a Make sure your software program is using a correct fill pattern.
b Resend the print job.

Do horizontal voids appear on prints?

Yes

Go to step 2.

\[o)

The problem is solved.

Step 2
a Load the specified tray or feeder with a recommended type of paper.
b Resend the print job.

Do horizontal voids appear on prints?

Go to step 3.

The problem is solved.




Troubleshooting

182

Action
Step 3
a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.
b Resend the print job.

Do horizontal voids appear on prints?

Yes

Go to step 4.

No

The problem is solved.

Step 4
Replace the imaging kit, and then resend the print job.

Do horizontal voids appear on prints?

Contact customer
support.

The problem is solved.

Incorrect margins on prints

a Move the width and length guides in the tray to the correct positions
for the paper size loaded.

b Resend the print job.

Are the margins correct?

Yes

The problem is solved.

\[o)

Go to step 2.

Step 2

From the printer control panel, set the paper size in the Paper menu to
match the paper loaded in the tray.

Does the paper size match the paper loaded in the tray?

Go to step 3.

Do one or more of the
following:

® Specify the paper
size from the tray
settings to match
the paper loaded in
the tray.

® Change the paper
loaded in the tray
to match the paper
size specified in the
tray settings.
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Action

Step 3

a Depending on your operating system, specify the paper size from
Printing Preferences or from the Print dialog.

b Resend the print job.

Are the margins correct?
.

Yes

The problem is solved.

No

Contact customer
support.

N

Paper curl
Action Yes No
Step 1 Go to step 2. Adjust the width and
Move the width and length guides in the tray to the correct positions for length guides.
the size of the paper loaded.
Are the width and length guides positioned correctly?
Step 2 Go to step 3. Specify the paper type
From the printer control panel, set the paper type and weight in the Paper and weight from the
menu to match the paper loaded in the tray. tray settings to match
the paper loaded in the
Do the paper type and weight match the type and weight of the paper in tray.
the tray?
Step 3 Go to step 4. The problem is solved.
a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.
b Resend the print job.
Is the paper still curled?
Step 4 Go to step 5. The problem is solved.

a Remove the paper from the tray, and then turn it over.
b Resend the print job.

Is the paper still curled?

Step 5
a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Is the paper still curled?

Contact customer
support.

The problem is solved.
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Print is too dark

B
ABC

DEF

Action

Yes No
Step 1 Go to step 2. The problem is solved.
a From the Quality menu on the printer control panel, select Color
Adjust.
b Resend the print job.
Is the print still too dark?
Step 2 Go to step 3. The problem is solved.
a From the Quality menu on the printer control panel, reduce the toner
darkness.
Note: 4 is the factory default setting.
b Resend the print job.
Is the print still too dark?
Step 3 Go to step 4. Change the paper
a Fromthe printer control panel, set the paper type, texture, and weight loaded in the tray to
in the Paper menu to match the paper loaded in the tray. match the paper type,
b Resend the print job. textlfr.e, a'nd weight
specified in the tray
settings.
Is the tray set to the type, texture, and weight of the paper loaded?
Step 4 Go to step 5. The problem is solved.

a Depending on your operating system, specify the paper type, texture
and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Is the print still too dark?

Step 5
Check if the paper loaded in the tray has texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel, set the
paper texture in the
Paper menu to match
the paper loaded on
the tray.

Go to step 6.
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Action
Step 6
a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Is the print still too dark?

Yes

Go tostep 7.

No

The problem is solved.

Step 7
Replace the imaging kit, and then resend the print job.

Is the print still too dark?

Contact customer
support.

The problem is solved.

Print is too light

AN

Action

Step 1

a From the Quality menu on the printer control panel, select Color
Adjust.

b Resend the print job.

Is the print still too light?

Yes

Go to step 2.

\[o)

The problem is solved.

Step 2

a Fromthe Quality menuonthe printer control panel, increase the toner
darkness.

Note: 4 is the factory default setting.
b Resend the print job.

Is the print still too light?

Go to step 3.

The problem is solved.

Step 3

From the printer control panel, set the paper type, texture, and weight in
the Paper menu to match the paper loaded in the tray.

Is the tray set to the type, texture, and weight of the paper loaded?

Go to step 4.

Specify the paper type,
texture, and weight
from the tray settings
to match the paper
loaded in the tray.
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Action

Step 4

a Depending on your operating system, specify the paper type, texture,
and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Is the print still too light?

Yes

Go to step 5.

No

The problem is solved.

Step 5
Make sure that the paper has no texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel, set the
paper texture in the
Paper menu to match
the paper loaded in the
tray

Go to step 5.

Step 6
a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Is the print still too light?

Go tostep 7.

The problem is solved.

Step 7
Replace the imaging kit, and then resend the print job.

Is the print still too light?

Contact customer
support.

The problem is solved.

Print irregularities

Leading edge

ARCDE
ABCL =
APTT,E

Trailing edge

Action

Step 1

a Move the width and length guides in the tray to the correct positions
for the size of the paper loaded in the tray.

b Resend the print job.

Do print irregularities still appear?

Yes

Go to step 2.

\[o)

The problem is solved.
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Action Yes No

Step 2 Go to step 3. Do one or more of the

From the printer control panel, set the paper size and type in the Paper following:

menu to match the paper loaded in the tray. ® Specify the paper
size from the tray

Is the tray set to the size and type of the paper loaded in the tray? settings to match
the paper loaded in
the tray.

® Change the paper

loaded in the tray
to match the paper
size specified in the
tray settings.

Step 3 Go to step 4. The problem is solved.

a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Do print irregularities still appear?

Step 4
Check if the paper loaded in the tray has texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel, set the
paper texture in the
Paper menu to match
the paper loaded in the
tray.

Go to step 5.

Step 5
a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do print irregularities still appear?

Go to step 6.

The problem is solved.

Step 6
Replace the imaging kit, and then resend the print job.

Do print irregularities still appear?

Contact customer
support.

The problem is solved.

Printer is printing blank pages

DN
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Action Yes No

Step 1 Go to step 2. The problem is solved.
a Check if there is packing material left on the imaging kit.
1 Remove the imaging kit.
2 Checkifthe packing materialis properly removed from theimaging
kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.
3 Reinstall the imaging kit.
b Resend the print job.

Is the printer still printing blank pages?

Step 2 Contact customer The problem is solved.
Replace the imaging kit, and then resend the print job. support.

Is the printer still printing blank pages?

Printer is printing solid black pages

Action Yes No

Step 1 Go to step 2. The problem is solved.
a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Is the printer printing solid black pages?
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Action
Step 2 Contact customer
Replace the imaging kit, and then resend the print job. support.

Is the printer printing solid black pages?

The problem is solved.

Shadow images appear on prints

Leading edge

ABCD
ABCD

Trailing edge

Action Yes

Step 1 Go to step 2.
Checkifthe paperloadedinthetray hasthe correct papertype and weight.

Is paper with the correct paper type and weight loaded in the tray?

No

Load paper with the
correct paper type and
weight in the tray.

Step 2 Go to step 3.

From the printer control panel, set the paper type and weight in the Paper
menu to match the paper loaded in the tray.

Do the printer settings match the type and weight of the paper loaded?

Change the paper type
and weight to match
the paper loaded in the
tray.

Step 3 Go to step 4.

a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Do shadow images still appear on prints?

The problem is solved.

Step 4 Contact customer

Replace the imaging kit, and then resend the print job. support.

Do shadow images still appear on prints?

The problem is solved.
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Skewed print

Action

Step 1

a Move the width and length guides in the tray to the correct positions
for the size of the paper loaded.

b Resend the print job.

Is the print still skewed?

Yes

Go to step 2.

No

The problem is solved.

Step 2
a Check if you are printing on a paper that is supported by the tray.
b Resend the print job.

Is the print still skewed?

Contact customer
support.

The problem is solved.

Streaked horizontal lines appear on prints

ABCDE
o)y
ABCDE

Action

Step 1

a Depending on your operating system, specify the tray or feeder from
Printing Preferences or the Print dialog.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Yes

Go to step 2.

No

The problem is solved.
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Action Yes No

Step 2 Go to step 3. Do one or more of the

From the printer control panel, set the paper type and weight in the Paper following:

menu to match the paper loaded in the tray. ® Specify the paper
type and weight

Do the paper type and weight match the paper in the tray? from the tray
settings to match
the paper loaded in
the tray.

® Change the paper

loaded in the tray
to match the paper
type and weight
specified in the tray
settings.

Step 3 Go to step 4. The problem is solved.

a Load paper from a fresh package.
Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Step 4 Go to step 5. The problem is solved.

a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Step 5
Replace the imaging kit, and then resend the print job.

Do streaked horizontal lines appear on prints?

Contact customer
support.

The problem is solved.

Streaked vertical lines appear on prints

e

Leading edge

Trailing edge
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Action Yes No
Step 1 Go to step 2. The problem is solved.
a Depending on your operating system, specify the paper type, texture,
and weight from Printing Preferences or from the Print dialog.
b Resend the print job.
Do streaked vertical lines appear on prints?
Step 2 Go to step 3. Do one or more of the
From the printer control panel, set the paper texture, type, and weight in following:
the Paper menu to match the paper loaded in the tray. ® Specify the paper
texture, type, and
Do the paper texture, type, and weight match the paper in the tray? weight from the
tray settings to
match the paper
loaded in the tray.
® Change the paper
loaded in the tray
to match the paper
size specified in the
tray settings.
Step 3 Go to step 4. The problem is solved.
a Load paper from a fresh package.
Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.
b Resend the print job.
Do streaked vertical lines appear on prints?
Step 4 Go to step 5. The problem is solved.

a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Do streaked vertical lines appear on prints?

Step 5
Replace the imaging kit, and then resend the print job.

Do streaked vertical lines appear on prints?

Contact customer
support.

The problem is solved.
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Transparency print quality is poor

Action Yes \[o)

Step 1 Go to step 2. Set the paper type to
From the printer control panel, set the paper type in the Paper menu to Transparency.

match the paper loaded in the tray.

Is the paper type for the tray set to Transparency?

Step 2
a Check if you are using a recommended type of transparency.
b Resend the print job.

Is the print quality still poor?

Contact customer
support.

The problem is solved.

Toner fog or background shading appears on prints

ABCDE
ABCDE
ABCDE

Action
Step 1
a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Does fog or shading disappear from the prints?

Yes

The problem is solved.

No

Go to step 2.

Step 2
Replace the imaging kit, and then resend the print job.

Does fog or shading disappear from the prints?

The problem is solved.

Contact customer
support.
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Toner rubs off

Leading edge

ABC
DEF’

Trailing edge

Action

Step 1

From the Paper menu on the printer control panel, check the paper type
and weight.

Do the paper type and texture match the paper loaded in the tray?

Yes

Go to step 2.

No

Specify the paper type
and weight from the
tray settings to match
the paper loaded in the
tray.

Step 2
Check if you are printing on paper with texture or rough finishes.

Are you printing on textured or rough paper?

From the Paper menu
on the printer control
panel, set the paper
texture.

Contact customer
support.

Vertical voids appear on prints

Leading edge

Trailing edge
Action Yes No
Step 1 Go to step 2. The problem is solved.
a Check if your software program is using a correct fill pattern.
b Resend the print job.
Do vertical voids appear on prints?
Step 2 Go to step 3. The problem is solved.

a From the Paper Menu on the printer control panel, check the paper
type and paper weight.

b Resend the print job.

Do vertical voids appear on prints?
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Action Yes No
Step 3 Go to step 4. The problem is solved.
Check if you are using a recommended type of paper.
a Load paper source with a recommended type of paper.
b Resend the print job.
Do vertical voids appear on prints?
Step 4 Go to step 5. The problem is solved.

a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.
b Resend the print job.

Do vertical voids appear on prints?

Step 5
Replace the imaging kit, and then resend the print job.

Do vertical voids appear on prints?

Contact customer
support.

The problem is solved.

Uneven print density

ABCD
ABCD

Replace the imaging kit, and then resend the print job.

Is the print density uneven?

Contact customer
support.

The problem is solved.
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Color quality problems

FAQ about color printing

What is RGB color?

Red, green, and blue light can be added together in various amounts to produce a large range of colors observed in
nature. For example, red and green can be combined to create yellow. Televisions and computer monitors create
colors in this manner. RGB color is a method of describing colors by indicating the amount of red, green, or blue
needed to produce a certain color.

What is CMYK color?

Cyan, magenta, yellow, and black inks or toners can be printed in various amounts to produce a large range of colors
observed in nature. For example, cyan and yellow can be combined to create green. Printing presses, inkjet printers,
and color laser printers create colors in this manner. CMYK color is a method of describing colors by indicating the
amount of cyan, magenta, yellow, and black needed to reproduce a particular color.

How is color specified in a document to be printed?

Software programs typically specify the document color using RGB or CMYK color combinations. Additionally, they
let users modify the color of each object in a document. For more information, see the help information of your
operating system.

How does the printer know what color to print?

When a user prints a document, information describing the type and color of each object is sent to the printer. The
color information is passed through color conversion tables that translate the color into the appropriate amounts of
cyan, magenta, yellow, and black toner needed to produce the color you want. The object information determines
the application of color conversion tables. For example, it is possible to apply one type of color conversion table to
text while applying a different color conversion table to photographic images.

What is manual color correction?

When manual color correction is enabled, the printer employs user-selected color conversion tables to process
objects. However, Color Correction must be set to Manual, or no user-defined color conversion will be implemented.
Manual color correction settings are specific to the type of object being printed (text, graphics, or images), and how
the color of the object is specified in the software program (RGB or CMYK combinations).

Notes:

® Manual color correction is not useful if the software program does not specify colors with RGB or CMYK
combinations. It is also not effective in situations in which the software program or the computer operating
system controls the adjustment of colors.

® When Auto Color Correction is selected, the color conversion tables will generate preferred colors used for
the majority of the documents.

To manually apply a different color conversion table, do the following:
1 From the Quality menu on the printer control panel, select Color Correction, and then select Manual.

2 From the Quality menu on the printer control panel, select Manual Color, and then select the appropriate color
conversion table for the affected object type.
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| Object type Color conversion tables

RGB Image ® Vivid—Produces brighter, more saturated colors and may be applied
RGB Text to all incoming color formats.
RGB Graphics ® sRGB Display—Produces an output that approximates the colors

displayed on a computer monitor.
Note: Black toner usage is optimized for printing photographs.

® Display-True Black—Produces an output that approximates the
colors displayed on a computer monitor. This uses only black toner
to create all levels of neutral gray.

® sRGB Vivid—Provides an increased color saturation for the sRGB
Display color correction.

Note: Black toner usage is optimized for printing business graphics.

® Off —No color correction is implemented.

CMYK Image ® US CMYK—Applies color correction to approximate the SWOP
CMYK Text (Specifications for Web Offset Publishing) color output.
CMYK Graphics ® Euro CMYK—Applies color correction to approximate Euroscale

color output.

® Vivid CMYK—Increases the color saturation of the US CMYK color
correction setting.

® Off —No color correction is implemented.

How can | match a particular color (such as a corporate logo)?

Nine types of Color Samples sets are available from the Quality menu on the printer control panel. These are also
available from the Color Samples page of the Embedded Web Server. Selecting any sample set generates a
multiple-page printout consisting of hundreds of colored boxes. Either a CMYK or RGB combination is located on
each box, depending on the table selected. The observed color of each box is obtained by passing the CMYK or RGB
combination labeled on the box through the selected color conversion table.

By examining Color Samples sets, you can identify the box whose color is the closest to the color you want. The color
combination labeled on the box can then be used for modifying the color of the object in a software program. For
more information, see the help information of your operating system.

Note: Manual color correction may be necessary to utilize the selected color conversion table for the particular
object.

Selecting which Color Samples set to use for a particular color-matching problem depends on the Color Correction
setting being used , the type of object being printed, and how the color of the object is specified in the software
program. When Color Correction is set to Off, the color is based on the print job information, and no color conversion
is implemented.

Note: The Color Samples pages are not useful if the software program does not specify colors with RGB or CMYK
combinations. Additionally, certain situations exist in which the software program or the computer operating
system adjusts the RGB or CMYK combinations specified in the program through color management. The resulting
printed color may not be an exact match of the Color Samples pages.

What are detailed color samples and how do | access them?

Detailed color samples sets are available only through the Embedded Web Server of a network printer. A detailed
Color Samples set contains a range of shades that are similar to a user-defined RGB or CMYK value. The likeness of
the colors in the set is dependent on the value entered in the RGB or CMYK Increment box.
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To access a detailed Color Samples set from the Embedded Web Server, do the following:

1 Open a Web browser, and then type the printer IP address in the address field.

Note: If you do not know the IP address or printer name, then you can:

® View the information on the printer home screen, or in the TCP/IP section in the Networks/Ports menu.

® Print a network setup page or menu settings page, and then locate the information in the TCP/IP section.

2 Click Configuration > Color Samples > Detailed Options.
3 Select a color conversion table.
4 Enter the RGB or CMYK color number.

5 Enter an increment value from 1 to 255.

Note: The closer the value is to 1, the narrower the color sample range will appear.

6 Click Print.

Prints on color transparencies appear dark when projected

Note: This problem occurs when projecting transparencies with reflective overhead projectors. To obtain the highest
projected color quality, transmissive overhead projectors are recommended.

Action Yes No

Step 1 Go to step 2. Set the paper type to
From the printer control panel, make sure the paper type setting is set to Transparency.
Transparency.

Is the paper type setting correct?

Step 2 The problem is solved. | Go to step 3.

Reduce the toner darkness, and then resend the print job.

Does the print on the color transparency look lighter?

Step 3

Make sure you are using a recommended type of color transparency, and
then resend the print job.

Does the print on the color transparency look lighter?

The problem is solved.

Contact customer
support.
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The color of the print does not match the color of the original file

Note: The color conversion tables used in Auto Color Correction mode generally approximate the colors of a
standard computer monitor. However, because of technology differences that exist between printers and monitors,
there are many colors that can also be affected by monitor variations and lighting conditions.

Action

Step 1
a Set Color Correction to Off.

Note: When the printer color correction is disabled, the color is
based on the print job information, and no color conversion is
implemented.

b Resend the print job.

Does the color of the print match the color of the file on the computer
screen?

Yes

The problem is solved.

No

Go to step 2.

Step 2
From the Quality menu on the printer control panel, do the following:
a Select Color Correction, and then select Manual.

b Select Manual Color, and then select the appropriate color conversion
table for the affected object type.

¢ Resend the print job.

Does the color of the print match the color of the file on the computer
screen?

The problem is solved.

Contact customer
support.

The print appears tinted

Action

Adjust the color balance.

a From the Color Balance menu on the printer control panel, increase
or decrease the values for cyan, magenta, yellow, and black.

b Resend the print job.

Does the print still appear tinted?

\

Yes

The problem is solved.

\[o)

Contact customer
support.

Embedded Web Server does not open

Action
Step 1
a Turn on the printer.

b Opena Web browser, and then type the printer IP address.
Cc Press Enter.

Does the Embedded Web Server open?

Yes

The problem is solved.

No

Go to step 2.

\
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Action Yes No
Step 2 The problem is solved. | Go to step 3.
Make sure the printer IP address is correct.
a View the printer IP address:
® From the TCP/IP section in the Network/Ports menu
® By printing a network setup page or menu settings page, and then
finding the TCP/IP section
Note: An IP address appears as four sets of numbers separated
by periods, such as 123.123.123.123.
b Open a Web browser, and then type the IP address.
Note: Depending on the network settings, you may need to type
“https://” instead of “http: //” before the printer IP address
to access the Embedded Web Server.
c Press Enter.
Does the Embedded Web Server open?
Step 3 The problem is solved. | Go to step 4.
Check if the network is working.
a Print a network setup page.
b Checkthe first section of the network setup page and confirm that the
status is Connected.
Note: If the status is Not Connected, then the connection may be
intermittent, or the network cable may be defective. Contact your
system support person for a solution, and then print another
network setup page.
¢ Open a Web browser, and then type the printer IP address.
d Press Enter.
Does the Embedded Web Server open?
Step 4 The problem is solved. | Go to step 5.

Check if the cable connections to the printer and print server are secure.

a Connect the cables properly. For more information, see the setup
documentation that came with the printer.

b Opena Web browser, and then type the printer IP address.
Cc Press Enter.

Does the Embedded Web Server open?

Step 5
Temporarily disable the Web proxy servers.

Proxy servers may block or restrict you from accessing certain Web
sites including the Embedded Web Server.

Does the Embedded Web Server open?

The problem is solved.

Contact your system
support person.
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Contacting customer support

When you contact customer support, you will need to be able to describe the problem you are experiencing, the message
on the printer display, and the troubleshooting steps you have already taken to find a solution.

You need to know your printer model type and serial number. For more information, see the label at the back of the
printer. The serial number is also listed on the menu settings page.

Lexmark has various ways to help you solve your printing problem. Visit the Lexmark Web site at
http://support.lexmark.com, and then select one of the following:

Tech Library | You can browse our library of manuals, support documentation, drivers, and other downloads to help you
solve common problems.

E-mail You can send an e-mail to the Lexmark team, describing your problem. A service representative will respond
and provide you with information to solve your problem.

Live chat You can chat directly with a service representative. They can work with you to solve your printer problem or
provide assistance through Assisted Service where the service representative can remotely connect to your
computer through the Internet to troubleshoot problems, install updates, or complete other tasks to help
you successfully use your Lexmark product.

Telephone support is also available. In the U.S. or Canada, call 1-800-539-6275. For other countries or regions, visit
http://support.lexmark.com.
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Notices

Product information

Product name:
CS410n, CS410dn
Machine type:
5027

Model(s):
410,430

Edition notice

September 2012

The following paragraph does not apply to any country where such provisions are inconsistent with local law:
LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions; therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the
information herein; these changes will be incorporated in later editions. Improvements or changes in the products or
the programs described may be made at any time.

References in this publication to products, programs, or services do not imply that the manufacturer intends to make
these available in all countries in which it operates. Any reference to a product, program, or service is not intended to
state or imply that only that product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification
of operation in conjunction with other products, programs, or services, except those expressly designated by the
manufacturer, are the user’s responsibility.

For Lexmark technical support, visit http://support.lexmark.com.

For information on supplies and downloads, visit www.lexmark.com.

© 2012 Lexmark International, Inc.

All rights reserved.

GOVERNMENT END USERS

The Software Program and any related documentation are "Commercial Items," as that term is defined in 48 C.F.R.
2.101, "Computer Software" and "Commercial Computer Software Documentation," as such terms are used in 48 C.F.R.
12.2120r48C.F.R.227.7202,as applicable. Consistent with 48 C.F.R. 12.212 0or48 C.F.R. 227.7202-1through 227.7207-4,
as applicable, the Commercial Computer Software and Commercial Software Documentation are licensed to the U.S.
Government end users (a) only as Commerical Items and (b) with only those rights as are granted to all other end users
pursuant to the terms and conditions herein.
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Trademarks

Lexmark, Lexmark with diamond design, and MarkVision are trademarks of Lexmark International, Inc., registered in
the United States and/or other countries.

Mac and the Mac logo are trademarks of Apple Inc., registered in the U.S. and other countries.

PCL® is a registered trademark of the Hewlett-Packard Company. PCL is Hewlett-Packard Company’s designation of a
set of printer commands (language) and functions included in its printer products. This printer is intended to be
compatible with the PCL language. This means the printer recognizes PCL commands used in various application
programs, and that the printer emulates the functions corresponding to the commands.

The following terms are trademarks or registered trademarks of these companies:

Albertus The Monotype Corporation plc

Antique Olive Monsieur Marcel OLIVE

Apple-Chancery Apple Computer, Inc.

Arial The Monotype Corporation plc

CG Times Based on Times New Roman under license from The Monotype Corporation plc, is a product of

Agfa Corporation

Chicago Apple Computer, Inc.

Clarendon Linotype-Hell AG and/or its subsidiaries
Eurostile Nebiolo

Geneva Apple Computer, Inc.

GillSans The Monotype Corporation plc
Helvetica Linotype-Hell AG and/or its subsidiaries
Hoefler Jonathan Hoefler Type Foundry

ITC Avant Garde Gothic | International Typeface Corporation

ITC Bookman International Typeface Corporation

ITC Mona Lisa International Typeface Corporation

ITC Zapf Chancery International Typeface Corporation
Joanna The Monotype Corporation plc
Marigold Arthur Baker

Monaco Apple Computer, Inc.

New York Apple Computer, Inc.

Oxford Arthur Baker

Palatino Linotype-Hell AG and/or its subsidiaries
Stempel Garamond Linotype-Hell AG and/or its subsidiaries
Taffy Agfa Corporation

Times New Roman The Monotype Corporation plc

Univers Linotype-Hell AG and/or its subsidiaries
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All other trademarks are the property of their respective owners.

Federal Communications Commission (FCC) compliance information statement

This product has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference when the equipment
is operated in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and,
if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the following measures:

® Reorient or relocate the receiving antenna.
® |ncrease the separation between the equipment and receiver.
® Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

® Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for radio or television interference caused by using other than recommended
cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could
void the user's authority to operate this equipment.

Note: To assure compliance with FCC regulations on electromagnetic interference for a Class B computing device,
use a properly shielded and grounded cable such as Lexmark part number 1021231 for parallel attach or 1021294 for
USB attach. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC
regulations.

Any questions regarding this compliance information statement should be directed to:

Director of Lexmark Technology & Services
Lexmark International, Inc.

740 West New Circle Road

Lexington, KY 40550

(859) 232—-3000

Licensing notices

All licensing notices associated with this product can be viewed from the root directory of the installation software CD.

Noise emission levels

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

Note: Some modes may not apply to your product.

| 1-meter average sound pressure, dBA

Printing 50 dBA

Ready 16 dBA
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Values are subject to change. See www.lexmark.com for current values.

Waste from Electrical and Electronic Equipment (WEEE) directive

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the European
Union. We encourage the recycling of our products.

If you have further questions about recycling options, visit the Lexmark Web site at www.lexmark.com for your local
sales office phone number.

Product disposal

Do not dispose of the printer or supplies in the same manner as normal household waste. Consult your local authorities
for disposal and recycling options.

Static sensitivity notice

y

A

This symbol identifies static-sensitive parts. Do not touch in the areas near these symbols without first touching the
metal frame of the printer.

ENERGY STAR

Any Lexmark product bearing the ENERGY STAR emblem on the product or on a start-up screen is certified to comply
with Environmental Protection Agency (EPA) ENERGY STAR requirements as configured when shipped by Lexmark.

ENERGY STAR
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Temperature information

| Ambient temperature 15.6 to 32.2°C (60 to 90°F) |

| Shipping and storage temperature -40 to 43°C (-40 to 110°F) I

Informacion de la energia de México

Consumo de energia en operacion:

540 Wh

Consumo de energia en modo de espera:

0.2 Wh

Cantidad de producto por unidad de energia consumida:

2.78 paginas / Wh

Laser notice

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, Chapter I, Subchapter J for Class |
(1) laser products, and elsewhere is certified as a Class | laser product conforming to the requirements of IEC 60825-1.

Class | laser products are not considered to be hazardous. The printer contains internally a Class lllb (3b) laser that is
nominally a 7 milliwatt gallium arsenide laser operating in the wavelength of 655-675 nanometers. The laser system
and printer are designed so there is never any human access to laser radiation above a Class | level during normal
operation, user maintenance, or prescribed service condition.

Laser advisory label

A laser notice label may be affixed to this printer as shown:

DANGER - Invisible laser radiation when cartridges are removed and interlock defeated. Avoid exposure to laser beam.

PERIGO - Radiagdo a laser invisivel sera liberada se os cartuchos forem removidos e o lacre rompido. Evite a exposicdo aos feixes de laser.

Opasnost - Nevidljivo lasersko zracenje kada su kasete uklonjene i ponistena sigurnosna veza. Izbjegavati izlaganje zracima.

NEBEZPEC( - Kdy? jsou vyjmuty kazety a je odblokovana pojistka, ze zafizeni je vysilano neviditelné laserové zaieni. Nevystavujte se ptisobeni laserového paprsku.

FARE - Usynlig laserstraling, nar patroner fjernes, og sparreanordningen er slaet fra. Undga at blive udsat for laserstralen.

GEVAAR - Onzichtbare laserstraling wanneer cartridges worden verwijderd en een vergrendeling wordt genegeerd. Voorkom blootstelling aan de laser.

DANGER - Rayonnements laser invisibles lors du retrait des cartouches et du déverrouillage des loquets. Eviter toute exposition au rayon laser.

VAARA - Nakymatonta lasersateilya on varottava, kun varikasetit on poistettu ja lukitus on auki. Valta lasersateelle altistumista.

GEFAHR - Unsichtbare Laserstrahlung beim Herausnehmen von Druckkassetten und offener Sicherheitssperre. Laserstrahl meiden.

KINAYNOS -EkAuon aopatng aktvoBoliag laser katd tnv adaipeon twv Kaoetwy Kal tnv anacddAion thg pavddAwong. Artodelyete tnv €kBeon otnv aktvoBolia laser.

VESZELY — Nem lathato lézersugarzas fordulhat el6 a patronok eltavolitasakor és a zardszerkezet felbontasakor. Keriilje a lézersugarnak vald kitettséget.

PERICOLO - Emissione di radiazioni laser invisibili durante la rimozione delle cartucce e del blocco. Evitare |'esposizione al raggio laser.

FARE — Usynlig laserstraling nar kassettene tas ut og sperren er satt ut av spill. Unnga eksponering for laserstralen.

NIEBEZPIECZENSTWO - niewidzialne promieniowanie laserowe podczas usuwania kaset i blokady. Nalezy unika¢ naswietlenia promieniem lasera.

OMACHO! HeBnanmoe nasepHoe U3nyyeHue Npu U3BNedYeHHbIX KapTpUAKax U CHATUM BNOKMPOBKN. M3beraliTe BO3LeNCTBUA 1a3epHbIX yyeil.

Pozor — Nebezpecdenstvo neviditelného laserového Ziarenia pri odobratych kazetdch a odblokovanej poistke. Nevystavujte sa li¢om.

PELIGRO: Se producen radiaciones laser invisibles al extraer los cartuchos con el interbloqueo desactivado. Evite la exposicion al haz de laser.

FARA — Osynlig laserstralning nar patroner tas ur och sparrmekanismen ar upphavd. Undvik exponering for laserstralen.

fEB - MR B4 ABURME S E R R ROt RS, W B RO,

Sl - R BRI [ B2 A PR B R & AR B AR LB M E A, SR B E E O T,
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Notices 207

Power consumption

Product power consumption
The following table documents the power consumption characteristics of the product.

Note: Some modes may not apply to your product.

Mode Description Power consumption (Watts)
Printing The product is generating hard-copy output from electronic inputs. 500 W (25 ppm), 550 W (32 ppm)
Copy The product is generating hard-copy output from hard-copy original N/A
documents.
Scan The product is scanning hard-copy documents. N/A
Ready The product is waiting for a print job. 40 W
Sleep Mode | The product is in a high-level energy-saving mode. 7W
Hibernate |The productisin a low-level energy-saving mode. 1w
Off The product is plugged into an electrical outlet, but the power switchis | 0.0 W
turned off.

The power consumption levels listed in the previous table represent time-averaged measurements. Instantaneous
power draws may be substantially higher than the average.

Values are subject to change. See www.lexmark.com for current values.

Sleep Mode

This product is designed with an energy-saving mode called Sleep Mode. The Sleep Mode saves energy by lowering
power consumption during extended periods of inactivity. The Sleep Mode is automatically engaged after this product
is not used for a specified period of time, called the Sleep Mode Timeout.

[Factory default Sleep Mode Timeout for this product (in minutes): 30 minutes J

By using the configuration menus, the Sleep Mode Timeout can be modified between 1 minute and 180 minutes. Setting
the Sleep Mode Timeout to alow value reduces energy consumption, but mayincrease the response time of the product.
Setting the Sleep Mode Timeout to a high value maintains a fast response, but uses more energy.

Off mode

If this product has an off mode which still consumes a small amount of power, then to completely stop product power
consumption, disconnect the power supply cord from the electrical outlet.

Total energy usage

It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in
power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in
order to calculate energy usage. The total product energy usage is the sum of each mode's energy usage.
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Industry Canada compliance statement

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Standard
ICES-003.

Avis de conformité aux normes de l'industrie du Canada

Cet appareil numérique de classe B est conforme aux exigences de la norme canadienne relative aux équipements
pouvant causer des interférences NMB-003.

European Community (EC) directives conformity

This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC and
2009/125/EC on the approximation and harmonization of the laws of the Member States relating to electromagnetic
compatibility, safety of electrical equipment designed for use within certain voltage limits and the ecodesign of energy-
related products.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungaria Kft., 8 Lechner Odon fasor, Millennium
Tower lll, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Regulatory notices for wireless products

This section contains the following regulatory information pertaining to wireless products that contain transmitters,
for example, but not limited to, wireless network cards or proximity card readers.

Modular component notice

Wireless-equipped models contain the following modular component(s):

Lexmark Regulatory Type-Model LEX-M01-005; FCC ID:IYLLEXM01005; IC:2376A-M01005

Exposure to radio frequency radiation

The radiated output power of this device is far below the radio frequency exposure limits of the FCCand other regulatory
agencies. A minimum separation of 20 cm (8 inches) must be maintained between the antenna and any persons for
this device to satisfy the RF exposure requirements of the FCC and other regulatory agencies.

Industry Canada (Canada)

This device complies with Industry Canada specification RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that
may cause undesired operation of the device.
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This device has been designed to operate only with the antenna provided. Use of any other antennais strictly prohibited
per regulations of Industry Canada.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.

The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit RF
fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health
Canada's Web site www.hc-sc.gc.ca/rpb.

The term "IC:" before the certification/registration number only signifies that the Industry Canada technical
specifications were met.

Industry Canada (Canada)

Cet appareil est conforme a la norme RSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux conditions
suivantes :

(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence recue, y compris celles
risquant d'altérer son fonctionnement.

Cet appareil a été congu pour fonctionner uniquement avec lI'antenne fournie. L'utilisation de toute autre antenne est
strictement interdite par la réglementation d'Industry Canada.

En application des réglementations d'Industry Canada, I'utilisation d'une antenne de gain supérieur est strictement
interdite.

Pour empécher toute interférence radio au service faisant I'objet d'une licence, cet appareil doit étre utilisé a l'intérieur
et loin des fenétres afin de garantir une protection optimale.

Si le matériel (ou son antenne d'émission) est installé a I'extérieur, il doit faire I'objet d'une licence.

L'installateur de cet équipement radio doit veiller a ce que I'antenne soit implantée et dirigée de maniére a n'émettre
aucun champ HF dépassant les limites fixées pour I'ensemble de la population par Santé Canada. Reportez-vous au
Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-sc.gc.ca/rpb.

Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est conforme
aux spécifications techniques d'Industry Canada.

Notice to users in the European Union

This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC,
1999/5/EC, and 2009/125/EC on the approximation and harmonization of the laws of the Member States relating to
electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits, radio
equipment and telecommunications terminal equipment and on the ecodesign of energy-related products.

Compliance is indicated by the CE marking.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungaria Kft., 8 Lechner Odon fasor, Millennium
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Tower lll, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Products equipped with 2.4GHz Wireless LAN option are in conformity with the protection requirements of EC Council
directives 2004/108/EC, 2006/95/EC, 1999/5/EC, and 2009/125/EC on the approximation and harmonization of the

laws of the Member States relating to electromagnetic compatibility, safety of electrical equipment designed for use
within certain voltage limits and on radio equipment and telecommunications terminal equipment and on the ecodesign

of energy-related products.

Operation is allowed in all EU and EFTA countries, but is restricted to indoor use only.

Compliance is indicated by the CE marking.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungdria Kft., 8 Lechner Odon fasor, Millennium
Tower lll, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.

This product may be used in the countries indicated in the table below.

AT BE BG CH cY (074 DE DK EE

EL ES FI FR HR HU IE IS IT

LI LT LU LV MT NL NO PL PT

RO SE SI SK TR UK

Cesky Spolecnost Lexmark International, Inc. timto prohlasuje, Ze vyrobek tento vyrobek je ve shodé se zadkladnimi
pozadavky a dalsimi pfislusnymi ustanovenimi smérnice 1999/5/ES.

Dansk Lexmark International, Inc. erklaerer herved, at dette produkt overholder de vaesentlige krav og gvrige relevante
krav i direktiv 1999/5/EF.

Deutsch Hiermit erklért Lexmark International, Inc., dass sich das Gerit dieses Gerit in Ubereinstimmung mit den
grundlegenden Anforderungen und den Ubrigen einschldgigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

EAMnvikrj | ME THN MAPOYZA H LEXMARK INTERNATIONAL, INC. AHAQNEI OTI AYTO TO MPOION
ZYMMOPOQNETAI NMPOZ TIZ OYZIQAEIZ AMAITHZEIZ KAI TIZ AOINEZ ZXETIKEZ AIATAZEIZ
THZ OAHIMIAZ 1999/5/EK.

English Hereby, Lexmark International, Inc., declares that this type of equipment is in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC.

Espariol Por medio de la presente, Lexmark International, Inc. declara que este producto cumple con los requisitos
esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva 1999/5/CE.

Eesti K&esolevaga kinnitab Lexmark International, Inc., et seade see toode vastab direktiivi 1999/5/EU
pdhinduetele ja nimetatud direktiivist tulenevatele muudele asjakohastele satetele.

Suomi Lexmark International, Inc. vakuuttaa titen, ettd tama tuote on direktiivin 1999/5/EY oleellisten vaatimusten
ja muiden sitd koskevien direktiivin ehtojen mukainen.
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Frangais Par la présente, Lexmark International, Inc. déclare que I'appareil ce produit est conforme aux exigences
fondamentales et autres dispositions pertinentes de la directive 1999/5/CE.

Magyar Alulirott, Lexmark International, Inc. nyilatkozom, hogy a termék megfelel a vonatkozé alapvetd
kovetelményeknek és az 1999/5/EC irdnyelv egyéb eldirdsainak.

islenska | Hér mes lysir Lexmark International, Inc. yfir pvi ad pessi vara er i samraemi vid grunnkrofur og adrar
krofur, sem gerdar eru i tilskipun 1999/5/EC.

Italiano Con la presente Lexmark International, Inc. dichiara che questo questo prodotto & conforme ai requisiti
essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.

Latviski Ar So Lexmark International, Inc. deklaré, ka Sis izstradajums atbilst Direktivas 1999/5/EK bitiskajam
prasibam un citiem ar to saistitajiem noteikumiem.

Lietuviy | Siuo Lexmark International, Inc. deklaruoja, kad $is produktas atitinka esminius reikalavimus ir kitas
1999/5/EB direktyvos nuostatas.

Malti Bil-prezenti, Lexmark International, Inc., jiddikjara li dan il-prodott huwa konformi mal-htigijiet
essenzjali u ma dispozizzjonijiet ohrajn relevanti li jinsabu fid-Direttiva 1999/5/KE.

Nederlands | Hierbij verklaart Lexmark International, Inc. dat het toestel dit product in overeenstemmingis met de essentiéle
eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.

Norsk Lexmark International, Inc. erklaerer herved at dette produktet er i samsvar med de grunnleggende krav og
gvrige relevante krav i direktiv 1999/5/EF.

Polski Niniejszym Lexmark International, Inc. oswiadcza, ze niniejszy produkt jest zgodny z zasadniczymi
wymogami oraz pozostatymi stosownymi postanowieniami Dyrektywy 1999/5/EC.

Portugués | ALexmarkInternational Inc. declara que este este produto estd conforme com os requisitos essenciais e outras
disposi¢des da Diretiva 1999/5/CE.

Slovensky | Lexmark International, Inc. tymto vyhlasuje, Ze tento produkt spifia zakladné poziadavky a véetky
prislusné ustanovenia smernice 1999/5/ES.

Slovensko | Lexmark International, Inc. izjavlja, da je ta izdelek v skladu z bistvenimi zahtevami in ostalimi
relevantnimi dolocili direktive 1999/5/ES.

Svenska Harmed intygar Lexmark International, Inc. att denna produkt star i dverensstdmmelse med de vasentliga
egenskapskrav och 6vriga relevanta bestdmmelser som framgar av direktiv 1999/5/EG.

Patent acknowledgment

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Elliptic Curve Cryptography (ECC) Cipher Suites for Transport
Layer Security (TLS) implemented in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for TLS Elliptic Curve Cipher Suites with SHA-256/382 and AES Galois
Counter Mode (GCM) implemented in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for TLS Suite B Profile for Transport Layer Security (TLS) implemented
in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Addition of the Camellia Cipher Suites to Transport Layer Security
(TLS) implemented in the product or service.
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The use of certain patents in this product or service is subject to the reasonable, non-discriminatory terms in the
Intellectual Property Rights (IPR) Disclosure of Certicom Corp. at the IETF for AES-CCM ECC Cipher Suites for TLS
implemented in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for IKE and IKEv2 Authentication Using the Eliptic Curve Digital
Signature Algorithm (ECDSA) implemented in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Suite B Cryptographic Suites for IPSec implemented in the
product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Algorithms for Internet Key Exchange version 1 (IKEv1)
implemented in the product or service.

STATEMENT OF LIMITED WARRANTY FOR LEXMARK LASER PRINTERS,
LEXMARK LED PRINTERS, AND LEXMARK MULTIFUNCTION LASER PRINTERS

Lexmark International, Inc., Lexington, KY

This limited warranty applies to the United States and Canada. For customers outside the U.S., refer to the country-
specific warranty information that came with your product.

This limited warranty applies to this product only if it was originally purchased for your use, and not for resale, from
Lexmark or a Lexmark Remarketer, referred to in this statement as “Remarketer.”

Limited warranty

Lexmark warrants that this product:

—Is manufactured from new parts, or new and serviceable used parts, which perform like new parts
—Is, during normal use, free from defects in material and workmanship

If this product does not function as warranted during the warranty period, contact a Remarketer or Lexmark for repair
or replacement (at Lexmark's option).

If this product is a feature or option, this statement applies only when that feature or option is used with the product
for which it was intended. To obtain warranty service, you may be required to present the feature or option with the
product.

If you transfer this product to another user, warranty service under the terms of this statement is available to that user
for the remainder of the warranty period. You should transfer proof of original purchase and this statement to that
user.

Limited warranty service

The warranty period starts on the date of original purchase as shown on the purchase receipt and ends 12 months later
provided that the warranty period for any supplies and for any maintenance items included with the printer shall end
earlier if it, or its original contents, are substantially used up, depleted, or consumed. Fuser Units, Transfer/Transport
Units, Paper Feed items, if any, and any other items for which a Maintenance Kit is available are substantially consumed
when the printer displays a “Life Warning” or “Scheduled Maintenance” message for such item.
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To obtain warranty service you may be required to present proof of original purchase. You may be required to deliver
your product to the Remarketer or Lexmark, or ship it prepaid and suitably packaged to a Lexmark designated location.
You are responsible for loss of, or damage to, a product in transit to the Remarketer or the Lexmark designated location.

When warranty service involves the exchange of a product or part, the item replaced becomes the property of the
Remarketer or Lexmark. The replacement may be a new or repaired item.

The replacement item assumes the remaining warranty period of the original product.

Replacement is not available to you if the product you present for exchange is defaced, altered, in need of a repair not
included in warranty service, damaged beyond repair, or if the product is not free of all legal obligations, restrictions,
liens, and encumbrances.

As part of your warranty service and/or replacement, Lexmark may update the firmware in your printer to the latest

version. Firmware updates may modify printer settings and cause counterfeit and/or unauthorized products, supplies,
parts, materials (such as toners and inks), software, or interfaces to stop working. Authorized use of genuine Lexmark
products will not be impacted.

Before you present this product for warranty service, remove all print cartridges, programs, data, and removable storage
media (unless directed otherwise by Lexmark).

For further explanation of your warranty alternatives and the nearest Lexmark authorized servicer in your area contact
Lexmark on the World Wide Web.

Remote technical support is provided for this product throughout its warranty period. For products no longer covered
by a Lexmark warranty, technical support may not be available or only be available for a fee.

Extent of limited warranty

Lexmark does not warrant uninterrupted or error-free operation of any product or the durability or longevity of prints
produced by any product.

Warranty service does not include repair of failures caused by:

—Modification or unauthorized attachments

—Accidents, misuse, abuse or use inconsistent with Lexmark user’s guides, manuals, instructions or guidance
—Unsuitable physical or operating environment

—Maintenance by anyone other than Lexmark or a Lexmark authorized servicer

—Operation of a product beyond the limit of its duty cycle

—Use of printing media outside of Lexmark specifications

—Refurbishment, repair, refilling or remanufacture by a third party of products, supplies or parts

—Products, supplies, parts, materials (such as toners and inks), software, or interfaces not furnished by Lexmark

TO THE EXTENT PERMITTED BY APPLICABLE LAW, NEITHER LEXMARK NOR ITS THIRD PARTY SUPPLIERS OR
REMARKETERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED, WITH
RESPECT TO THIS PRODUCT, AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND SATISFACTORY QUALITY. ANY WARRANTIES THAT
MAY NOT BE DISCLAIMED UNDER APPLICABLE LAW ARE LIMITED IN DURATION TO THE WARRANTY PERIOD. NO
WARRANTIES, EXPRESS OR IMPLIED, WILL APPLY AFTER THIS PERIOD. ALL INFORMATION, SPECIFICATIONS, PRICES,
AND SERVICES ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE.
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Limitation of liability

Your sole remedy under this limited warranty is set forth in this document. For any claim concerning performance or
nonperformance of Lexmark or a Remarketer for this product under this limited warranty, you may recover actual
damages up to the limit set forth in the following paragraph.

Lexmark's liability for actual damages from any cause whatsoever will be limited to the amount you paid for the product
that caused the damages. This limitation of liability will not apply to claims by you for bodily injury or damage to real
property or tangible personal property for which Lexmark is legally liable. IN NO EVENT WILL LEXMARK BE LIABLE FOR
ANY LOST PROFITS, LOST SAVINGS, INCIDENTAL DAMAGE, OR OTHER ECONOMIC OR CONSEQUENTIAL DAMAGES.
This is true even if you advise Lexmark or a Remarketer of the possibility of such damages. Lexmark is not liable for any
claim by you based on a third party claim.

This limitation of remedies also applies to claims against any Suppliers and Remarketers of Lexmark. Lexmark's and its
Suppliers' and Remarketers' limitations of remedies are not cumulative. Such Suppliers and Remarketers are intended
beneficiaries of this limitation.

Additional rights

Some states do not allow limitations on how long an implied warranty lasts, or do not allow the exclusion or limitation
of incidental or consequential damages, so the limitations or exclusions contained above may not apply to you.

This limited warranty gives you specific legal rights. You may also have other rights that vary from state to state.
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Index

Numerics
250-sheet tray
loading 36
550-sheet tray
installing 25
loading 36
650-sheet duo tray
installing 25
loading 36, 38

Symbols

[Color] cartridge low [88.xy] 155
[Color] cartridge nearly low
[88.xy] 155

[Color] cartridge very low, [x]
estimated pages remain

[88.xy] 155

[Type] imaging kit low [84.xy] 155
[Type] imaging kit nearly low
[84.xy] 155

[Type] imaging kit very low, [x]
estimated pages remain

[84.xy] 155

[x]-page jam, open front door to
clear fuser. 145

[x]-page jam, open front door. 147
[x]-page jam, clear manual
feeder. 151

[x]-page jam, clear multipurpose
feeder 151

[x]-page jam, clear standard

bin. 144

[x]-page jam, open front door to
clear duplex. 148

[x]-page jam, open tray [x]. 149

A
Active NIC menu 76
Adjusting color 154
adjusting printer display
brightness 110
adjusting Sleep mode 108
adjusting toner darkness 57
administrator settings
Embedded Web Server 139
AppleTalk menu 81
attaching cables 28

available internal options 18
avoiding jams 53
avoiding paper jams 142

B
black-and-white printing 57

C

cables
Ethernet 28
USB 28
canceling
print job, from computer 63
canceling a print job
from a computer 63
from the printer control panel 62
cannot open Embedded Web
Server 199
card stock
loading 39
tips 50
Change [paper source] to [custom
string] 154
Change [paper source] to [custom
type name] 154
Change [paper source] to [paper
type] [paper size] 154
checking an unresponsive
printer 166
checking status of parts and
supplies 114
checking the printer status
using the Embedded Web
Server 139
checking the status of parts and
supplies 114
checking the virtual display
using the Embedded Web
Server 139
cleaning
exterior of the printer 114
interior of the printer 114
cleaning the printer 114
Close door 154
color quality troubleshooting
color of print and color on
computer screen do not
match 199

prints on color transparencies
appear dark when projected 198
color quality, troubleshooting
print appears tinted 199
Complex page, some data may not
have printed [39] 156
confidential data
information on securing 113
confidential jobs
modifying print settings 140
confidential print jobs 60
printing from a Macintosh
computer 61
printing from Windows 61
Confidential Print menu 83
Configuration change, some held
jobs were not restored [57] 156
configuration information
wireless network 31
configurations
printer 14
Configure MP menu 69
configuring
multiple printers 141
supply notifications, imaging
kit 140
supply notifications, maintenance
kit 140
supply notifications, toner
cartridge 140
supply notifications, waste toner
bottle 140
configuring supply notifications
from the Embedded Web
Server 140
configuring the Universal paper size
settings 35
connecting to a wireless network
using PBC, Push Button
Configuration method 32
using PIN, Personal Identification
Number method 32
using the Embedded Web
Server 33
conservation settings
brightness, adjusting 110
conserving supplies 106
Eco-Mode 107
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Hibernate mode 109
Hibernate Timeout 110
Quiet Mode 107
Schedule Power Modes 108
Sleep mode 108
conserving supplies 106
contacting customer support 201
control panel, printer
indicator light 16
Sleep button light 16
controller board
accessing 19
custom paper type
assigning 45
custom paper type name
creating 44
custom paper type names
assigning 45
Custom Type [x]
assigning a paper type 45
Custom Type [x] name
creating 44
Custom Types menu 74
customer support
contacting 201

D

Default Source menu 66
Defective flash detected [51] 156
developer unit
replacing 121, 131
device and network settings
erasing 113
directory list
printing 62
Disk Wiping menu 84
display troubleshooting
printer display is blank 168
display, printer control panel
adjusting brightness 110
documents, printing
from Macintosh 57
from Windows 57

E

Eco-Mode

using 107
embedded solutions
erasing 113

Embedded Web Server 140
accessing 17

adjusting brightness 110
administrator settings 139
checking printer status 139
checking the status of parts 114
checking the status of
supplies 114
copying settings to other
printers 141
functions 17
modifying confidential print
settings 140
networking settings 139
problem accessing 199
using 17
Embedded Web Server
Administrator's Guide
where to find 113, 139
emission notices 204, 208, 209
envelopes
loading 39, 42
tips on using 49
environmental settings
conserving supplies 106
Eco-Mode 107
Hibernate mode 109
Hibernate Timeout 110
printer display brightness,
adjusting 110
Quiet Mode 107
Schedule Power Modes 108
Sleep mode 108
erasing non-volatile memory 113
erasing volatile memory 113
Error reading USB drive. Remove
USB. 156
Error reading USB hub. Remove
hub. 156
Ethernet network
preparing to set up for Ethernet
printing 29
Ethernet network setup
using Macintosh 30
using Windows 30
Ethernet networking
Macintosh 30
Windows 30
Ethernet port 28
Ethernet setup
preparing for an 29
exterior of the printer
cleaning 114

F

factory defaults, restoring 141
FAQ about color printing 196
FCC notices 204, 208

finding more information about the

printer 12
Finishing menu 94
firmware card 18
flash drive

printing from 59
Flash Drive menu 92
flash drives

supported file types 60
font sample list

printing 62

G

General settings menu 86
green settings
Eco-Mode 107
Hibernate mode 109
Hibernate Timeout 110
Quiet Mode 107
Schedule Power Modes 108

H

held jobs 60
printing from a Macintosh
computer 61
printing from Windows 61
Hibernate mode
using 109
Hibernate Timeout
setting 110
HTML menu 103

Image menu 104
imaging kit
replacing 121
imaging kits
ordering 116
Incompatible tray [x] [59] 156
Incorrect paper size, open [paper
source] [34] 157
individual settings
erasing 113
Insert Tray [x] 157
installing an optional card 23
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installing options
order of installation 25
installing printer on a network
Ethernet networking 30
installing printer software 27
adding options 28
Insufficient memory for Flash
Memory Defragment operation
[37] 157
Insufficient memory to collate job
[37] 157
Insufficient memory to support
Resource Save feature [35] 157
Insufficient memory, some Held
Jobs were deleted [37] 157
Insufficient memory, some held
jobs will not be restored [37] 158
interior of the printer
cleaning 114
internal options 18
IPv6 menu 79

J
jams
avoiding 142
locating doors and trays 144
locations 144
messages 144
jams, clearing
in fuser area 145
in manual feeder 151
in multipurpose feeder 151
in standard bin 144
Tray 1 149
Tray 2 149

L

labels, paper
tips 50
letterhead
loading, multipurpose feeder 47
loading, trays 47
linking trays 44
assigning custom paper type
names 45
Load [paper source] with [custom
string] 158
Load [paper source] with [custom
type name] 158
Load [paper source] with [paper
size] 158

Load [paper source] with [paper
type] [paper size] 159
Load Manual Feeder with [custom
string] 159
Load Manual Feeder with [custom
type name] 159
Load Manual Feeder with [paper
size] 159
Load Manual Feeder with [paper
type] [paper size] 159
loading
250-sheet tray 36
550-sheet tray 36
650-sheet duo tray 36, 38
card stock 39
envelopes 39, 42
manual feeder 42
multipurpose feeder 39
transparencies 39
loading letterhead
paper orientation 47
lock, security 112

M

Maintenance kit low [80.xy] 160
Maintenance kit nearly low
[80.xy] 160
Maintenance kit very low, [x]
estimated pages remain
[80.xy] 160
manual feeder

loading 42
Max Speed and Max Yield

using 58
memory

types installed on printer 112
memory card 18

installing 21

troubleshooting 168
Memory full [38] 160
menu settings

loading on multiple printers 141
menu settings page

printing 33
menus

Active NIC 76

AppleTalk 81

Confidential Print 83

Configure MP 69

Custom Types 74

Default Source 66

Disk Wiping 84

Finishing 94

Flash Drive 92
General settings 86
HTML 103

Image 104

IPv6 79

list 64

Network [x] 76
Network Card 78
Network Reports 77
Paper Loading 73
Paper Size/Type 66
Paper Texture 69
Paper Weight 71

PCL Emul 101

PDF 100

PostScript 100
Quality 95

Reports 75

Security Audit Log 85
Set Date and Time 85
Setup 91

SMTP Setup menu 82
Standard Network 76
Standard USB 81
Substitute Size 69
Supplies 65

TCP/IP 78

Universal Setup 74
Utilities 98

Wireless 80

XPS 99
menus list 64
moving the printer 13, 138
multipurpose feeder
loading 39

N

Network [x] menu 76
Network [x] software error
[54] 160
Network Card menu 78
Network Reports menu 77
network settings

Embedded Web Server 139
network setup page

printing 34
Networking Guide

where to find 139
noise emission levels 204
Non-Lexmark [color] [supply type],
see User's Guide [33.xy] 161
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non-volatile memory 112
erasing 113

Not enough free space in flash

memory for resources [52] 160

notices 203, 204, 205, 206, 207,

208, 209, 210

number of remaining pages
estimate 115

(0

optional card
installing 23
options
550-sheet tray 25
650-sheet duo tray 25
firmware cards 18
memory card 21
memory cards 18
updating in printer driver 28
ordering
imaging kits 116
toner cartridges 115
waste toner bottle 116

P

paper
characteristics 50
letterhead 52
preprinted forms 52
recycled 52
selecting 52
setting size 35
setting type 35
storing 53
unacceptable 51
Universal size setting 35
using recycled 106
paper feed troubleshooting
message remains after jam is
cleared 172
paper jams
avoiding 142
paper jams, clearing
[x]-page jam, open front door to
clear fuser. 145
[x]-page jam, open front
door. 147
[x]-page jam, open front door to
clear duplex. 148
in fuser area 145
in manual feeder 151

in multipurpose feeder 151
in standard bin 144
Tray 1 149
Tray 2 149
Paper Loading menu 73
Paper Size/Type menu 66
paper sizes
supported by the printer 53
Paper Texture menu 69
paper types
supported by printer 56
where to load 56
Paper Weight menu 71
paper weights
supported by printer 56
parts
checking status 114
checking, using the Embedded
Web Server 114
using genuine Lexmark 115
parts and supplies, status of
checking, on printer control
panel 114
PCL Emul menu 101
PDF menu 100
Personal Identification Number
method
using 32
PostScript menu 100
power cord socket 28
PPDS font error [50] 161
preparing to set up the printer on
an Ethernet network 29
print irregularities 186
print job

canceling from the printer control

panel 62
canceling, from computer 63
print quality
replacing a developer unit 131
replacing imaging kit 121
replacing the waste toner
bottle 117
print quality troubleshooting
blank pages 187

characters have jagged edges 179

clipped pages or images 179

gray background on prints 180

horizontal voids appear on
prints 181

print irregularities 186

print is too dark 184

print is too light 185
printer is printing solid black
pages 188
repeating print defects 177
shadow images appear on
prints 189
skewed print 190
streaked horizontal lines appear
on prints 190
streaked vertical lines appear on
prints 191
toner fog or background shading
appears on prints 193
toner rubs off 194
transparency print quality is
poor 193
uneven print density 195
vertical voids appear on
prints 194
print troubleshooting
incorrect characters print 173
incorrect margins on prints 182
jammed pages are not
reprinted 171
job prints from wrong tray 173
job prints on wrong paper 173
jobs do not print 175
Large jobs do not collate 174
paper curl 183
paper frequently jams 171
print job takes longer than
expected 176
printing slows down 174
tray linking does not work 177
unexpected page breaks
occur 178
printer
configurations 14
minimum clearances 13
models 14
moving 13, 138
selecting a location 13
shipping 138
printer control panel
adjusting brightness 110
arrow button 15
Back button 15
display 15
factory defaults, restoring 141
Home button 15
indicator light 15, 16
keypad 15
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Select button 15
Sleep button 15
Sleep button light 16
Stop button 15
USB port 15
using 15
printer control panel, virtual
display
using the Embedded Web
Server 139
printer information
where to find 12
printer is printing blank pages 187
printer messages
[Color] cartridge low [88.xy] 155
[Color] cartridge nearly low
[88.xy] 155
[Color] cartridge very low, [x]
estimated pages remain
[88.xy] 155
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